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UNIT-I 

 

INTRODUCTION TO COMPUTERS: DEFINITION, CHARACTERISTICS AND 

GENERATION OF COMPUTERS – ELEMENT OF COMPUTERS – HARDWARE – CPU – 

PRIMARY AND SECONDARY MEMORY – INPUT AND OUTPUT DEVICES – 

FEATURES OF COMPUTERS – CLASSIFICATION – PARTS OF A COMPUTER 

SYSTEM. 

 

INTRODUCTION 

Computer as a revolution left no area of life untouched in the present world. It is of 

tremendous help in  all field of life. Hence, the knowledge of computer is a necessity for existence 

of everybody in this global village. The invention of computer has transformed our simple manual 

works to sophisticated life of automated works to meet the global demand for the higher 

productivity and increased efficiency with high precision. This is designed to meet the prerequisite 

need of everybody that are interested and wish to know about computers science and computing in 

general. 

A computer is an electronic device, operating under the control of instructions stored 

in its own memory. These instructions tell the machine what to do. The computer is capable of 

accepting data (input), processing  data arithmetically and logically, producing output from the 

processing, and storing the results for future use. Most computers that sit on a desktop are called 

Personal Computers (PCs). 

The "computer" is an ensemble of different machines that you will be using to get 

your job done. A computer is primarily made of the Central Processing Unit (usually referred to as  

the computer), the  monitor,  the keyboard, and the mouse. Other pieces of hardware are commonly 

referred to as peripherals. 

In everyday life activities, we process data or encounter cases of data processing. A 

typical example of data processing is the generation of statement of student result from the marks 

score in an examination and continuous assessment. It is essential to know that information is  as 

good as the data from which it is derived,  and the transformation process which they are subjected 



 

 

to. Meaningless data or inappropriate processing produces wrong information. Thus computer gives 

you results corresponding to what data you supply and how you process it. 

 

GENERATIONS OF COMPUTERS 

The history of computer development is often referred to in reference to the different 

generations of computing devices. Each generation of computer is characterized by a major 

technological development that fundamentally changed the way computers operate, resulting in 

increasingly smaller, cheaper, more powerful, efficient and reliable devices. 

 

 FIRST GENERATION - 1940-1956: VACUUM TUBES 

The first computers used vacuum tubes for circuitry and magnetic drums for memory, and 

were often enormous, taking up entire rooms. They were very expensive to operate and in addition 

to using a great deal of electricity, generated a lot of heat, which was often the cause of 

malfunctions. First generation computers relied on machine language to perform operations, and 

they could only solve one problem at a time. Input was based  on punched cards and paper tape, 

and output was displayed on printouts. The UNIVAC and ENIAC computers are examples of first-

generation computing devices. The UNIVAC was the first commercial computer delivered to a 

business client. It was used in the 1951U.S. Bureau Census. 

 

 SECOND GENERATION - 1956-1963: TRANSISTORS 

Transistors replaced vacuum tubes and ushered in the second generation of computers. 

The transistor was invented in 1947 but did not see widespread use in computers until the late 50s. 

The transistor was a vast improvement over the vacuum tube, allowing computers to become 

smaller, faster, cheaper, more energy- efficient and more reliable than their first-generation 

predecessors. Second-generation computers still relied on punched cards for input and printouts for 

output. Second-generation computers moved from cryptic binary machine language to symbolic, or 

assembly, languages, which allowed programmers to specify instructions in words. High-level 

programming languages were also being developed at this time, such as early versions of COBOL 

and FORTRAN. These were also the first computers that stored their instructions in their memory, 

which moved from a magnetic drum to magnetic core technology. The first computers of this 

generation were developed for the atomic energy industry. 



 

 

 

 THIRD GENERATION - 1964-1971: INTEGRATED CIRCUITS: 

The development of the integrated circuit was the hallmark of the third generation of 

computers. Transistors were miniaturized and placed on silicon chips, called  semiconductors, 

which  drastically increased the speed and efficiency of computers. Instead of punched cards and 

printouts, users interacted with third generation computers through keyboards and monitors and 

interfaced with an operating system, which allowed the device to run many different applications at 

one time with a central program that monitored the memory. Computers for the first time became 

accessible to a mass audience because they were smaller and cheaper than their predecessors. 

 

 Fourth Generation - 1971-Present: Microprocessors 

The microprocessor brought the fourth generation of computers, as thousands of integrated 

circuits were built on to a single silicon chip. What in the first generation filled an entire room could 

now fit in the palm of the hand. In 1981 IBM introduced its first computer for the home user, and in 

1984 Apple  introduced  the  Macintosh. Microprocessors also moved out of the realm of desktop 

computers and into many areas of life as more and more everyday products began to use 

microprocessors. As these small computers became more powerful, they could be linked together to 

form networks, which eventually led to the development of the Internet. Fourth generation computers 

also saw the development of GUIs, the mouse and handheld devices. 

 

 Fifth Generation - Present and Beyond: Artificial Intelligence 

Fifth generation computing devices, based on artificial intelligence, are still in  

development, though  there are some applications, such as voice recognition, that are being used 

today. The use of parallel processing and superconductors is helping to make artificial intelligence 

a reality. Quantum  computation  and molecular  and nanotechnology will radically change the face 

of computers in years to come. The goal of fifth-generation computing is to develop devices that 

respond to natural language input and are capable of learning and self- organization. 

HARDWARE AND SOFTWARE 

Hardware is the term given to the physical components of a computer: e.g. keyboard, 

monitor, system box or floppy disk drive. Software, on the other hand, is electronic information: 

files, operating system, graphics, computer programs are all example of software. The difference 



 

 

between hardware and software reflects the duality between the physical and mental worlds: for 

example, your brain is hardware, whereas your mind is software. 

Software is the stuff that makes your computer do things for you. The computer without 

software would be like a home entertainment system with no tapes, CD’s, or movies - you have the 

machine, but there is nothing to play on it. Software is continually developed. Each time the 

software maker (Microsoft, Adobe, Corel, etc) develops a new version of their software they 

assign it a version number. Before Microsoft Word 7, there was Microsoft Word 6.0.1, and before 

that Word 6.0. The larger the developments made to the software, the larger the version number 

changes. Usually a large change will result in a whole number upgrade; a small change may result 

in a tenth of a decimal place. 

Hardware are those components or physical pieces (things you can touch) that make up the 

computer.  The different pieces of the computer is hardware are monitor, speakers, mouse, 

CDROM, floppy drive, hard drive, keyboard, CPU, RAM, Processor, etc. Each piece plays a role 

in the operation of a computer. 

 

THE CENTRAL PROCESSING UNIT (CPU) 

This is the main brain of the computer that accepts data, performs operations on the data and 

sends out  the result.Information from an input device or from the computerís memory is 

communicated via the bus to the Central Processing Unit (CPU), which is the part of the computer 

that translates commands and runs programs.   It consists of ALU and CU, and a single chip or 

series of chips that performs arithmetic and logical calculations and controls the operations of the 

other elements of the system. 

The main functions of the microprocessor (CPU clips) includes the following. 

 Control use of the main storage in storing data and instructions (i.e the ROM). 

 Control the sequence of operations. 

 Give commands to all parts of the computer system. 

 Carry out processing. 

 

STORAGE DEVICES(PRIMARY AND SECONDARY MEMORY): 

Storage devices provide permanent storage of information and programs for retrieval by the 

computer. The two main types of storage devices are primary memory and secondary memory.  



 

 

PRIMARY MEMORY: 

Primary memory refers to the computer chips that store information for quick retrieval by the 

CPU. They are basically divided into two ROM and RAM. 

 

Random Access Memory (RAM) is used to store information and instructions that operate 

the computerís programs. Typically, programs are transferred from storage on a disk drive to 

RAM. RAM is also known as volatile memory because the information within the computer chips 

is lost when power to the computer is turned off or the computer hanged. 

 

Read-Only Memory (ROM) contains critical information and software that must be 

permanently available for computer operation, such as the operating system that directs  the 

computerís actions from start up  to shut down. ROM is called non-volatile memory because the 

memory chips do not lose  their information  when power to the computer is turned off. 

SECONDARY DEVICES: 

Hard disk drives store information in magnetic particles embedded in a disk. Usually a 

permanent part of the computer, hard disk drives can store large amounts of information and 

retrieve that information very quickly. The disks are of different sizes such as 1G, 10G, 40G, etc. 

Floppy disk drives also store information in magnetic particles embedded in removable 

disks. Floppy disks store less information than a hard disk drive and retrieve the information at a 

much slower rate. It is of 2 type 51/4 floppy disk and 31/2 floppy disk. 

Magneto-optical disc drives store information on removable discs that are sensitive to 

both laser light and magnetic fields. They can typically store as much information as hard disks, 

but they have slightly slower retrieval speeds. 

Compact Disc Drives store information on pits burned into the surface of a disc of reflective 

material such as CD-ROM. CD-ROMs can store about as much information as a hard drive but 

have a slower rate of information retrieval. 

Digital Video Disc (DVD): This is similar and works like a CD-ROM but can store more than 

15times as much information. 

Flash drives work as floppy disks but more sensitive as a hard disk that must be ejected 

logical before final removal from the computer system. It has more memory than floppy disks. 



 

 

Memory Cards work as flash drive but with an additional device called the card reader. 

This is very effective and more durable than the flash drives. 

Some devices serve more than one purpose. For example, floppy disks may also be used as 

input devices if they contain information to be used and processed by the computer user. In 

addition, they can be used as output devices if the user wants to store the results of computations 

on them. 

INPUT DEVICES: 

Input unit consists of external devicesóthat is, components outside the computerís CPU. It 

provides or fetches information and instructions to the computer. These include keyboard, mouse 

(mechanical/ opto- mechanical/ opticals), light pen, joystick, scanner, microphones (voice 

recognition modules), Optical Character Reader (OCR), Magnetic Ink Character Reader 

Recognition (MICR), bar code reader, badge reader, digitizer, touch screen and optical mark reader 

(OMR). 

Light pen: This is a stylus with a light sensitive tip that is used to draw directly on a 

computerís video screen or to select information on the screen by pressing a clip in the light pen 

or by pressing the light pen against the surface of the screen. The pen contains light sensors that 

identify which portion of the screen it is passed over. It is mostly used with Laptop. 

Mouse: This is a pointing device designed to be gripped by one hand. It has a detection 

device (usually   a ball) on the bottom that enables the user to control the motion of an on-screen 

pointer, or cursor, by moving the mouse on a flat surface. As the device moves across the surface, 

the cursor moves across the screen. To select items or choose commands on the screen, the user 

presses a button on the mouse. 

Joystick is a pointing device composed of a lever that moves in multiple directions to 

navigate a cursor or other graphical object on a computer screen. 

Keyboard: Keyboard is typewriter-like devices that allows the user to type in text, numeric 

and execute commands with the aid of the functional keys on the keyboard. 

Optical Scanner: This is light-sensing equipment that converts images such as a picture or 

text into electronic signals that can be manipulated by a computer. For example, a photograph 

can be scanned into a computer and then included in a text document created on that computer. 

The two most common scanner types are the flatbed scanner, which is similar to an office 

photocopier, and the handheld scanner, which is passed manually across the image to be 



 

 

processed. 

Microphone: This is a device for converting sound into signals that can then be stored, 

manipulated, and played back by the computer. A voice recognition module is a device that 

converts spoken words into information that the computer can recognize and process. 

Modem: It stands for modulator-demodulator, is a device that connects a computer to a 

telephone line or cable television network and allows information to be transmitted to or received 

from another computer. Each computer that sends or receives information must be connected to 

a modem. 

 

OUTPUT DEVICES 

Output devices consists of hardware that transfer information from the computerís CPU to 

the computer user. This includes the monitor, Printer, plotters, or speaker. 

Video Graphic Adapter: This is a device that converts information generated by the 

computer into visual information called Monitor. It looks similar to a television set. Information 

from the CPU is displayed on the screen of the monitor. 

Printers: Information and graphics processed or produced with the aid of computer are 

printed out as hardcopy with the aid of printer. There are different types of printers; Dot-matrix 

printers, Laser printers, Inkjet, etc. 

Plotters: Computer output to microfilm or fiche (COM) which process information on rolls 

of film (drum plotter) or slide of film (flatbed plotter). 

 

FEATURES OF COMPUTERS: 

 

People use computers in many ways; business, computers are used to track inventories with 

bar codes and scanners, check the credit status of customers, and transfer funds electronically, 

homes, tiny computers embedded in the electronic circuitry of most appliances control the indoor 

temperature, operate home security systems, tell the time, and turn video cassette recorders 

(VCRs) on and off, automobiles regulate the flow offuel, thereby increasing gas mileage, they 

also entertain, creating digitized sound on stereo systems or computer-animated features from a 

digitally encoded laser disc. 



 

 

Computer programs, or applications, exist to aid every level of education, from programs 

that teach simple addition or sentence construction to programs that teach advanced calculus. 

Educators use computers to track grades and communicate with students; with computer-controlled 

projection units, they can add graphics, sound, and animation to their communications. Computers 

are used extensively in scientific research to solve mathematical problems, investigate complicated 

data, or model systems that are too costly or impractical to  build, such as testing the air flow 

around the next generation of aircraft. The military employs computers in sophisticated 

communications to encode and unscramble messages, and to keep track of personnel and supplies. 

CLASSIFICATION OF COMPUTERS: 

Analog computer 

These systems were the first type to be produced. It is an electronic machine capable of 

performing arithmetic functions on numbers which are represented by some physical quantities 

such as temperature,  pressure, voltage, etc. Analog refers to circuits or numerical values that have 

a continuous range. Popular analog computer used in the 20th century was the slide rule. 

Digital Computers 

Virtually all modern computers are digital. Digital refers to the processes in computers that 

manipulate binary numbers (0s or 1s), which represent switches that are  turned on  or off by 

electrical current. A bit can  have the value 0 or the value 1, but nothing in between 0 and 1. A 

desk lamp can serve as an example of the difference between analog and digital. If the lamp has a 

simple on/off switch, then the lamp system is digital, because the lamp either produces light at a 

given moment or it does not. If a dimmer replaces the on/off switch, then the lamp is digital, 

because the amount of light can vary continuously from on to off and all intensities in between. 

Digital computers are more common in use and it will be our focus of discussion. 

Hybrid Computer 

This is when a computer make is of both analog and digital components and techniques. Such 

computer require analog to digital and digital to analog converter which will make analog and 

digital data palatable to it. The basic classification nowadays uses the following. 

1. The Desktop 

A computer is referred to as "desktop" when it is relatively small enough to be 

positioned on top of a table where a person is working. Such a computer can also be 



 

 

placed on the floor or somewhere under, or aside of, the table, in which case the monitor would be 

placed on top of the table. This is the most common type of computers used in the office or at 

home. A desktop computer is made of different parts that are connected with cables. 

2. The Laptop 

A computer is called laptop when it combines the CPU, the monitor, the keyboard, and 

the mouse in one unit to be so small that you can carry it on your laps when traveling or 

commuting. A laptop is also called  a notebook. Other parts, such as an external mouse, an 

external keyboard, or peripherals such as a printer or a projector, can be connected to the 

laptop. A laptop is only physically smaller than a desktop but, everything considered, it can do 

anything that a desktop can do. 

3. The Server 

 

A server is a computer that holds information that other computers, called 

workstations, can retrieve. Such workstations are connected to the server using 

various means. This means that they could be connected using cable, wireless 

connection, etc. Only computers that maintain a type  of  connection with the 

server can get the information that is stored in the server. 

Normally, although not particularly recommended, any computer, including a desktop or 

even a laptop can be used as a server, as long as it can do the job required. A server is more defined 

by the program (called an operating system) that is installed in it, not how the machine looks. 

Any type of computer, including a desktop, a laptop, a CD or DVD machine, etc can be 

connected to a server. The person who sets up a server also defines the types of connections it is 

made for. 

4. The Mainframe 

 

A mainframe is a computer, usually physically big, that does almost all the jobs for other 

types of computers that are connected to it. This is a broad definition but other aspects are 

involved. Like a server, the program (operating system) that runs in the mainframe defines 

its role. 

 

 



 

 

DIFFERENT PARTS OF A COMPUTER AND THEIR USES 

 

The standard computer consists of a monitor, a keyboard, a mouse and the system unit. One 

can attach accessories such as printers and scanners by means of ports. Increasingly in the 

workplace, computers are connected to printers and other computers by means of a network. 

 

The monitor 

This is the Visual Display Unit (VDU). There are various technologies for the display unit, 

cathode  ray tube (CRT) or Liquid  Crystal Display (LCD) or electro luminescent screens or  the 

projector. The monitor or screen displays your work. Facing it down reduces  reflected glare from 

room lights. This reflection may affect your sight. Monitors come in  different  sizes. The (most 

important) size of the monitor is measured diagonally on the screen (in inches). Based on this, the 

monitors range in sizes of 12", 14", 15", 17", 19", 21", 29", etc. Monitors are also characterized by 

the flatness of their screen. The flatter and the  wider screens  are usually  the better. 

 

The system box or computer console 

The system box is where all the computations that the computer performs take place. Inside 

are the CPU processor, the motherboard, the hard disk, any network or sound cards, memory chips 

(RAM), printer ports (at the back) and the drive bays for floppy disks, Zip disks or  CDs. Outside 

the casings are the power buttons (ON/OFF and Restart) with some additional facilities like the 

casing USB ports, Webcams, etc. 

 

The keyboard (Pressing) 

This is the basic input device. It is one of the ways you can tell the computer what to do. It 

consists of the standard typewriter keys as well as a numeric keypad and function  keys.  You can 

use it to give the computer commands, name folders and files, and type  text in word processing 

documents. The keyboard is made of three main categories of keys with 

each used for a different purpose. 

 

 

 



 

 

The Mouse (Clicking and Dragging) 

This is another input device used to move a small white arrow pointer-the Cursor (but the shape 

will change depending on the context in which the mouse is being used) on the screen. By pointing 

and clicking you can carry out commands. The computer may ask you to verify that you are sure to 

rename a file, by clicking on the ëOkí button. A mouse is primarily made of three parts: the 

buttons, the handling area, and the sensor (rolling object or light). There are either one, two or 

three mouse buttons. By default, a mouse has two buttons: left and right. Most mice nowadays are 

also equipped with  a  wheel on top of the middle button called the Scroll Button. 

 

Motherboard: The motherboard is a printed circuit board that connects other components through 

the use of traces, or electrical pathways. The motherboard is indispensable to the computer and 

provides  the main computing capability. Personal computers normally have one central processing 

unit (CPU) on the motherboard. 

 

COMPUTER SOFTWARE: 

Software is the set of instruction that tells the computer what to do and when to do it. The 

computer uses this instruction to manipulate data, and enhance the proper functioning of the 

hardware components. It is designed to exploit and provide the potential capabilities of the 

hardware to the user. It converts data into information and allows users to use the computer in 

different ways. 

Computer programs are written by human beings, like you. This means that the person who 

writes a program also decides on its functionality and behaviour; which explains why two 

programs that are supposed to do the same thing, don't do it the same way. This is why, regardless 

of your expertise, you need to be acquainted with a particular program in order to make better use 

of it. The fact that you don't know a particular program doesn't say anything about your 

intelligence or lack of it. It simply means that you are not familiar with that program. 

These programs are usually stored and transferred via the computerís hardware to and from 

the CPU. Software also governs how the hardware is utilized; for example, how information is 

retrieved from a storage device. The interaction between the input and output devices is controlled 

by software called the Basic Input Output System (BIOS) Software. Software as a whole can be 

divided into a number of categories based on the types of work done by programs. The two 



 

 

primary software categories are system software, and application software. 

 

SYSTEM SOFTWARE 

This refers to set of programs that facilitate the optional use of the hardware systems by 

coordinating them. It consists of programs that start up the computer and perform some utility 

functions such as checking and getting the computer ready for use. They are usually written to 

accomplish loading, execution, storage, and retrieval of files from/into the computer. They are 

basically operating system, utility software, and language translators. 

 

Operating System 

An operating system is a program that acts as an intermediary between the application 

programs and the computer hardware.You cannot directly use computer applications (or programs) 

with computer hardware without a translation system between the hardware and the applications. 

This translation system is called the operating system (OS). The Windows or Mac OS works 

ìbehind-the-scenesî to run your computer (i.e. the software and the hardware). It tells the computer 

what to do when it starts up and keeps track of  your  documents, files, and other software. It also 

provides the standard user interface component (like menus and the desktop) that you see when 

you look at your computer screen. Both the Windows and the Mac OS operating systems use a 

graphical interface (pictures or icons instead of text) that allow you to immerse yourself in 

multitasking (accessing multiple applications and files simultaneously). You work with ìwindowsî 

in this interface. These windows are a series of boxes, which can be opened and closed as needed. 

We shall be using Microsoft Windows Operating System as it is the most common on the 

personal computers. There are various types of Microsoft Windows. A type of Microsoft Windows 

is referred to as a version. Examples of versions are Microsoft Windows 3.3, Microsoft Windows 

95, Microsoft Windows NT Workstation, Microsoft Windows NT Server, Microsoft Windows 98, 

Microsoft Windows 98 Second Edition, Microsoft Windows Millennium, Microsoft Windows 

2000 Professional, Microsoft Windows 2000 Server, Microsoft Windows XP Home Edition, 

Microsoft Windows XP Professional, and Microsoft Windows Server 2003. 
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INTRODUCTION TO WINDOWS 

 Microsoft Windows Operating System 

All computers and computer like devices have operating systems, including your laptop, tablet, 

desktop, Smartphone, smart watch, router etc.  

Windows is operating system from Microsoft Inc. It is a system program that controls, 

coordinates and manipulates overall desktop publishing operations. It serves as an interface 

between the hardware and other software on the computer system. It allocates memory 

locations to data and other computer programs. It controls other computer resources like files 

and programs, input/output devices, computer memories etc during data processing operations. 

It also performs the hardware and software diagnosis to detect faults and errors. 

 

Versions of windows 

Windows provides a graphical user interface (GUI), and support  many peripheral devices. In 

addition to windows operating system for personal computers, Microsoft also offers operating 

system for servers and personal computers. 

1. Windows 1.0- 2.0 (1985-1992). Window 1.0 allowed users to point and click to access 

the windows. Window 2.0 added icons, keyboard shortcuts and improved graphics. 

 

2. Windows 3.0-3.1 (1990-1994). Support better icons and program manager (1st version 

of “look and feel” screen of Microsoft windows). 

 

3. Windows 95 (August 1995). It  runs faster and  has ability to automatically delete and 

configure installed hardware (plug and play). 

 

4. Windows 98 (June 1998). It offers supports for new technology FAT32, AGP, MMX, 

USB, DVD. It is an active desktop which integrates the web browser (internet 

Explorer). 

 

5. Windows ME- Millennium Edition (September 2000). Booting is in Dos option. 

 

6. Windows NT 3.1-4.0 (1993-1996).  It supports pre-emptive multi tasking. They are 

Windows NT and Windows NT SERVER. 

 

7. Windows 2000 or W2k. (February 2000). It is an operating system for business desktop 

and laptop systems to run software applications. 

 

8. Windows XP (October 2001). It has a better look and feel. There are two versions Home 

and professional. 

 

9. Windows Vista (November 2006). It  offered an advancement in reliability, security 

and ease of deployment. 
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10. Windows 7 (October 2009). Improved performance and start-up-time and window 

media centre. 

 

11. Windows 8 (August 2012). It was developed with touch screen use in mind. Better start-

up. Start screen replaced look and feel  screen made up of “live Tiles” 

 

12. Windows 10 (2015).  Fast start-up, Microsoft edge, Microsoft new browser. 

 

13. Window server (2003). Designed for corporate networking, internet/intranet, hosting, 

data bases and similar functions. 

 

14. Window Home Server (January 2007). This is a “consumer Server” designed to use 

with multiple computers connected in the home. 

 

Aside from window operating system designed for personal computers (PCs) and 

laptops, Microsoft has also developed operating system for services, handheld devices 

and mobile phones. 

 

1. Window CE (November 2006) it is designed for small devices such as PDAs for 

handheld computing devices. 

 

2. Windows mobile (April 2000) designed for smart phones and mobile devices. 

 

3. Windows phone 7-10 (November 2010) or win phone 7 designed for smart phones and 

mobile devices but targeted more to the consumer market than enterprises market. 

 

Major Features of Windows 

The following are the attributes and characteristics of reliable windows: 

(i) Interactive Package: It ensures a flow of communication between the user and the 

computer. Hence, it serves as an intermediary between the two parties. 

(ii)  Menu Driven Package: Ms-Windows ensure flexibility in that the user can 

perform several functions or task without remembering the commands, simply by 

the Click. Of an option of a menu or sub-menu. 

(iii) Program Manager: Ms-Window serves as a manager to other programs since it 

controls, co-ordinates and manipulates their processing. 

(iv) Multi-tasking Package: With windows operations, a user can make use of two or 

more package while shifting from one package to another e.g. A user can be 

working in ms-excel, and at the same time involve in PageMaker etc. 

 

Appearance of Window Screen 

The appearance of window screen depends on how the computer is being set-up. A window 

screen always contains various items or ICON depending on the window version. Hence, a 

reliable window screen consists of the following: major icons and other additional icons. 

(i) My computer Icon: This is a container for disk drives. My computer icon displays 

window with Icons representing object in the computer system. Such as folder, files, 

disk-drive. 

(ii) Internet Explorer: This is a shortcut for launching the internet explorer program, 

which is web browser. A web browser is a software program for navigating, WWW 

(World Wide Web). 



(iii) Network Neighbourhood: Network neighbourhood icon serves as container for 

network resources of other, computer it might include items such as; disk drive, 

printer and CD-ROMS. 

(iv) Network: A network is a collection of several computer connected together with 

the aim of sharing the same resources and component e.g. printer. 

(v) Recycle Bin: This is a computer object for files that are no longer needed the 

computer or, this is a temporary storage location where all files are kept. One can 

retrieve such file if deleted by error. 

 

 

 
 

  Fig. 7.1: Different versions of windows 

Window Screens 

The windows’ screen consists of several icons arranged according’ to the computer set up the 

user. 

 

Icons: An icon is an image or picture representing a particular function on the window’s screen. 

It is like a command or instruction to perform a particular task. Some of the icons noticed on 

the window screen a computer, network neighbourhoods, Recycle Bin, Internet Explorer, Start 

and Tune button. 

To access an icon, double click on such, and window responds by displaying the operation 

under the icon. 

 

Accessing Windows 

When a computer system is switch on, the memory tent is performed until the window screen 

appears automatically. 

Window screen is divided into two parts; the upper layer which contains several icons and the 

lower layer called the status /bar which contain the: start button, task bar and time. 

 



Status Bar: This is the lower part of the windows. It consists’ of the start button, task bar and 

time. 

 

Start Button: it contain everything needed to work with windows, start icon of the windows 

consists of several options in form of sub-menu. Hence, when you click on start button, a sup-

menu appears as follows: 

(i) Program: it displays the list of software available in the windows environment for 

the user to utilize. 

(ii) Document: it displays the list of documents that have been opened previously. 

(iii) Setting: it list out all the computer components which their setting can be changed 

e.g. setting date and time, changing window screen etc. 

(iv) Find: it is used to find and locate a particular file, folder and e-mail messages. 

(v) Help: it shows the steps involve in performing a particular task. It equally serves as 

a tutor. 

(vi) Run: it is mainly used to run or execute Ms-command and other application 

packages. 

(vii) Shut Down: it is used to shut down or re-start the computer. It should be noted that 

the system must be properly shut down before switching off the system. 

 

Task Bar  

Each time an operation is performed, a button representing that window appears on the task 

bar. To switch from the window to another click on the button for the window you want in the 

task bar. 

 

Notification Area 

It shows at the extreme end of the status bar. It displays the current time. 

 

Folder 

A folder is a directory, which stores files and other folders. Or a folder is a directory through 

which users can access files and other folders. 

 

Windows Operating Devices 

These are electronic devices used in manipulating windows. It could be input device or output 

device. 

Input Device 

An input device is a peripheral (piece of computer hardware equipment) used in sending in 

data, control signals and graphics to the computer memory or any other information processing 

system allowing you to interact with and control the computer. They include keyboard, mouse 

scanner, joystick, light pen etc. 

(i) Computer Keyboard: it is a rectangular tray of electronic keys used as input device 

to send data, instructions, commands and signals into the computer. It is the 

‘primary computer input unit device. It consists of several types of keys: 

Function Keys: F1-F12 

Alphabetic Keys: A-Z,. 

Numeric Keys: 0-9 

Control Keys: Alt key {), Ctrl key, Fn key etc 

Editing Keys: End, Spacebar, Backspace, Caps Lock, Del key etc. 

Directional/Navigating Keys: the arrow keys, Pg Up and PgDn and Keys, Home 

and End keys. 

Special Function Keys: Ctrl+A, insert, Numlock, PrtSc etc. 



Special Character Keys: I, / @, “, #, !, &,%,*,(),{}, [], :, ;, -, +, =, etc. 

 

(ii) Mouse: this is a rat-like pointing device used as input device to send command to 

the computer by point, click and drag operations. Mouse could be an optical mouse 

or rolling ball mouse, a PS/2 mouse, a Serial mouse or the padded (as found on 

laptops PDAs). 

 

(iii) Scanner: this is a graphic puts service that sends graphics, picture, and images to 

the computer memory for processing. It consists of tubes light that takes the picture 

of an object and send it to the memory for processing. 

 

Computer Keyboards 

A keyboard is the most fundamental input device for any computer system. In the early days 

of computing, it was typically the only input device. 

Keyboard is one of the input devices that used to transfer data, from outside world into the 

CPU. As you type, the processor in the keyboard analyzes the key matrix and determines what 

characters to send to the computer. It maintains three characters in its memory buffer and then 

sends the data. 

 

  
a. Typical keyboard for desktop computer  b. Typical laptop computer 

 

Many keyboards connect to the computer through a cable with a PS/2 or USB (Universal Serial 

Bus) connector. Laptops use internal connectors. Regardless of which types of, connector is 

used, the cable must carry power to the keyboard, and it must carry signals from the keyboard 

back to the computer. 

Wireless keyboards, on the other hand connect to the computer through infrared (IR), radio 

frequency (RF) Bluetooth connections. IR and RF connections are similar to what you will find 

in a remote control. Regardless of which sort of signal they use, wireless keyboards require a 

receiver, either built in or plugged in to the USB port, to communicate with the computer. Since 

they don’t have a physical connection to the computer, wireless keyboards have an AC power 

connection or use batteries for power.  

 

Microsoft Wireless Keyboard 

Microsoft Wireless Keyboard is a battery-powered computer keyboard. Whether it’s through a 

cable or wireless, the signal from the keyboard is monitored by the computer’s keyboard 

controller. This is an integrated circuit (IC) that processes all of the data that comes from the 

keyboard and forwards it to the operating system. When the operating system (OS) is notified 

that there is data from the keyboard it checks to see if the keyboard data is a system level, 

command (i.e. command that controls the computer system itself, a good example of this is 



Ctrl-Alt-Delete on a Windows computer, which reboots the system).  If it is not a system level 

command, then, the OS passes the keyboard data on to the current application. 

The application also determines whether the keyboard data is a command like Alt-F, which 

opens the file menu in a windows application. If the data is not a command, the application 

accepts it as content, which can be anything from typing a document to entering a URL to 

performing a calculation. If the current application does not accept keyboard data it simply 

ignores the information. This whole process, from pressing the key to entering content into 

application, happens almost instantaneously. 

 

The mouse 

Mouse Techniques 

These are the modes of using mouse. They include: 

(i) Pointing: this is a process of making the mouse pointer touch an option or icon on 

a window screen during selection of an object or option. 

(ii) Clicking: this is a process of pointing the mouse pointer at the option or      icon 

and instantly presses the left right button to select an option. 

(iv) Dragging: this is a process of holding down the left button and move the mouse 

along the mouse pad and release when desired. 

(v) Double clicking: it is a process of pressing the button on two consecutive times i.e. 

we double click to see the content of an icon. 

 

 

 

 
 

Typical mouse 

Mouse innovations 

As with many computer-related devices, mouse is being combined with other gadgets and 

technologies to create improved and multipurpose devices. Examples include multi- media 

mouse, combination mouse/remote controls, optical mouse, gaming mouse, biometric mouse, 

tilting wheel mouse and motion-based mouse. To learn more about innovations in mouse 

technology, let’s start with multi-media mouse and combination mouse/remote controls. 

 

Multi-media Mouse and Combination Mouse/Remote 

These types’ of mouse are used with multimedia systems such the windows 

XZ media Center Edition computers. Some combine features of a mouse with additional as 

buttons (such as play, pause; forward, back and volume) for controlling media. Others resemble 

a television/media player remote control with added features for mousing. Remote controls 

generally use infrared sensor but some use a combination of infrared and RF technology for 

greater range. 

 

Gaming Mouse 

Gaming Mouse are high-pressure, optical mouse designed for use and game controllers. Its 

features may include: 



Multiple buttons for added flexibility and functions such as adjusting (dots per inch) rates on 

the fly. 

Wireless connectivity and an optical sensor. 

Motion feedback and two-way communication 

 

Motion Based Mouse 

Yet another innovation in mouse technology is motion-based control feature, you control the 

mouse pointer by waving the mouse in the air. 

 

Biometric Mouse 

Biometric Mouse adds security to your computer system by permitting-authorized users to 

control the mouse and access the computer. Pro’ accomplished with an integrated fingerprint 

reader either in the receiver or the mouse. This feature enhances security and adds convenience 

because-can use your fingerprint rather than passwords for a secure login. The Wireless 

Intellimouse Explorer with Fingerprint Reader is a Biome to use the biometric features, a 

software program that comes with registers fingerprints and stores information about 

corresponding users. Some software programs also let you encrypt and decrypt files. 

 

 keyboard track pads on a laptop computer 

Desktop computers have a separate keyboard and mouse, but for laptops, these are integrated 

into a computer system itself. In laptops, the mouse is actually substituted with a touch pad or 

track pad. You can still connect an external mouse to a laptop if you prefer. 

 

  
Computer flatbeds scanners. 

Another common input device is an image scanner. A typical desktop or flatbed scanner is a 

device that optically scans printed images and paper documents and converts them into digital 

images. 

 

 

 Microphone. 

Audio and video can be recorded using a microphone and video camera, respectively. Due to 

the popularity of video conference on Skpe, these are typically integrated in most laptops and 

monitor displays for desktops; however, you can also connect an external webcam, which can 

record both audio and video. 



 

 

 

Input devices 

The most commonly used or primary input devices in a computer are the keyboard and mouse. 

However, there are dozens of other devices that can also be used to input data into the computer. 

Below is a list of computer input devices that can be utilized with a computer or a computing 

device. 

1. Touch screen  

2. Webcam. 

3. Audio conversion device. 

4. Barcode reader. 

5. Finger print scanner. 

6. Business card reader. 

7. Digital camera and digital camcorder. 

8. Gamepad, Joystick, Paddle. 

9. Gesture recognition. 

10. Graphics tablet. 

11. Light gun and light pen scanner. 

12. Magnetic stripe reader. 

13. Microphone (using voice speech recognition or biometric verification). 

14. Touch pad or other pointing device. 

15. Optical mark reader (OMR). 

16. Light pen or stylus. 

17. Punch card reader. 

18. Video capture device. 

 

QUESTIONS 

1. List 5 input devices apart from the keyboard, mouse and scanner. 

2. What does an input device send to a computer? 

3. What is the difference between an input device and output device? 

4. What is window operating system 

5. List 3 types of window operating system with date and major features.  

6. What is the difference between status bar and task bar. 
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Microsoft Word 2007 Step by Step  
 

 

Lesson 1: Getting Familiar with Microsoft Word 2007 for 

Windows 

 
 The Microsoft Office Button 

 The Quick Access Toolbar 
 The Title Bar 
 The Ribbon 
 The Ruler 
 The Text Area 
 The Vertical and Horizontal Scroll Bars 
 The Status Bar 
 Understanding Document Views 
 Click 
 Understanding Nonprinting Characters 
 Create Sample Data and Select Text 
 Place the Cursor 
 Execute Commands with Keyboard Shortcuts 
 Start a New Paragraph 
 Exit Word 

  

Microsoft Word is a word processing software package. You can use it to type letters, reports, and 
other documents. This tutorial teaches Microsoft Word 2007 basics. Although this tutorial was created 
for the computer novice, because Microsoft Word 2007 is so different from previous versions of 
Microsoft Word, even experienced users may find it useful. 

This lesson will introduce you to the Word window. You use this window to interact with Word. To begin 
this lesson, open Microsoft Word 2007. The Microsoft Word window appears and your screen looks 
similar to the one shown here. 
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Note: Your screen will probably not look exactly like the screen shown. In Word 2007, how a window 
displays depends on the size of your window, the size of your monitor, and the resolution to which your 
monitor is set. Resolution determines how much information your computer monitor can display. If you 
use a low resolution, less information fits on your screen, but the size of your text and images are 
larger. If you use a high resolution, more information fits on your screen, but the size of the text and 
images are smaller. Also, Word 2007, Windows Vista, and Windows XP have settings that allow you to 
change the color and style of your windows. 

The Microsoft Office Button 

 

In the upper-left corner of the Word 2007 window is the Microsoft Office button. When you click the 
button, a menu appears. You can use the menu to create a new file, open an existing file, save a file, 
and perform many other tasks. 

The Quick Access Toolbar 

 

Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar provides you 
with access to commands you frequently use. By default Save, Undo, and Redo appear on the Quick 
Access toolbar. You can use Save to save your file, Undo to rollback an action you have taken, and 
Redo to reapply an action you have rolled back. 
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The Title Bar 

 
Next to the Quick Access toolbar is the Title bar. The Title bar displays the title of the document on 
which you are currently working. Word names the first new document you open Document1. As you 
open additional new documents, Word names them sequentially. When you save your document, you 
assign the document a new name. 

The Ribbon 

 
You use commands to tell Microsoft Word what to do. In Microsoft Word 2007, you use the Ribbon to 
issue commands. The Ribbon is located near the top of the screen, below the Quick Access toolbar. At 
the top of the Ribbon are several tabs; clicking a tab displays several related command groups. Within 
each group are related command buttons. You click buttons to issue commands or to access menus 
and dialog boxes. You may also find a dialog box launcher in the bottom-right corner of a group. 
Clicking the dialog box launcher gives you access to additional commands via a dialog box. 

The Ruler 

 
The ruler is found below the Ribbon. 

You can use the ruler to change the format of your document quickly. If your ruler is not visible, follow 
the steps listed here: 

 
1. Click the View tab to choose it. 

2. Click the check box next to Ruler in the Show/Hide group. The ruler appears below the Ribbon. 

The Text Area 

Just below the ruler is a large area called the text area. You type your document in the text area. The 
blinking vertical line in the upper-left corner of the text area is the cursor. It marks the insertion point. As 
you type, your text displays at the cursor location. The horizontal line next to the cursor marks the end 
of the document. 
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The Vertical and Horizontal and Vertical Scroll Bars 

The vertical and horizontal scroll bars enable you to move up, down, and across your window simply by 
dragging the icon located on the scroll bar. The vertical scroll bar is located along the right side of the 
screen. The horizontal scroll bar is located just above the status bar. To move up and down your 
document, click and drag the vertical scroll bar up and down. To move back and forth across your 
document, click and drag the horizontal scroll bar back and forth. You won't see a horizontal scroll bar if 
the width of your document fits on your screen. 

The Status Bar 

The Status bar appears at the very bottom of your window and provides such information as the current 
page and the number of words in your document. You can change what displays on the Status bar by 
right-clicking on the Status bar and selecting the options you want from the Customize Status Bar 
menu. You click a menu item to select it. You click it again to deselect it. A check mark next to an item 
means it is selected. 
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Understanding Document Views 

In Word 2007, you can display your document in one of five views: Draft, Web Layout, Print Layout, Full 
Screen Reading, or Online Layout. 

Draft View 
Draft view is the most frequently used view. You use Draft view to quickly edit your document. 

Web Layout 
Web Layout view enables you to see your document as it would appear in a browser such as 
Internet Explorer. 

Print Layout 
The Print Layout view shows the document as it will look when it is printed. 

Reading Layout 
Reading Layout view formats your screen to make reading your document more comfortable. 

Outline View 
Outline view displays the document in outline form. You can display headings without the text. If 
you move a heading, the accompanying text moves with it. 

You should use Draft view for these lessons. Before moving ahead, make sure you are in Draft view: 
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1. Click the View tab. 

2. Click Draft in the Document Views group. When the Draft option is selected it appears in a contrasting 
color. 

Click 

During the lessons that follow, you will be asked to "click" items and to choose tabs. When asked to 
click: 

1. Point to the item. 

2. Press your left mouse button once. 

If you are asked to double-click an item: 

1. Point to the item. 

2. Quickly press your left mouse button twice. 

If you are asked to right-click: 

1. Point to the item. 

2. Press your right mouse button. 

If you are asked to choose a tab, click the tab. 

Understanding Nonprinting Characters 

Certain characters, called nonprinting characters, do not print and will not appear in your printed 
document but do affect your document layout. You can elect to see these characters on the screen as 
you type or you can elect to have them remain invisible. For these lessons, opt to see them onscreen. 
This table describes most of them: 

Character Denotes 

 

A tab 

. A space 

¶ The end of a paragraph 
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Hidden text 

To view nonprinting characters: 

 
1. Choose the Home tab. 

2. Click the Show/Hide button  in the Paragraph group . The Show/Hide button appears in a contrasting 
color, when it is selected. 

Create Sample Data and Select Text 

If you type =rand() in your Word document and then press Enter, Word creates three paragraphs. You 
can use these paragraphs to practice what you learn. Throughout these lessons, you will be asked to 
select text. The following exercise teaches you how to create data and how to select data. You can 
select by using the arrow keys or by clicking and dragging. When using the arrow keys, use the up 
arrow to move up, the down arrow to move down, the left arrow to move left, and the right arrow to 
move right. When using the mouse, press the left mouse button and then drag in the direction you want 
to move. 

EXERCISE 1 

Create Sample Data 

1. Type =rand(). 
2. Press Enter. Three paragraphs appear in your document. 

Select with the Shift and Arrow Keys 

1. Place your cursor before the word "On" in the first paragraph. 

2. Press and hold down the Shift key, which serves as an "anchor" showing where text you wish to select 
begins or ends. 

3. Press the right arrow key until the first line of text is highlighted. 

4. Press the down arrow key until the first paragraph is highlighted. 

5. Click anywhere outside the highlighted area to remove the highlighting. 

Select with the Mouse 

1. Place your cursor before the word "You" in the second paragraph. 

2. Press and hold down the left mouse button. 
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3. Drag the mouse until you have highlighted the second paragraph. 

4. Click anywhere outside the highlighted area to remove the highlighting. 

Place the Cursor 

During the lessons, you will often be asked to place the cursor at a specific location (the insertion point) 
on the screen. You place the cursor by moving the cursor to the specified location and pressing the left 
mouse button or by using the arrow keys to move to the specified location. 

EXERCISE 2 

The Arrow Keys 

1. Use the down arrow key to move down your document. 

2. Use the right arrow key to move to the right. 

3. Use the up arrow key to move up. 

4. Use the left arrow key to move to the left. 

Cursor 

1. Move around your document by using you mouse and clicking in a variety of location. 

2. Click in a location and type. Note what happens. 

Execute Commands with Keyboard Shortcuts 

There are many methods you can use to accomplish tasks when using Word. Generally, you choose an 
option by clicking the option on the Ribbon. However, you can also use shortcut keys. A key name 
followed by a plus and a letter means to hold down the key while pressing the letter. For example, 
Ctrl+b means you should hold down the Ctrl key while pressing "b." A shorthand notation of the above 
would read as follows: 

Press Ctrl+b 

Typists who are slowed down by using a mouse usually prefer using keys. 

Start a New Paragraph 

When you type in Microsoft Word, you do not need to press a key to move to a new line. To start a new 
paragraph, press the Enter key.  

Exit Word 

You have completed Lesson One. Typically, you save your work before exiting. 

EXERCISE 3 

Close and Save—Windows Vista 
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1. Click the Microsoft Office button. A menu appears. 

2. Click Exit Word, which you can find in the bottom-right corner. 

 
 

3. You are prompted: "Do you want to save changes to Document1?" To save your changes, click Yes. 
Otherwise, click No. If you click Yes, the Save As dialog box appears. 

 
 

4. Move to the correct folder. 

5. Name your file by typing Lesson One.doc in the File Name field. 
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6. Click Save. Word saves your file. 

Close and Save—Windows XP 

1. Click the Microsoft Office button. A menu appears. 

2. Click Exit Word, which is in the bottom-right corner. 

3. You will be prompted: "Do you want to save changes to Document1?" To save your changes, click Yes. 
Otherwise, click No. If you click Yes, the Save As dialog box appears. 

4. Specify the correct folder in the Save In box. 

5. Name your file by typing Lesson One.doc in the File Name field. 
6. Click Save. Word saves your file. 
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Lesson 2: Microsoft Word 2007 Basic Features 
 

Lesson 1 familiarized you with the the Microsoft Word window. You are now ready to learn how to 
create a Word document. This lesson covers typing, using the Backspace key, using the Delete key, 
inserting text, bolding, underlining, and italicizing. To begin, open Microsoft Word.  

 Type, Backspace, and Delete 

 Insert and Overtype 
 Bold, Italicize, and Underline 
 Save a File and Close Word 

 

Type, Backspace, and Delete 
 
In Microsoft Word, you create documents by typing them. For example, if you want to create a report, 
you open Microsoft Word and then begin typing. You do not have to do anything when your text 
reaches the end of a line and you want to move to a new line—Microsoft Word automatically moves 
your text to a new line.  If you want to start a new paragraph, press Enter. Microsoft word creates a 
blank line to indicate the start of a new paragraph. To capitalize, hold down the Shift key while typing 
the letter you want to capitalize.  If you make a mistake, you can delete what you typed and then type 
your correction. 
You can use the Backspace key to delete. Each time you press the Backspace key, Microsoft Word 
deletes the character that precedes the insertion point. The  insertion point is the point at which your 
mouse pointer is located. You can also delete text by using the Delete key. First, you select the text you 
want to delete; then you press the Delete key. 

EXERCISE 1 

Type and Backspace 

1. Type the following sentence:  
Joe has a very large house. 

2. Delete the word "house." Using either the arrow keys or the mouse, place the cursor between the 
period and the "e" in "house." 

3. Press the Backspace key until the word "house" is deleted. 

4. Type boat. The sentence should now read: 
"Joe has a very large boat." 

Delete 
Delete the word "very" from the sentence you just typed. 

1. Select the word "very." You can place the cursor before the "v" in the word "very," press and hold down 
the Shift key, and then press the right arrow key until the word "very" is highlighted. 

2. Press the Delete key. The sentence should now read:  
"Joe has a large boat." 

Insert and Overtype 
While creating your document, you may find you need to insert text—place new text between existing 
text. Suppose, you type the sentence, "Joe has a large boat."  After typing it, you decide you want to 

http://www.baycongroup.com/word2007/02_word2007.html
http://www.baycongroup.com/word2007/02_word2007.html
http://www.baycongroup.com/word2007/02_word2007.html
http://www.baycongroup.com/word2007/02_word2007.html
http://www.baycongroup.com/word2007/02_word2007.html


assistant teacher: Wasan A. Alawsi                    Microsoft Word 2007 

13  

change the sentence to "Joe has a  large blue boat." With Microsoft Word, inserting a word, phrase, or 
even several paragraphs is easy. 
Alternatively, you may want to overtype text—replace old text with new text. For example, suppose you 
type the sentence, "Joe has a large blue boat." After typing it, you decide you want to change the 
sentence to  "Joe has a large gray boat." With Microsoft Word, overtyping the word blue with the word 
gray is also easy.  Before you attempt to insert or overtype, you should check the mode you are in—
Insert or Overtype. You right-click the Status bar and then use the Customize Status Bar menu to place 
the Insert/Overtype button on the Status bar. You can then use the Insert/Overtype button to switch 
between Insert and Overtype mode. When you are in Insert mode, you can insert text. When you are in 
Overtype mode, you can overtype text. By default, Microsoft Word is in the Insert mode. 

EXERCISE 2 

Placing the Insert/Overtype button on the Status bar 

1. Right-click the Status bar. The Customize Status Bar menu appears. 

2. Click Overtype. The Insert/Overtype button appears on the Status bar. 

3. If the word Insert appears on the Status bar, you are in Insert mode. 

4. If the word Overtype appears on the Status bar, click the word Overtype and it will change to Insert, 
thereby changing Word to Insert mode. 

Insert 

Make sure you are in Insert mode before proceeding. You are going to insert the word "blue" between 
the words "large" and "boat." 

1. Place the cursor after the space between the words "large" and "boat." 

2. Type the word blue. 
3. Press the spacebar to add a space. 
4. The sentence should now read:  

"Joe has a large blue boat." 

Overtype 
You can type over the current text (replace the current text with new text) in the Overtype mode. Do the 
following to change to the Overtype mode. 

 Click "Insert" on the Status bar. The word Insert changes to Overtype. 

Change the word "blue" to "gray." 

1. Place the cursor before the letter "b" in "blue." 

2. Type the word gray. 
3. The sentence should now read:  

"Joe has a large gray boat." 
Note: You can overtype text without changing to Overtype mode by selecting the text you want to 
overtype and then typing. 

Bold, Italicize, and Underline 
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When creating a document, you may need to emphasize particular words or phrases by bolding, 
underlining, or italicizing. Also, certain grammatical constructs require that you bold, underline, or 
italicize.  You can  bold, underline, and italicize when using Word. You also can combine these 
features—in other words, you can bold, underline, and italicize a single piece of text. 

When you need to perform a task in Microsoft Word, you can usually choose from several methods. 
The exercises that follow show you how to bold, underline, or italicize using four different methods: 
using the launcher, the Ribbon, the Mini-toolbar/context menu, and the keyboard. 

EXERCISE 3 
Type the following exactly as shown. Remember, pressing the Enter key starts a new paragraph. Press 
the Enter key at the end of each of the following lines to start a new paragraph. 

Launcher: Bold Italicize Underline these words. All three Regular 
Ribbon: Bold Italicize Underline these words. All three Regular 
Mini Toolbar: Bold Italicize Regular 
Keys: Bold Italicize Underline these words. All three Regular 
 

 
Your screen should look similar to the one shown here. 
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Bold with the Dialog Box Launcher 

 

 

1. On the line that begins with Launcher, select the word "Bold."  You can place the cursor before the 
letter "B" in "Bold." Press the Shift key; then press the right arrow key until the entire word is 
highlighted. 

2. Choose the Home tab. 

3. Click the dialog box launcher in the Font group. The Font dialog box appears. 
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4. Click Bold in the Font Style box. 
Note: You can see the effect of your action in the Preview window. To remove the bold, click Regular. 

5. Click OK to close the dialog box. 

6. Click anywhere in the text area to remove the highlighting. You have bolded the word bold. 

Alternate Method—Bold with the Ribbon 

 

 

 

1. On the line that begins with "Ribbon," select the word "Bold."  You can place the cursor before the letter 
"B" in "Bold." Press the Shift key; then press the right arrow key until the entire word is highlighted. 

2. Choose the Home tab. 

3. Click the Bold button  in the Font group. You have bolded the word bold. 

Note: To remove the bold, you can select the text and then click the Bold button  again. 
4. Click anywhere in the text area to remove the highlighting. 

Alternate Method - Bold with the Mini Toolbar 
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1. On the line that begins with "Mini Toolbar," select the word "Bold."  You can place the cursor before the 
letter "B" in "Bold."Press the Shift key; then press the right arrow key until the entire word is highlighted. 

2. Right-click. The Mini toolbar appears. 

3. Click the Bold button . You have bolded the word bold. 

Alternate Method—Bold with Keys 
1. On the line that begins with "Keys," select the word "Bold."  You can place the cursor before the letter 

"B" in "Bold." Press the Shift key; then press the right arrow key until the entire word is highlighted. 

2. Press Ctrl+b (hold down the Ctrl key while pressing b).  
Note: To remove the Bold, press Ctrl+b again. You can also remove formatting by pressing 
Ctrl+spacebar. 

3. Click anywhere in the text area to remove the highlighting. 

Italicize with the Dialog Box Launcher 
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1. On the line that begins with Launcher, select the word "Italicize."  You can place the cursor before the 
letter "I" in "Italicize." Press the Shift key; then press the right arrow key until the entire word is 
highlighted. 

2. Choose the Home tab. 

3. Click the dialog box launcher in the Font group. The Font dialog box appears. 

 

 

 

4. Click Italic in the Font Style box. 
Note: You can see the effect of your selection in the Preview window. To remove the italics, click 
Regular in the Font Style box. 

5. Click OK to close the Font dialog box. 

6. Click anywhere in the text area to remove the highlighting. You have italicized the word Italicize. 

Alternate Method—Italicize with the Ribbon 



assistant teacher: Wasan A. Alawsi                    Microsoft Word 2007 

19  

 

 

1. On the line that begins with "Ribbon," select the word "Italicize." You can place the cursor before the 
letter "I" in "Italicize." Press the Shift key; then press the right arrow key until the entire word is 
highlighted. 

2. Choose the Home tab. 

3. Click the Italic button  on the Ribbon. You have italicized the word Italicize. 

Note: To remove the italics, select the text and click the Italicize button  again. 
4. Click anywhere in the text area to remove the highlighting. 

Alternate Method—Italicize with the Mini Toolbar 

 

1. On the line that begins with "Mini Toolbar," select the word "Italicize." You can place the cursor before 
the letter "I" in "Italicize." Press the Shift key; then press the right arrow key until the entire word is 
highlighted. 

2. Right-click. The Mini toolbar appears. 
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3. Click the Italic button . You have italicized the word Italicize. 

Alternate Method—Italicize with Keys 
1. On the line that begins with "Keys," select the word "Italicize." You can place the cursor before the letter 

"I" in "Italicize." Press the Shift key; then press the right arrow key until the entire word is highlighted. 

2. Press Ctrl+i (hold down the Ctrl key while pressing i).  
Note: To remove italics, press Ctrl+i again. You can also remove formatting by pressing Ctrl+spacebar. 

3. Click anywhere in the text area to remove the highlighting.You have italicized the word Italicize. 

Underline with the Dialog Box Launcher 
You can underline when using Word. Word provides you with many types of underlines from which to 
choose.The following are some of the underlines that are available if you use the dialog box launcher: 

 

 

The following illustrates underlining with the dialog box launcher: 
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1. On the line that begins with "Launcher," select the words "Underline these words." 

2. Choose the Home tab. 

3. Click the dialog box launcher in the Font group. The Font dialog box appears. 

 

4. In the Underline Style box, click the down arrow to open the pull-down menu. 

5. Click the type of underline you wish to use.  
Note: To remove an underline, you select None from the pull-down menu. 

6. Click OK to close the dialog box. The underline you selected appears under the words. 

7. Click anywhere in the text area to remove the highlighting. 
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Alternate Method—Underline with the Ribbon 

 

 

1. On the line that begins with "Ribbon," select the words "Underline these words." 

2. Choose the Home tab. 

3. Click the Underline button  in the Font group . Alternatively, you can press the down arrow  next to 

the underline button  and click to choose the type of underline you want. 

Note: To remove the underlining, click the Underline button  again. 
4. Click anywhere in the text area to remove the highlighting. 

Alternate Method—Underline with Keys 
1. On the line that begins with "Keys," select the words "Underline these words." 

2. Press Ctrl+u (hold down the Ctrl key while pressing u).  
Note: To remove the underlining, press Ctrl+u again. 

3. Click anywhere in the text area to remove the highlighting. 

All Three with the Dialog Box Launcher 
1. On the line that begins with "Launcher," select the words "All three." 

2. Choose the Home tab. 

3. Click the dialog box launcher in the Font group. The Font dialog box appears. 

4. In the Font Style box, click Bold Italic. 
Note: You can see the effect of your selection in the preview window. To turn off the Bold Italic, click 
Regular. 

5. In the Underline box, click to open the pull-down menu. Click the type of underline you want to use. 
Note: To remove an underline, select None from the pull-down menu. 

6. Click OK to close the dialog box. 

7. Click anywhere in the text area to remove the highlighting. 

Alternate Method—All Three with the Ribbon 
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1. On the line that begins with "Ribbon," select the words "All three." 

2. Choose the Home tab. 

3. Click the Bold button  in the Font group. 

4. Click the Italic button  in the Font group. 

5. Click the Underline button  in the Font group. 

6. Click anywhere in the text area to remove the highlighting. 

Alternate Method—All Three with Keys 
1. On the line that begins with "Keys," select the words "All three." 

2. Press Ctrl+b (bold). 

3. Press Ctrl+i (italicize). 

4. Press Ctrl+u (underline).  
Note: You can remove formatting by highlighting the text and pressing Ctrl+spacebar. 

5. Click anywhere in the text area to remove the highlighting. 

 
 

Save a File and Close Word 
You must save your documents if you wish to recall them later. You can use the Save option on the 
Microsoft Office menu, to save a document. You can also save a document by typing Ctrl+s. The first 
time you save a document, the Save As dialog box appears.  Use the Save As dialog box to locate the 
folder in which you want to save your document and to give your document a name. After you have 
saved your document at least once, you can save any changes you make to your document simply by 
clicking the Save after you click the Microsoft Office button. 
The following exercise shows you how to save the file you just created and close Word. You will name 
your file Lesson Two. 

EXERCISE 4 

Save a File—Windows Vista: 

 
1. Click the Microsoft Office button. A menu appears. 



assistant teacher: Wasan A. Alawsi                    Microsoft Word 2007 

24  

2. Click Save. The Save As dialog box appears, if you are saving your document for the first time. 

 
 

3. Use the Address bar to locate the folder  in which you want to save your file. 

4. Name your file by typing Lesson Two.docx in the File Name box. 
5. Click Save. 

6. Click the Microsoft Office button. A menu appears. 

7. Click Exit Word, which is located in the bottom-right corner of the window. Word closes. 

 
 

Save a File—Windows XP 
1. Click the Microsoft Office button. A menu appears. 

2. Click Save. The Save As dialog box appears if you are saving your document for the first time. 

3. Specify the correct folder in the Save In box. 

4. Name your document by typing Lesson Two in the File Name box. 
5. Click Save. 

6. Click the Microsoft Office button. A menu appears. 

7. Click Exit Word, which is located in the bottom-right corner of the window. Word closes. 

Every time you save your document, you overwrite the previous version of your document. For 
example, you create a document and save it. Later you delete several passages from the document 
and then save your changes. The passages from the first draft of the document no longer exist. If you 
want to save both the original draft of your document and the revised document, you must save the 
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second draft of the document using a different name. To save the document using a different name, 
click the Microsoft Office button. A menu appears. Click Save As. The Save As dialog box appears. 
Use the File Name box to give your document a new name.  
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Lesson 3: More Basic Features 
 Open a File 

 Cut and Paste 
 Copy and Paste 
 Use the Clipboard 
 Create AutoText 
 Use Spell Check 
 Find and Replace 
 Change the Font Size 
 Change the Font 
 Save Your File 

 

The features in Word 2007 can make your work easier, make your documents more attractive, and/or 
enable you to work more efficiently. This Microsoft Word lesson teaches you how to open a file, cut, 
copy, paste, use AutoText, use spell check, use Find and Replace, and change fonts. All of these 
features either make your work easier or make your document more attractive. 

Open a File 
When you do not have time to complete your work or when you finish your work, you can save and 
close your file. After saving a file, you can later open it to revise or finish it.  You learned how to save a 
file in Lesson 2. In the exercise that follows, you learn how to open the file you saved. 

EXERCISE 1 

Open a File with Windows Vista 

If you are using Windows Vista: 

1. Open Word 2007. 

2. Click the Microsoft Office button. A menu appears. 

3. Click Open. The Open dialog box appears. 

4. Locate the folder in which you saved the file. The file is named Lesson Two.docx. 

5. Click Lesson Two.docx. 

6. Click Open. The file you created during the previous lesson appears. 

Open a File with Windows XP 

If you are using Windows XP: 

1. Open Word 2007. 

2. Click the Microsoft Office button. A menu appears. 

3. Click Open. The Open dialog box appears. 

4. Use the Look In field to move to the folder in which you saved the file. The file is named Lesson 
Two.docx. 

5. Click Lesson Two.docx. 
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6. Click Open. The file you created during the previous lesson appears. 

Alternate Method—Opening a File with Keys 

1. Open Word 2007. 

2. Press Ctrl+o. 

3. Locate the folder in which you saved your file. The file is named Lesson Two.docx 

4. Click Lesson Two.docx. 

5. Click Open. The file you created during the previous lesson appears. 

Cut and Paste 
You can use Word's Cut feature to remove information from a document.  The you can use the Paste 
feature to place the information you cut anywhere in the same or another document.   In other words, 
you can move information from one place in a document to another place in the same or different 
document by using the Cut and Paste features. The Office Clipboard is a storage area. When you cut, 
Word stores the data you cut on the Clipboard. You can paste the information that is stored on the 
Clipboard as often as you like.  

EXERCISE 2 

Cut with the Ribbon 

 

1. Type the following:  
I want to move. I am content where I am. 

2. Select "I want to move. " 

3. Choose the Home tab. 
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4. Click the Cut button  in the Clipboard group. Word cuts the text you selected and places it on the 
Clipboard. Your text should now read:  
"I am content where I am." 

Paste with the Ribbon 

 

1.  

2. Place the cursor after the period in the sentence "I am content where I am." 

3. Press the spacebar to leave a space. 

4. Choose the Home tab. 

5. Click the Paste button  in the Clipboard group. Word pastes the text on the Clipboard. Your text 
should now read:  
"I am content where I am. I want to move." 

Alternate Method—Cut with a Context Menu 
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1. Type the following:  
I want to move. I am content where I am. 

2. Select "I want to move. " 

3. Right-click. The Mini toolbar and a context menu appear. 

4. Click Cut on the menu. Your text should now read:  
"I am content where I am." 

Alternate Method—Paste with a Context Menu 

 

1. Place the cursor after the period in the sentence  
"I am content where I am." 

2. Press the spacebar to leave a space. 
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3. Right-click. A Mini toolbar and a context menu appear. 

4. Click Paste. Your text should now read:  
"I am content where I am. I want to move." 

Alternate Method—Cut with Keys 

1. Type the following:  
I want to move. I am content where I am. 

2. Select "I want to move." 

3. Press Ctrl+x. 

4. Your text should now read:  
" I am content where I am." 

Alternate Method—Paste with Keys 

1. Place the cursor after the period in the sentence: "I am content where I am." 

2. Press the spacebar to leave a space. 

3. Press Ctrl+v. 

4. Your text should now read:  
"I am content where I am. I want to move." 

Copy and Paste 
In Microsoft Word, you can copy information from one area of a document and place the information 
you copied anywhere in the same or another document. In other words, after you type information into 
a document, if you want to place the same information somewhere else, you do not have to retype the 
information. You simple copy it and then paste it in the new location. As with cut data, Word stores 
copied data on the Clipboard. 

EXERCISE 3 

Copy with the Ribbon 

 

1. Type the following:  
You will want to copy me. One of me is all you need. 

2. Select "You will want to copy me." 
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3. Choose the Home tab. 

4. Click the Copy button  in the Clipboard group. Word copies the data you selected to the Clipboard. 

Paste with the Ribbon 

 

1. Place the cursor after the period in the sentence: "One of me is all you need." 

2. Press the spacebar to leave a space. 

3. Choose the Home tab. 

4. Click the Paste  button in the Clipboard group. Word places the data you copied at the insertion 
point. Your text should now read: "You will want to copy me. One of me is all you need. You will want to 
copy me." 

Alternate Method—Copy with a Context Menu 

 

1. Type the following:  
You will want to copy me. One of me is all you need. 

2. Select "You will want to copy me." 

3. Right-click. A Mini toolbar and a context menu appear. 

4. Click Copy. Word places the data you copied at the insertion point. Your text should now read: "You will 
want to copy me. One of me is all you need. You will want to copy me." 

Alternate Method—Paste with a Context Menu 
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1. Place the cursor after the period in the sentence: "One of me is all you need." 

2. Press the spacebar to leave a space. 

3. Right-click. A context menu appears. 

4. Click Paste. Word pastes the information on the Clipboard into the document. 

Alternate Method—Copy with Keys 

1. Type the following:  
You will want to copy me. One of me is all you need. 

2. Select "You will want to copy me. " 

3. Press Ctrl+c. Word copies the information you selected to the Clipboard. 

Alternate Method—Paste with Keys 

1. Place the cursor after the period in the sentence "One of me is all you need." 

2. Press the spacebar to leave a space. 

3. Press Ctrl+v. 

4. Your text should now read:  
"You will want to copy me. One of me is all you need. You will want to copy me." 

Use the Clipboard 
As you cut or copy, Word can store the information you have cut or copied on the Clipboard in a 
hierarchy. Then each time you cut or copy, the data you just cut or copied moves to the top of the 
Clipboard hierarchy and the data previously at the top moves down one level. When you choose Paste, 
the item at the top of the hierarchy is the item Word pastes into your document. The Clipboard can 
store up to 24 items. You can paste any item on the Clipboard into your document by placing your 
cursor at the insertion point, displaying the Clipboard pane, and then clicking the item. 

The Clipboard pane includes an Options button. You can click the Options button to set the Clipboard 
options described in the following table. 

Option Description 

Show Office Clipboard Automatically Shows the Clipboard automatically when you copy 
items. 

Show Office Clipboard When Ctrl+c 
Pressed Twice 

Shows the Clipboard when you press Ctrl+c twice. 

Collect Without Showing Office 
Clipboard 

Copies to the Clipboard without displaying the 
Clipboard pane. 
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Show Office Clipboard Icon on Taskbar Displays the Clipboard icon on your system 
taskbar. 

Show Status Near Taskbar When 
Copying 

Displays the number of items copied on the 
taskbar when copying. 

EXERCISE 4 

Use the Clipboard 

 

1. Place the cursor at the point at which you want to insert your text. 

2. Choose the Home tab. 

3. Click the Clipboard dialog box launcher to open the Clipboard. 

4. Click the item on the clipboard you want to insert into your document. Word pastes the Clipboard item 
into your document at the insertion point. 

Create AutoText 
Cut and Copy both store information on the Clipboard. Information you store on the Clipboard is 
eventually lost. If you want to store information permanently for reuse, use AutoText. AutoText 
permanently stores information for future use. 

EXERCISE 5 

Create AutoText 
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1. Type the following:  
AutoText information is stored permanently. 

2. Select "AutoText information is stored permanently." 

3. Choose the Insert tab. 
4. Click Quick Parts in the Text group. A menu appears. 

5. Click Save Selection to Quick Part Gallery. The Create New Building Block dialog box appears. 

 

6. Microsoft Word suggests a name. Change the name by typing AT in the Name field. 
7. Click OK. The dialog box closes. 

8. Click anywhere in the text area to remove the highlighting. 

9. Place the cursor between the period in the sentence you just typed and the paragraph marker (¶). 

10. Press the spacebar to leave a blank space. 

11. Type AT. 
12. Press F3. Your text should now read:  

"AutoText information is stored permanently. AutoText information is stored permanently." 
Note: Whenever you need the text, simply type the name (AT) and then press F3. 

Use Spell Check 
Word checks your spelling and grammar as you type. Spelling errors display with a red wavy line under 
the word. Grammar errors display with a green wavy line under the error. In Word 2007, you can use 
the Review tab's Spelling & Grammar button to initiate a spell and grammar check of your document. 
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EXERCISE 6 

Use Spell Check 

 

1. Type the following exactly as shown. Include all errors.  
Open thr door for Mayrala. She is a teacher from the town of Ridgemont. 

2. Select: "Open thr door for Mayrala. She is a teacher from the town of Ridgemont." 

3. Choose the Review tab. 

4. Click the Spelling & Grammar button. The Spelling and Grammar dialog box appears. 

 

6. "The" is misspelled, so it is highlighted on the screen and noted in the Not in Dictionary box. Word 
suggests correct spellings. These suggestions are found in the Suggestions box. 

7. Click "the" in the Suggestions box. 

8. Click Change.  
Note: If the word is misspelled in several places, click Change All to correct all misspellings. 

9. The name "Mayrala" is not in the dictionary, but it is correct. Click Ignore Once to leave "Mayrala" in the 
document with its current spelling. 
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Note: If a word appears in several places in the document, click Ignore All so you are not prompted to 
correct the spelling for each occurrence. 

10. "Ridgemont" is not found in the dictionary. If you frequently use a word not found in the dictionary, you 
might want to add that word to the dictionary by clicking the Add to Dictionary button. Word will then 
recognize the word the next time it appears. Click Add to Dictionary. 

11. The following should appear on your screen: "Word finished checking the selection. Do you want to 
continue checking the remainder of the document?" 

12. Click No. If you wanted Word to spell-check the entire document, you would have clicked Yes. 

Note: You can also press F7 to initiate a spelling and grammar check. If you don't have anything 
selected, Word checks the entire document. 

Find and Replace 
If you need to find a particular word or phrase in your document, you can use the Find command. This 
command is especially useful when you are working with large files. If you want to search the entire 
document, simply execute the Find command. If you want to limit your search to a selected area, select 
that area and then execute the Find command. 

After you find the word or phrase you are searching for, you can replace it with new text by executing 
the Replace command. 

EXERCISE 7 

Use Find with the Ribbon 

 
1. Type the following:  

Monica is from Easton. She lives on the east side of town. Her daughter attends Eastern High 
School. 

2. Select: "Monica is from Easton. She lives on the east side of town. Her daughter attends Eastern High 
School." 

3. Choose the Home tab. 

4. Click Find in the Editing group. A menu appears. 

5. Click the Find option on the menu. The Find and Replace dialog box appears. 
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6. Type east in the Find What field. 
7. Click Find Next.  

Note that the "East" in Easton is highlighted. 
8. Click Find Next again.  

Note that "east" is highlighted. 
9. Click Find Next again.  

Note that the "East" in Eastern is highlighted. 
10. Click Find Next. The following message should appear: "Word has finished searching the selection. Do 

you want to search the remainder of the document?" 

11. Click No. 

12. Click Cancel. 

Alternate Method—Find with Keys 

1. Select: "Monica is from Easton. She lives on the east side of town. Her daughter attends Eastern High 
School." 

2. Press Ctrl+f. 

3. Follow steps 6 through 12 in the preceding section. 

Use Replace with the Ribbon 
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1. Select "Monica is from Easton. She lives on the east side of town. Her daughter attends Eastern High 
School." 

2. Choose the Home tab. 

3. Click Replace in the Editing group. The Find and Replace dialog box appears. 

 

4. Type east in the Find What box. 
5. Type west in the Replace With box. 
6. Click Find Next. The East in Easton is highlighted. 

7. Click Replace. Word replaces the "East" in "Easton" with "West" and then highlights the word "east." 

8. Click Replace. Word replaces the word "east" with "west" and then highlights the word "Eastern." 

9. Click Close. Do not replace the "East" in "Eastern" with "West." 

10. Your text should now read,  
"Monica is from Weston. She lives on the west side of town. Her daughter attends Eastern High 
School." 

Alternate Method—Replace with Keys 

1. Select "Monica is from Easton. She lives on the west side of town. Her daughter attends Western High 
School." 

2. Press Ctrl+h. 

3. Follow steps 4 through 11 in the preceding section. 

Change the Font Size 
A font is a set of characters (text) represented in a single typeface. Each character within a font is 
created by using the same basic style. In Microsoft Word, you can change the size of your font. The 
following exercise illustrates changing the font size. 

EXERCISE 8 

Change the Font Size 
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1. Type the following:  
I can be any size you want me to be. 

2. Select "I can be any size you want me to be." 
3. Choose the Home tab. 

4. In the Font group, click the down arrow next to the Font Size box. A menu of font sizes appears. 

5. Move your cursor over the menu of font sizes. As you do, Word 2007 provides a live preview of the 
effect of applying each font size. 

6. Click 36 to select it as your font size. 

Note: If you know the font size you want, you can type it in the Font Size field. 

Alternate Method—Change the Font Size with Grow Font and Shrink Font 

You can also change the size of your font by clicking the Grow Font and Shrink Font buttons. Selecting 
text and then clicking the Grow Font button makes your font larger. Selecting text and then clicking the 
Shrink Font button makes your font smaller. 
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1. Type the following: 
Grow Shrink 

2. Select "Grow" 

3. Choose the Home tab. 

4. Click the Grow Font button  several times. Your font becomes larger. 

5. Select Shrink. 

6. Click the Shrink Font button  several times. Your font becomes smaller. 

Change the Font 
In Microsoft Word, you can change the font (the "family" of type you use for your text). This feature is 
illustrated in the following exercise: 

EXERCISE 9 

Change the Font with the Ribbon 
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1. Type the following:  
Changing fonts 

2. Select "Changing fonts." 

3. Choose the Home tab. 

4. Click the down arrow next to the Font field. A menu of fonts appears. 

5. Move the cursor over the list of fonts. Word 2007 provides a live preview of what the font will look like if 
you select it. 

6. Click the font name to select the font you want. 

Alternate Method—Change the Font with the Mini Toolbar 

 

1. Select "Changing fonts." 

2. Right-click. The Mini toolbar and a menu appears. 
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3. Move to the Mini toolbar. 

4. Click the down arrow next to the Font field. A menu of fonts appears. 

5. Click the name of the font you want. 

Save Your File 
This is the end of Lesson 3. You can save your file and close Word. See Lesson 2 to learn how to save 
and close.  
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Lesson 4: Formatting Paragraphs and Working with Styles 

 

When you type information into Microsoft Word, each time you press the Enter key Word creates a new 
paragraph. You can format paragraphs. For example, you can indent the first line of a paragraph, you 
can set the amount of space that separates paragraphs, and you can align a paragraph left, right, 
center, or flush with both margins. Styles are a set of formats you can quickly apply to a paragraph. For 
example, by applying a style, you can set the font, set the font size, and align a paragraph all at once. 
In this lesson, you will learn about the various formats you can apply to a paragraph and about styles. 

 Open a Blank Document 
 Add Sample Text 
 Add Space Before or After Paragraphs 
 Change Line Spacing 
 Create a First-Line Indent 
 Indent Paragraphs 
 Align Paragraphs 
 Create a Hanging Indent 
 Choose a Style Set 
 Apply a Style 
 Change Style Sets 

 

When you type information into Microsoft Word, each time you press the Enter key Word creates a new 
paragraph. You can format paragraphs. For example, you can indent the first line of a paragraph, you 
can set the amount of space that separates paragraphs, and you can align a paragraph left, right, 
center, or flush with both margins. Styles are a set of formats you can quickly apply to a paragraph. For 
example, by applying a style, you can set the font, set the font size, and align a paragraph all at once. 
In this lesson, you will learn about the various formats you can apply to a paragraph and about styles. 

When you are formatting a paragraph, you do not need to select the entire paragraph. Placing the 
cursor anywhere in the paragraph enables you to format it. After you format a paragraph, pressing the 
Enter key creates a new paragraph in the same format. 

Open a Blank Document 
To begin a new Word project, you start by opening a new document.To begin this lesson, open a blank 
document in Microsoft Word. 

EXERCISE 1 

Open a Blank Document 

http://www.baycongroup.com/word2007/04_word2007.html
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1. Open Word 2007. 

2. Click the Microsoft Office button. A menu appears. 

3. Click New. The New Document dialog box appears. 

 

4. Click Blank Document. 

5. Click Create. A new blank document opens. 

Add Sample Text 
This lesson uses sample text provided by Microsoft for training and demonstration purposes. You can 
type the text; however, there is a quicker way. You can use the rand function. 

Functions are used to obtain information. You tell the function what you want and the function returns 
that information to you. By default, in Word, when you type the rand function, Word returns three 
paragraphs. When working with functions, you use arguments to be specific about what you want the 
function to return. There are two arguments you can use with the rand function. The first one tells Word 
how many paragraphs you want, and the second one tells Word how many sentences you want in a 
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paragraph. You place arguments between the parentheses and you separate them with a comma. For 
example, if you type =rand() and then press Enter, word returns three paragraphs. To tell Word you 
want two paragraphs with three sentences in each paragraph, you type =rand(2,3). 

EXERCISE 2 

Add Sample Text 

1. Type =rand(). 

2. Press the Enter key. The following text appears: 

On the Insert tab, the galleries include items that are designed to coordinate with 
the overall look of your document. You can use these galleries to insert tables, 
headers, footers, lists, cover pages, and other document building blocks. When 
you create pictures, charts, or diagrams, they also coordinate with your current 
document look. ¶ 

You can easily change the formatting of selected text in the document text by 
choosing a look for the selected text from the Quick Styles gallery on the Home 
tab. You can also format text directly by using the other controls on the Home 
tab. Most controls offer a choice of using the look from the current theme or using 
a format that you specify directly. ¶ 

To change the overall look of your document, choose new Theme elements on 
the Page Layout tab. To change the looks available in the Quick Style gallery, 
use the Change Current Quick Style Set command. Both the Themes gallery and 
the Quick Styles gallery provide reset commands so that you can always restore 
the look of your document to the original contained in your current template. ¶ 

Add Space Before or After Paragraphs 
When creating a document, space is often used to clearly identify where each paragraph begins and 
ends. By default, Word may place slightly more space between paragraphs than it does between lines 
in a paragraph. You can increase or decrease the amount of space that appears before and after 
paragraphs by entering amounts in the Before and After fields in the Paragraph section of the Page 
Layout tab. Use the up arrows next to the Before and After fields to increase the amount of space 
before or after each paragraph; use the down arrows to decrease the amount of space before or after 
each paragraph. The following illustrates: 

EXERCISE 3 

Add Space Before or After Paragraphs 
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1. Place your cursor anywhere in the second paragraph of the sample text you created in Exercise 2. 

2. Choose the Page Layout tab. The default spacing appears in the Spacing Before field. 

3. Click the up arrow next to the Spacing Before field to increase the space before the paragraph. 

4. Click the up arrow next to the Spacing After field to increase the amount of space after the paragraph. 

Note: You can click the down arrows next to the Spacing Before and the Spacing After fields to 
decrease the amount of space before or after a paragraph. You can also type the amount of space you 
want to use directly into the fields. Space is measured in points. There are 72 points to an inch. 

Change Line Spacing 
Line spacing sets the amount of space between lines within a paragraph. The spacing for each line is 
set to accommodate the largest font on that line. If the lines include smaller fonts, there will appear to 
be extra space between lines where the smaller fonts are located. At 1.5, the line spacing is set to one-
and-a-half times the single-space amount. At 2.0, the line spacing is set to two times the single-space 
amount (double space). 

EXERCISE 4 

Change Line Spacing 
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1. Place your cursor anywhere in the first paragraph of the sample text you created in Exercise 2. 

2. Choose the Home tab. 

3. Click the Line Spacing button  in the Paragraph group. A menu of options appears. 

4. Click 2.0 to double-space the first paragraph. 

Create a First-Line Indent 
Some people and organizations delineate the start of a new paragraph by indenting the first line. If you 
want to indent the first line of your paragraphs, you can use the Paragraph dialog box to set the amount 
by which you want to indent. In the Special Field of the Paragraph dialog box, you tell Word you want to 
indent the first line by choosing First Line from the menu options. In the By field, you tell Word the 
amount, in inches by which you want to indent. 

EXAMPLE: First-line Indent 
             On the Insert tab, the galleries include items that are designed to 
coordinate with the overall look of your document. You can use these galleries to 
insert tables, headers, footers, lists, cover pages, and other document building 
blocks. When you create pictures, charts, or diagrams, they also coordinate with 
your current document look. 

EXERCISE 5 

Create a First-line Indent 
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1. Place your cursor anywhere within the first paragraph of the sample text you created in Exercise 2. 

2. Choose the Home tab. 

3. In the Paragraphs group, click the launcher. The Paragraph dialog box appears. 

 

4. Choose the Indents and Spacing tab. 

5. Click to open the drop-down menu on the Special field. 

6. Click First Line. 

7. Enter 0.5" in the By field. 

8. Click OK. The first line of your paragraph is now indented half an inch. 

Special Note: To remove the first line indent: 
1. Place the cursor anywhere in the paragraph. 
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2. Choose the Home tab. 

3. In the Paragraphs group, click the launcher. The Paragraph dialog box opens. 

4. Choose the Indents and Spacing tab. 

5. Click the down arrow next to the Special field and then click None. 

6. Click OK. 

Indent Paragraphs 
Indentation allows you to indent your paragraph from the left and/or right margin. You may find this 
necessary when you are quoting a large block of text. The following exercise shows you how to indent 
a paragraph 1 inch from each side. 

EXAMPLE: Indentation 
On the Insert tab, the galleries include items that are designed to coordinate with 
the overall look of your document. You can use these galleries to insert tables, 
headers, footers, lists, cover pages, and other document building blocks. When 
you create pictures, charts, or diagrams, they also coordinate with your current 
document look. 

You can easily change the formatting of selected text in the document 
text by choosing a look for the selected text from the Quick Styles 
gallery on the Home tab. You can also format text directly by using 
the other controls on the Home tab. Most controls offer a choice of 
using the look from the current theme or using a format that you 
specify directly. 

 

EXERCISE 6 

Indent Paragraphs 
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1. Place your cursor anywhere in the second paragraph of the sample text you created in Exercise 2. 

2. Choose the Page Layout tab. 

3. Type 1" in the Indent Left field or use the up or down arrows to set the field value to 1". 
4. Type 1" in the Indent Right field or use the up or down arrows to set the field value to 1". Your 

paragraph is now indented one inch from both the left and right margins, as in the example. 

Align Paragraphs 
Microsoft Word gives you a choice of several types of alignments. Left-aligned text is flush with the left 
margin of your document and is the default setting. Right-aligned text is flush with the right margin of 
your document, centered text is centered between the left and right margins, and Justified text is flush 
with both the left and right margins. 

EXAMPLE: Left-Aligned 
Sample Paragraph 

On the Insert tab, the galleries include items that are designed to coordinate with 
the overall look of your document. You can use these galleries to insert tables, 
headers, footers, lists, cover pages, and other document building blocks. When 
you create pictures, charts, or diagrams, they also coordinate with your current 
document look. 

EXAMPLE: Right-aligned 
Sample Paragraph 

On the Insert tab, the galleries include items that are designed to coordinate with 
the overall look of your document. You can use these galleries to insert tables, 

headers, footers, lists, cover pages, and other document building blocks. When 
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you create pictures, charts, or diagrams, they also coordinate with your current 
document look. 

EXAMPLE: Centered 
Sample Paragraph 

On the Insert tab, the galleries include items that are designed to coordinate with 
the overall look of your document. You can use these galleries to insert tables, 
headers, footers, lists, cover pages, and other document building blocks. When 
you create pictures, charts, or diagrams, they also coordinate with your current 

document look. 

EXAMPLE: Justified 
Sample Paragraph 

On the Insert tab, the galleries include items that are designed to coordinate with 
the overall look of your document. You can use these galleries to insert tables, 
headers, footers, lists, cover pages, and other document building blocks. When 
you create pictures, charts, or diagrams, they also coordinate with your current 
document look. 

The following exercises demonstrate how to justify text. 

EXERCISE 7 

Create the Paragraphs 

1. Type Sample Paragraph. 
2. Press Enter. 
3. Type =rand(1) to create a paragraph. 
4. Press Enter. 

Right-align 

 

1. Select the paragraphs you created. 



assistant teacher: Wasan A. Alawsi                    Microsoft Word 2007 

52  

2. Choose the Home tab. 

3. Click the Align-right button  in the Paragraph group. Word right-aligns your paragraphs. 

Left-align 

1. Select the paragraphs you created. 

2. Choose the Home tab. 

3. Click the Align-left button  in the Paragraph group. Word left-aligns your paragraph. 

Center 

1. Selected the paragraphs you created. 

2. Choose the Home tab. 

3. Click the Center button  in the Paragraph group. Word centers your paragraph. 

Justify 

1. Select the paragraphs you created. 

2. Choose the Home tab. 

3. Click the Justify button  in the Paragraph group. Word justifies your paragraph. 

Alternate Method—Right-Justify with Keys 

1. Select the paragraphs you created. 

2. Press Ctrl+r. The paragraph is now right-aligned. 

Alternate Method—Left-Justify with Keys 

1. Select the paragraphs you created. 

2. Press Ctrl+l. The paragraph is now left-aligned. 

Alternate Method—Center with Keys 

1. Select the paragraphs you created. 

2. Press Ctrl+e. The paragraph is now centered. 

Alternate Method—Justify with Keys 

1. Select the paragraphs you created. 

2. Press Ctrl+j. The paragraph is now justified. 

Create a Hanging Indent 
The hanging indent feature indents each line except the first line by the amount specified in the By field, 
as shown in the example. 

EXAMPLE: Hanging Indent 
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Hanging Indent: The hanging indent feature indents the 
first line of the paragraph from the margin 
by the amount specified in the Left field. 
The amount in the Left field plus the 
amount specified in the By field indent all 
subsequent lines. 

 

EXERCISE 8 

Create a Hanging Indent 

 

1. Type the following:  
Hanging Indent: The hanging indent feature indents the first line by the amount specified in the Left 
field. Subsequent lines are indented by the amount specified in the Left field plus the amount specified 
in the By field. 

2. Select the paragraph you just typed. 

3. Choose the Home tab. 

4. Click the launcher in the Paragraph group. The Paragraph dialog box appears. 
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5. Choose the Indents and Spacing tab. 

6. In the Special field, click to open the pull-down menu. 

7. Click Hanging. 

8. In the By box, type 2". 
9. Click OK. 

10. Place the cursor after the colon following "Hanging Indent." 

11. Press the Tab key. Notice that the indentation changes. 

Choose a Style Set 
When working with Word, you can use styles to quickly format your documents. A style is a set of 
formats consisting of such things as fonts, font colors, font sizes, and paragraph formats. Word 2007 
supplies you with predesigned style sets that contain styles for titles, subtitles, quotes, headings, lists 
and more. The sections that follow all show you how to work with styles. The exercises are based on a 
file you must download. Right click here to download the file. Click Save Target As from the menu that 
appears, and save the linked file to a directory on your computer. 
The file will download as a zip file. A zip file is a file that is compressed. Compressed files are smaller 
and easier to download. To open the file: 

1. Open the folder you downloaded the file to. 

2. Right-click on the file name. 

3. Click Extract All on the menu that appears. The Extract Compressed (Zipped) Folders dialog box 
appears. 

4. Enter the folder you want to put the file in or except to suggested location. 

http://www.baycongroup.com/word2007/CreatingStyles.zip
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5. Click Extract. Windows Explorer extracts the file. 

6. You can use Microsoft Word to open the file. 

EXERCISE 9 

Choose a Style Set 

 

1. Choose the Home tab. 

2. Click Change Styles in the Styles group. A menu appears. 

3. Click Style Set. A menu appears. You can choose from any of the styles listed on the menu. 

4. Click Simple. Word 2007 reformats all of the paragraphs into the Simple style by applying the Normal 
format to each paragraph. 

Apply a Style 
You can see of all the styles available to you in the style set by clicking the launcher in the Styles group 
and opening the Styles pane. You can leave the Styles pane open and available for use by docking it. 
To dock the Styles pane, click the top of the pane and drag it to the left or right edge of the Word 
window. 

You do not need to select an entire paragraph to apply a style. If the cursor is anywhere in the 
paragraph, when you click on the style, Word formats the entire paragraph. 

EXERCISE 10 

Apply the Title Style 
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1. Choose the Home tab. 

2. Click the launcher in the Styles Group. The Styles pane appears. You can drag it to the side of the 
Word window to dock it. To close the Styles pane, click the Close button  in the upper right corner of 
the pane . 

3. Click anywhere in the paragraph "Single-Parent Family—Career Help." 

4. Click Title in the Styles pane. Word 2007 applies the Title style to the paragraph. 

Headings and subheadings mark major topics within your document. With Word 2007, you can easily 
format the headings and subheadings in your document. 

Apply Headings 

1. Click anywhere in the paragraph "The Nature of Single Parenthood." 

2. In the Style box, click Heading 1. Word reformats the paragraph. 

3. Repeat steps 1 and 2 in the following paragraphs: 

 Types of Single Parents 

 Career Development Needs of Single Parents 

 Career Development Programs 

Apply Subheadings 

1. Click anywhere in the paragraph "Displaced Homemakers" 

2. In the Style box, click Heading 2. Word reformats the paragraph. 

3. Repeat steps 1 and 2 for the following paragraphs: 
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 Displaced Homemakers 

 Adolescent Mothers 

 Single Fathers 

 High School Dropout Prevention 

 Established Education Sites 

Alternate Method -- Apply Styles with the Ribbon 

You can also choose styles by selecting the option you want from the Styles group on the Ribbon. First 
you must place your cursor in the paragraph to which you want to apply the style. Then you click the 
More button in the Styles group to see all of the styles in the currently selected set. As you roll your 
cursor over each of the styles listed, Word 2007 provides you with a live preview of how the style will 
appear when applied. 

1. Select the paragraphs "Emotional Support" through "Parenthood Education" (they are probably on page 
two). 

2. Click the More button in the Styles group. 
3. Locate and click the List Paragraph style. Word applies the List Paragraph style to the paragraphs you 

selected. 

Change Style Sets 
Once you have applied styles, changing to another style set is easy. You simply open the Style Set 
gallery. As you move your cursor down the menu, Word 2007 provides you with a live preview of the 
effect of applying the style set. To choose a style set, you click it. 

EXERCISE 11 

Change Style Sets 

1. Click Change Styles in the Styles group. A menu appears. 

2. Click Style Set. A menu appears. As you move your cursor down the menu Word 2007 provides you 
with a live preview of the effect of applying the Style set to your document. 

3. Click Formal. Word 2007 reformats all of the paragraphs into the Formal style applying the appropriate 
format to each paragraph. 

This is the end of Lesson 3. You can save you file and close Word. See Lesson 2 to learn how to save 
and close.  
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Lesson 5: Adding Bullets and Numbers, Undoing and Redoing, 
Setting Page Layouts and Printing Documents 

If you have lists of data, you may want to bullet or number them. When using Microsoft Word, bulleting 
and numbering are easy. The first part of this lesson teaches you to bullet and number. After you have 
completed your document, you may want to share it with others. One way to share your document is to 
print and distribute it. However, before you print you may want to add page numbers and tell Word such 
things as the page orientation, the paper size, and the margin setting you want to use. In this lesson 
you will learn how to layout and how to print your documents. 

 Add Bullets and Numbers 

 Undo and Redo 
 Set the Orientation 
 Set the Page Size 
 Set the Margins 
 Add Page Numbers 
 Insert Page Breaks 
 Preview and Print Documents 

 

If you have lists of data, you may want to bullet or number them. When using Microsoft Word, bulleting 
and numbering are easy. The first part of this lesson teaches you to bullet and number. 

After you have completed your document, you may want to share it with others. One way to share your 
document is to print and distribute it. However, before you print you may want to add page numbers 
and tell Word such things as the page orientation, the paper size, and the margin setting you want to 
use. In this lesson you will learn how to layout and how to print your documents. 

Add Bullets and Numbers 
In Microsoft Word, you can easily create bulleted or numbered lists of items. Several bulleting and 
numbering styles are available, as shown in the examples. You can select the one you wish to use. 

EXAMPLES: Numbering 

 

EXAMPLES: Bulleting 

http://www.baycongroup.com/word2007/05_word2007.html
http://www.baycongroup.com/word2007/05_word2007.html
http://www.baycongroup.com/word2007/05_word2007.html
http://www.baycongroup.com/word2007/05_word2007.html
http://www.baycongroup.com/word2007/05_word2007.html
http://www.baycongroup.com/word2007/05_word2007.html
http://www.baycongroup.com/word2007/05_word2007.html
http://www.baycongroup.com/word2007/05_word2007.html
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EXERCISE 1 

Bullets 

 

1. Type the following list as shown: 
Apple  
Orange  
Grape  
Mango  
Cherry 

2. Select the words you just typed. 

3. Choose the Home tab. 

4. In the Paragraph group, click the down arrow next to the Bullets button . The Bullet Library appears. 

5. Click to select the type of bullet you want to use. Word adds bullets to your list. 
Note: As you move your cursor over the various bullet styles, Word displays the bullet style onscreen. 
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To remove the bulleting: 

1. Select the list again. 

2. Choose the Home tab. 

3. In the Paragraph group, click the down arrow next to the Bullets icon. The Bullet dialog box appears. 

4. Click None. Word removes the bullets from your list. 

Numbers 

 

1. Type the following list as shown: 
Apple  
Orange  
Grape  
Mango  
Cherry 

2. Select the words you just typed. 

3. Choose the Home tab. 

4. In the Paragraph group, click the down arrow next to the Numbering button . The Numbering 
Library appears. 

5. Click to select the type of numbering you want to use. Word numbers your list. 
Note: As you move your cursor over the various number styles, Word displays the number style 
onscreen. 
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To remove the numbering: 

1. Select the list again. 

2. Choose the Home tab. 

3. In the Paragraph group, click the down arrow next yo the Numbering icon. The Number dialog box 
appears. 

4. Click None. Word removes the numbering from your list. 

Undo and Redo 
You can quickly reverse most commands you execute by using Undo. If you then change your mind 
again, and want to reapply a command, you can use Redo. 

EXERCISE 2 

Undo and Redo 

 

1. Type Undo example. 
2. Click the Undo button on the Quick Access menu. The typing disappears. 

3. Click the Redo button on the Quick Access menu. The typing reappears. 

4. Select "Undo example." 

5. Press Ctrl+b to bold. Word bolds the text. 

6. Press Ctrl+i. Word italicizes the text. 

7. Press Ctrl+u Word underlines the text. 

8. Click the down arrow next to the Undo icon. You will see the actions you performed listed. To undo the 
underline, click Underline; to undo the underline and italic, click Underline Italic; to undo the underline, 
italic, and bold click Bold etc. 

9. To redo, click the Redo icon several times. 

Alternate Method -- Undo & Redo by Using Keys 

1. Type Undo example. 
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2. Press Ctrl+z. The typing disappears. 

3. Press Ctrl+y. The typing reappears. 

4. Select "Undo example." 

5. Press Ctrl+u to underline. 

6. Press Ctrl+z. The underline is removed. 

7. Press Ctrl+y. The underline reappears. 

Set the Orientation 
Before you print your document, you may want to change the orientation of your pages. There are two 
orientations you can use: portrait and landscape. Paper, such as paper sized 8 1/2 by 11, is longer on 
one edge than it is on the other. If you print in Portrait, the shortest edge of the paper becomes the top 
of the page. Portrait is the default option. If you print Landscape, the longest edge of the paper 
becomes the top of the page. 

Portrait 

  

Landscape 

The exercises that follow use a file named SamplePrint.docx. Right click here to download the file. Click 
Save Target As from the menu that appears, and save the linked file to a directory on your computer. 
The file will download as a zip file. A zip file is a file that is compressed. Compressed files are smaller 
and easier to download. To open the file: 

1. Open the folder you downloaded the file to. 

2. Right-click on the file name. 

3. Click Extract All on the menu that appears. The Extract Compressed (Zipped) Folders dialog box 
appears. 

4. Enter the folder you want to put the file in or except to suggested location. 

5. Click Extract. Windows Explorer extracts the file. 

6. You can use Microsoft Word to open the file. 

EXERCISE 3 

Set the Orientation 

http://www.baycongroup.com/word2007/SamplePrint.zip
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1. Choose the Page Layout tab. 

2. Click Orientation in the Page Setup group. A menu appears. 

3. Click Portrait. Word sets your page orientation to Portrait. 

Set the Page Size 
Paper comes in a variety of sizes. Most business correspondence uses 8 1/2 by 11 paper which is the 
default page size in Word. If you are not using 8 1/2 by 11 paper, you can use the Size option in the 
Page Setup group of the Page Layout tab to change the Size setting. 

EXERCISE 4 

Set the Page Size 

1. Choose the Page Layout tab. 

2. Click Size in the Page Setup group. A menu appears. 

3. Click Letter 8.5 x 11in. Word sets your page size. 

Set the Margins 
Margins define the amount of white space that appears at the top, bottom, left, and right edges of your 
document. The Margin option in the Page Setup group of the Page Layout tab provides several 
standard margin sizes from which you can choose. 
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EXERCISE 5 

Set the Margins 

 

1. Choose the Page Layout tab. 

2. Click Margins in the Page Setup group. A menu appears. 

3. Click Moderate. Word sets your margins to the Moderate settings. 

Add Page Numbers 
Page numbers help you keep your document organized and enable readers to find information quickly. 
You can add page numbers to the top, bottom, or margins of your pages, and you can choose where 
the numbers appear. For example, numbers can appear at the top of the page, on the left, right, or 
center of the page. Word also offers several number styles from which you can choose. 
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EXERCISE 6 

Add Page Numbers 

 

1. Choose the Insert tab. 

2. Click the Page Number button in the Header & Footer group. A menu appears. 

3. Click Bottom of Page. 

4. Click the right-side option. 

Insert Page Breaks 
As you learned in Lesson 1, you can display your document in any of five views: Draft, Web Layout, 
Print Layout, Full Screen Reading, or Online Layout. In Print Layout view you see your document as it 
will appear when you print it. You can clearly see where each page ends and a new page begins. 

As you review your document, you may find that you want to change the point at which a new page 
begins. You do this by inserting a page break. For example, if a page heading appears on one page 
and the first paragraph under the heading appears on the next page, you may want to inser a page 
break before the heading to keep the heading and the first paragraph together. 
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EXERCISE 7 

Change to Print View 

 

1. Choose the View tab. 

2. Click Print Layout in the Document Views group. Your document changes to the Print Layout view. 

Insert Page Breaks 

 

 

1. Place your cursor before the D in "Displaced Homemakers" 

2. Choose the Insert tab. 

3. Click Page Break. Word places a page break in your document. 

To delete a page break, you select the page break and then press the Delete key. 
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Preview and Print Documents 
When you have your margins, tabs, and so on the way you want them, you are ready to print. In Word, 
You can preview your document before you print. In the Preview mode, you can review each page, 
view multiple pages at the same time, zoom in on a page, and access the Size, Orientation, and Margin 
options. 

If you press the Zoom button while you are in Preview mode, the Zoom dialog box appears. In the 
Zoom dialog box you can set the sizes of the pages that display as well as the number of pages that 
display. 

When you are ready to print, you use the Print dialog box. In the Print Range area, choose All to print 
every page of your document, choose Current Page to print the page you are currently on, or choose 
Pages to enter the specific pages you want to print. Type the pages you want to print in the Pages field. 
Separate individual pages with commas (1,3, 13); specify a range by using a dash (4-9). 

EXERCISE 8 

Print Preview 

1. Click the Microsoft Office button. A menu appears. 

2. Highlight the Print option. The Preview and Print the Document menu appears. 

3. Click Print Preview. The Preview window appears, with your document in the window. 

4. Click One Page to view one page at a time. Click Two Pages to view two pages at a time. 

5. To view your document in normal size, click 100%. 

6. Click the Zoom Button. The Zoom dialog box appears. 

7. Select an option and then click OK. Perform this task for each option and note the results. 

Note: As you review your document, if you see changes you would like to make to the layout, use the 
Margin, Orientation, or Page Size options to make the changes. If you want to make other types of 
changes to your document, click the Close Print Preview button, to return to your document. Once you 
are satisfied with your document, you are ready to print. 

Print 

1. Click the Print button. The Print dialog box appears. 

2. Click the down arrow next to the Name field and select the printer to which you want to print. 

3. Choose All as the page range. 

4. Click OK. Word prints your document. 

You have completed Lesson 5. You can save your document and close Word. 
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Lesson 6: Creating section/chapter headers and footers 
in MS Word 

 
 

 
1.1 

 

To help view how your 

document will be divided, 

turn on the “hide/show 

paragraph ” tool (located 

within the “Home” tab. 

 

This tool shows paragraph 

marks and other hidden 

formatting symbols. 

 

 

1.2 

 

If the “hide/show 

paragraph ” tool is turned 

on, the formatting style of the 

document will be visible. 

 

  

1.3 

 

Common formatting styles 

that may now be visible in the 

document. 

 
= return 

= space 

= tab 
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1.4 

 

In this example, 

http://www.coe.uh.edu/cite/ 

training/tutorials/office/ chapters-

example.doc, the document has three 

chapters with subpages in each chapter. 

http://www.coe.uh.edu/cite/
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Differences between “Page Break” and 
“Section Break (Next Page)” 

2.1 
 

A “Page Break” marks the 

point at which one page ends 

and the next page begins 

(while still being in the same 

section/chapter). 
 

To insert a “Page Break”, 

click on the “Page Layout” 
tab  “Breaks”  “Page” 

 

The paragraph format icon 

will look like: 

 

 

 

 

2.2 
 

A “Section Break (Next 

Page)” inserts a break and 

starts the new section on the 

next page. 
 

To insert a “Section Break 

(Next Page)”, place your 

curser in the area to begin 

and new section/chapter, 

click on “Page Layout”  

“Breaks”  “Next Page” 
 

The paragraph format icon 

will look like: 

 

 

 

 

2.3 
 

Place “Page Breaks” and “Section Breaks (Next Page)” in the proper areas of your document 

(refer to graphic 1.4 as an example). 
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Creating section/chapter headers 

3.1 
 

At the beginning of a “section 

break” double-click on the 

header. This will open the 

“Design” tab. 

 

The “Link to Previous” 
 

button will be 

orange and already selected. 

Click on it to deselect/turn it 

off . The button 

will no longer be orange. 

3.2 

After the “Link to Previous” 

option has been deselected/ 

turned off, this will make sure 

the header is not linked to the 

previous section/chapter. 

 

Now make your text changes 

to the header (to reflect the 

new section/chapter). 

 

 

 

 

 

3.3 

 

Repeat steps (3.1 to 3.2) to create different headers for the beginning of each 

section/chapter. Once the header has been changed, the new header will automatically 

continue until the next section/chapter. 
 

3.4 
 

To exit the header, click on 

the “Close Header and 

Footer” button (located 

within the “Design” tab). 
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  section/chapter Page number reset for each  

4.1 

 

At the beginning of a “section 

break” double-click on the 

footer. This will open the 

“Design” tab. 

 

The “Link to Previous” 
 

button will be 

orange and already selected. 

Click on it to deselect/turn it 

off . The button 
will no longer be orange. 

   

 

4.2 

 

After the “Link to Previous” 

option has been deselected/ 

turned off, this will make sure 

the footer is not linked to the 

previous section/chapter. 

 

To reset the page numbering 

for the section/chapter, click 

the “Design” tab, click on 
“Page Number”  “Format 

Page Numbers…” 

 

  

4.3 

 

A “Page Number Format” 

window will appear. 

 

Click on the “Start at” radial 

button and set it to “1”. 

 

Then click on “OK”. 
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4.4 

 

The footer has now been 

reset to reflect the start of 

the new section/chapter. 

 

 

 

 

4.5 

 

Repeat steps (4.1 to 4.4) to create different headers for the beginning of each 

section/chapter. Once the footer has been changed, the numbering system will automatically 

continue until the next section/chapter. 

4.6 

 

To exit the footer, click on the 

“Close Header and Footer” 

button (located within the 

“Design” tab). 

 

  

   

Congratulations! 
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Lesson 7: Creating tables of contents 

and figures in Word 2007 

 

 

This Lesson demonstrates how to create a table of contents or figures quickly and easily. 

 

Table of contents 

The contents page should be the last part of the document that you produce. 

Word® can generate the table of contents automatically from the titles and 

paragraph headings within the document. To allow the appropriate titles to be 

identified, you must apply the “Heading” style or mark the titles. Word® also 

allows you to create a contents table manually. 

 

Applying the Heading style 

The Styles group can be found from the Home tab. You should use Heading 1 for main 

titles and chapter headings, Heading 2 for sub-headings and Heading 3 for paragraph 

headings. 
 

 Highlight the text which requires a Heading style 

 Click once on the style 

Generating a table of contents 

 Click where you wish to insert the table of contents 

 Click the References tab 

 Click the Table of Contents button 

 Select a style for the table 
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Update the table of contents 

If you change any of the headings in your document, you will need to update the table 

of contents. 

 Click the References tab 

 Click the Update Table button 

 In the box that appears, select Update entire 

table 

 Click Ok. 

 

Creating a table of contents manually 

 Click where you wish to insert the contents table 

 Click the References tab 

 Click the Table of Contents button 

 Select Manual Table 
 

 
An outline contents table will be inserted. You can click on each title and page 

number to enter your own information. 

 

Deleting a table of contents 

 Click the References tab 

 Click the Table of Contents button 

 Click Remove Table of Contents 
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Table of figures 

A table of figures is a contents page which references graphs, pictures and tables. Before 

you can create a table of figures, you need to create captions for each figure. Word® uses 

the captions to generate the table. 

Applying a caption 

 Click once anywhere on the figure to select it 

 Click the References tab 

 Click the Insert Caption button 

 Customise the caption and click OK 
 

 

 

 
Click here to enter your own title, 

e.g. Table 1: Chemical Symbols 

 

 

 

 

 
 

Choose a label 

that is suitable for 

the figure or click 

New Label to 

create your own 

label 

 
Choose where you 

want the caption 

to be inserted – 

above or below the 

figure 

 

 

 

 

 
 

Click here to 

create your 

own labels 
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Lesson 8: Working with Tables in Micro-

soft Word 2007 

 

The purpose of this document is to lead you through the steps of creating, editing 

and deleting tables and parts of tables. This document follows a tutorial format so 

that by the end of the document, you will have created and worked with tables in 

Microsoft Word. This document was written using the procedures for creating 

tables in Microsoft Office Word 2003, but the steps may also apply to older versions. 

 

The Parts of a Table 
It will be easier to create your tables if you are familiar with the parts of a table. 

The following table shows a sample table with its major parts listed. You can build 

a similar table to acquaint yourself with the steps for inserting tables into your 

documents. 

 

 Sample Table Click Insert Table of Figures  

 Customise the table and click OK.  

 

 

olumns 

Rows 

  

 
• 

• 
Columns the vertical sections of 

the table 

• 
Rows the horizontal sections of 
the table 

Cells 

 Column 1 Column 2 Column 3 
Row 1 Cell 1 Cell 2 Cell 3 
Row 2 Cell 4 Cell 5 Cell 6 
Row 3 Cell 7 Cell 8 Cell 9 
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Cells the individual squares in which you will place text or images 

 

Creating the Table 
You will need to insert the main part of the table to begin editing and manipulating 

it to suit your document's needs. To do this, perform the following steps. 

 

To insert a table: 

1. Place your cursor in the general area where you want the table to be; you can be 
more specific with its location once you have inserted it. 

2. In the Word menu bar, click Table > Insert > Table. 
 

Figure 1: Table option in the Windows menu bar 

 

3. A dialog box will display with the options for setting up your table. The 

following figure and paragraphs explain these options. 
 

Figure 2: Insert Table dialog box 

 

4. In the Table size section of the Insert Table dialog box, select the number of 
columns and rows you want in your table. If you need to, just estimate. You can 
always add and delete columns and rows later. 

5. In the AutoFit behavior section, select the option for how you want the 
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table sized within your d

•

ocument. 

  
Fixed column width makes all the cells of equal width. You can select a width with the up and 

down arrows, type in a width or use the default Auto setting. The cells may 
resize as you begin 

• 
adding content. 
AutoFit to contents automatically sizes the width of each cell as you add contents to the cell, 

• 
whether it is text or an image. 
AutoFit to window makes all the cells of equal width across the length of the 
document, but the 
cells will remain at this width, even as you begin adding content to the cell. 

 

Note: If you want to use these same dimensions for any future tables, check the Remember dimensions 

for new tables check box. 

6. Click OK. 

Using the settings of 3 columns and 4 rows with the Fixed column width option 

selected, your new table will display as shown below. We will call this our 

framework table. 

 

Framework Table 
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Editing the Table 

Now that you have inserted the table, it is time to edit, or customize, it. Microsoft 

Word offers many options for customizing tables but most are beyond the scope of 

this paper. The following instructions are for very basic editing, such as adding and 

deleting rows and columns, resizing table and cell size, aligning the table on the 

page and working with text within each cell. 

 
Remember our sample table at the beginning of this paper: 

 
 Column 1 Column 2 Column 3 
Row 1 Cell 1 Cell 2 Cell 3 
Row 2 Cell 4 Cell 5 Cell 6 
Row 3 Cell 7 Cell 8 Cell 9 

 
The following sections will help us take our framework table that we just inserted 

in the above steps and make it look like the sample table. 

 

To add columns or rows: 

To match our sample table, the framework table needs another column. 

1. Place your cursor in the first cell in the framework table. 

2. In the Windows menu bar, click Table > Insert > Columns to the Left. The 

table will now display as shown below. 
 
    

    

    

    

    

 

To align the table on the page: 

1. Right click anywhere inside the table to display the menu (you can also click 
Table on the menu bar once you have the cursor anywhere in the table). On 

this menu, select Table Properties to bring up the Table Properties dialog box. 
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Table 

Tab 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Figure 3: Table Properties dialog box 

 

2. Be sure the Table tab is selected. 

3. In the Alignment section, click Left if you want the table aligned with the left 
margin of the paper, Center if you want the table centered, and select Right if 

you want the table aligned with the right side of the paper. For our sample table, 
we want to select the Center option. 

4. Click OK to save your settings, or click Cancel to exit 

without saving. Our framework table will now be 

centered. 

 

    

    

    

    

    

 

To change the size of the cells: 

1. Highlight the cells that you want to change. 

2. Right click and select Table Properties from the menu to display the Table 

Properties dialog box. 

3. Select the Cell tab. 
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4. In the Preferred width area, use the arrow keys or type in a width for the 
cells to shorten or widen them. 

5. Click OK to apply the changes or click Cancel to exit without applying the changes. 

For our framework table we want each cell to be 1.33 inches in width, so type in 

1.33 in the Preferred width field. 

 

Changing the Color of a Cell, Row or Column 

A good way to help draw attention to an important cell, row or column (such as for 

headings for columns or rows) is to change its color to provide contrast and draw 

the eye of the reader. It might also help your reader follow the information in a row 

or column of a lengthy table if you alternate colors between rows or columns. For 

example, if you have a table that has 100 rows and 15 columns, with each cell 

containing numbers, if might be easier for the reader to scan a row if each row 

alternates between white and light gray, such as in the sample table. 

 

To change the color of a cell, row or column: 

1. Click and drag to highlight the row or column of which you want to change the 
color. To change the color of a single cell, just place the cursor in that cell. 

2. Right click to bring up the menu, or click Table in the menu bar. From the right 

click menu, select Borders and Shading. From the Table menu, select Table 

Properties, click the Table menu, then click the Borders and Shading button 
to display the following screen. 
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Shading 

Tab 

 

 

 

 

 

 

 

 

 

 

 

Figure 4: Borders and Shading dialog box - Shading tab selected 

 

3. In the Fill section, select a color for the cell, row or column. 

4. In the Apply to: section, be sure Cell is selected or the color will be applied to the 

entire table. 

5. Click OK to apply the changes, or click Cancel to exit without applying the changes. 

To get the look of our sample table, on the framework table, highlight the last 

three cells of the top row. Right click, select Borders and Shading, click the box 

with the color Gray – 55%. Click OK. Then highlight the last three cells of the 

first column in the framework table. Right click, select Borders and Shading, click 

the box with the color Gray – 55%. Click OK. Finally, highlight the last three cells 

of the third row. Right click, select Borders and Shading, click the box with the 

color Gray – 12.5%. Click OK. The framework table should now look like the 

following: 
 

    

    

    

    

    

 

To change the borders of a cell, row or column: 

1. To change the borders of a row or column, click and drag to highlight the row or 
column. To change the borders of a single cell, just place the cursor inside that 

cell. 

2. Right click and select Borders and Shading from the menu. You can also select 

Table from the menu bar, click Table Properties, and from the Table tab, click 
the Borders and Shading button to display the Borders and Shading dialog box, 

as shown below. 
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B
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a
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Figure 5: Borders and Shading dialog box - Borders tab selected 

 
Be certain the Borders tab is selected. From this tab you can 

customize your table by controlling what lines of the table, cell, row 

or column is displayed and at what line thickness. You can play 

around with the settings in this tab until you are happy with the 

results, but for our purposes, we want the first cell in the first row 

of our framework table to NOT display. To do this, perform the 

following steps. 

3. Place the cursor in the first cell of the first row of the framework table. 

4. In the Borders and Shading dialog box, click the Custom box in the 

Setting: area. 

5. In the Preview area, click the buttons for the lines that you don't 

want to display. The image in the center of the Preview area will 
show you which lines will display and which ones won't, based on 
the button you have pressed. For our purposes, we don't want the 

top or left side borders of the cell to display, so click the appropriate 
buttons. In the Apply to: area, be sure you select Cell so that your 

changes don't apply to the entire table. 

6. Click OK. The table should now display as shown below: 
 

    

    

    

    

    

 
The top and left side borders of the first cell in the first row will 

now be grayed out. These borders will not display when the 

paper is printed. 

 

Working with Text 
Similar to changing the color of a cell, row or column, changing the 

color or style (if the text is bold, italic, underlined or plain) of the text 
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within your table can also help draw your reader's eye to important 

text. For example, bolding the text of a heading for a column will 

indicate to the reader that this is a heading and not a data cell. 

 

To add text: 

1. Place the cursor inside the cell. Begin typing. 

2. You can also copy and paste text into the cell. 

For our framework table, we want to simply label each cell. Each row 
and column will have a heading, and each data cell will be labeled as 
well. Our table should now look like the following: 

 

 Column 1 Column 2 Column 3 
Row 1 Cell 1 Cell 2 Cell 3 
Row 2 Cell 4 Cell 5 Cell 6 
Row 3 Cell 7 Cell 8 Cell 9 

    

You may notice that we left the bottom row blank. This is because we 

will delete this row later in this document. 

 

To change font color: 

1. Highlight the text. 

2. In the Windows menu bar, click Format and select Font to display the 
Font dialog box. 

 

 

 

 

Font Tab 

 

F

o

n 

 

 

 

 

 

 

 

 

Figure 6: Font dialog box 

 

3. Make sure the Font tab is selected. In the Font color: section, select 

a color from the drop-down list. 
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4. Click OK to apply the changes or Cancel to exit without applying the 
changes. 

 

For our framework table, we want the heading cells for each column 

and row to display in white text, so we will select white. So now our 

framework table should look like the following: 
 

 Column 1 Column 2 Column 3 
Row 1 Cell 1 Cell 2 Cell 3 
Row 2 Cell 4 Cell 5 Cell 6 
Row 3 Cell 7 Cell 8 Cell 9 

    

 

To change the style of a font: 

1. Highlight the text that needs to be changed. 

2. In the Windows menu bar, click Format and select Font to display the 

Font dialog box. 

3. In the Font style: section select the style for the text. 

4. Click OK to apply the changes, or click Cancel to exit without applying 

the changes. 

For our framework table, we want the heading cells for the columns 

and rows to be bolded. So we would select Bold in the Font style: 

section of the Font dialog box. (See Figure 6: Font dialog box.) The 

heading cells for the columns and rows should now be bolded, as 

displayed in the table below: 
 

 Column 1 Column 2 Column 3 
Row 1 Cell 1 Cell 2 Cell 3 
Row 2 Cell 4 Cell 5 Cell 6 
Row 3 Cell 7 Cell 8 Cell 9 

    

 

To adjust the alignment of the text within the cell, row or column: 

1. Highlight the text for which you want to change the alignment. 

2. Right click and click the arrow next to the Cell Alignment option on 
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the menu. 

3. In the option menu that displays after you click the arrow, the top 

row will align the contents of the cell to the top of the cell(s). The 
middle row options will align the contents of the cell to the center 

of the cell(s). The bottom row options will align the contents of the 
cell to the bottom of the cell(s). 

For our framework table, we want the heading cells for the columns 

to be aligned in the center of the cell, so we will highlight the heading 

cells for the columns, right click, click the arrow on Cell Alignment, 

and select the option that will align the text in the middle center. 

The framework table will now display as below: (notice the column 

headings are centered) 
 

 Column 1 Column 2 Column 3 
Row 1 Cell 1 Cell 2 Cell 3 
Row 2 Cell 4 Cell 5 Cell 6 
Row 3 Cell 7 Cell 8 Cell 9 

    

 

Deleting Tables, Cells, Rows and Columns 
Once you have created a table, it may be necessary to delete parts 

of the table, or the entire table. The following instructions will lead 

you through deleting tables, cells, rows or columns. 

 

To delete a table: 

1. Place the cursor in a cell of the table you want to delete. 

2. In the Windows menu bar, click Table > Delete > Table. 
 

To delete a cell: 

1. Place the cursor in the cell you want to delete. 

2. In the Windows menu bar, click Table > Delete > Cells. 

Use the Shift cells left option if you are deleting a cell from a column 

and want the other rows to move to the left to fill the empty cell. 

Use the Shift cells up option if you are deleting a cell from a row and 

want the other rows to move up to fill the empty cell. 

Use the Delete entire row option if you want to delete the whole row. 
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Use the Delete entire column option if you want to delete the whole column. 

 

To delete a row: 

1. Place the cursor inside any cell of the row you want to delete. 

2. In the Windows menu bar, click Table > Delete > Rows. 
 

To delete a column: 

1. Place the cursor inside any cell of the column you want to delete. 

2. In the Windows menu bar, click Table > Delete > Column. 

For the final step in making our framework table into the sample 

table, we want to delete the bottom row of the table. To do this, we 

place the cursor in any cell of the bottom row. Click Table > Delete > 

Rows. Our framework table is now finished and should look like the 

following: 
 

 Column 1 Column 2 Column 3 
Row 1 Cell 1 Cell 2 Cell 3 
Row 2 Cell 4 Cell 5 Cell 6 
Row 3 Cell 7 Cell 8 Cell 9 
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MICROSOFT EXCEL 

INTRODUCTION 

If you have ever managed a budget by using paper, pencil and calculator, you would know the limitations: 

1. Filling out ledger sheets 

2. Calculating and recalculating totals 

3. Redesigning sheets to add or delete columns and rows, and so on. 

The beauty of Excel is its ability to simplify these tasks. Working with a paper spreadsheet is complicated, 
time consuming and limited. If a portion of your row data changes, you must erase and re-enter it, then you 
have to erase and recalculate derived data, such as totals or averages that were  affected by your changes. 
Excel can be used to make quick and easy financial analysis, analyze data and create presentation with chats 
(graph utilities), retrieve data from external data sources and use it in worksheets to calculate based on data 
from multiple worksheets, create web page with ease, and run queries on data available on the web. 

What Is Microsoft Excel? 

Microsoft Excel is a full-featured spreadsheet program that allows you to organize data, complete 
calculations, make decisions, transform data to graph, and develop professional looking reports. The three 
major parts of Excel are: 

Worksheets ñ Worksheets allow you to enter, calculate, manipulate and analyze data such as numbers and 
text. 

Charts ñ Charts pictorially represent data. Excel can draw two-dimensional and three dimensional column 
charts, pie charts and other types of charts. 

Databases ñ Databases manage data. For example, once you enter data onto a worksheet, Excel can sort the 
data, search for specific data, and select data that meets certain criteria. 

Excel and Data Base Management 

Excel is not database package but has some special database features like sorting, filtering, and data retrieval, 
which allows users to create and manage list. Hence, Excel is equipped to handle and manipulate small 
databases. While creating a small database, two points must be noted: 

a) The rows of data should be continuous to facilitate the manipulation of data. That is no blank row even a 
column label and the first record in the database. 

b) The names of the columns should be entered in a single cell and must be unique. 

HOW TO START EXCEL 
Start  All Programs  Microsoft Office  Microsoft Excel. 

Note that the version of the Excel used in this manual is 2003. There are latest versions that make the use of 
the package very easy and contains some new features. But I think using 2003 version is still better for 
learning purpose. 

EXPLORING THE WINDOWS 

There are two types of windows that appear on your Desktop: the application window and the document 
window. Application window contains the running program and they have menu bars.  The  document  
window appears inside the application window and it does not have menu bars. 

The status bar 

This is usually located and appears at the bottom of the screen. It shows the mode (status) of the worksheet. 



 

 

Selecting the whole worksheet 

Sheet Tabs Sheet Navigation buttons 

Cell reference 
or Name box 
or Cell indicator 

Notice the word ready on the status bar that tells you that Excel is ready and awaiting your next command. 

All indicators that appear on the status bar at the lower right corner of the screen are: 

Ready: This shows that the Excel is ready for the next command 

NUM: Toggles to activate the numeric keypad. 

CAPS: Toggles between the UPPERCASE and the lowercase. 

SCRL:Indicates that the scroll lock is on, the insertion point is not moved. 

EXT: Indicates that you are in the extension mode (press F8, press Esc to deactivate). 

END: Used with the navigation keys to move to the far ends, but to A1 with Home key. 

EDIT: Press either F2 or double-click a cell to enter the Edit Mode. 

POINT: When in Point Mode. This is done by using either mouse or arrows to select cells instead of typing 
when entering formulas. 

AUTOCALCULATE: Auto-calculate is a feature located at the right side of the status  bar  that  
automatically provides Averages, Count, Count Nums, Max, Min, or sum for the selected data. Sum is the 
default formula but can be changed by right-clicking this feature on the status bar to choose any other one 

 

from the Auto-calculate pop-up menu. The answer appears on the status bar. 

Note that the window above describes some features of the Microsoft Office Excel 2003. Other versions may 
look different or contain more rows and columns. For instance, in 2007, number of available columns is 64 x 
that of 2003 (i.e. 64 x 256 = 16,384) while rows numbered 16 x that of 2003 (i.e. 16 x 65,536 = 1,048,576). 
Also, the toolbars and menu bars have been replaced with ribbons. Itís very nice to work with this version. 

Display or hide the status bar 
Tools  Options View tab  Select or clear the Status bar check box. 



 

 

WORKING IN THE SPREADSHEET 

Workbooks 

Workbooks are like notebooks. When Excel first opens, a workbook is opened. Within that workbook are 
worksheets. You create your spreadsheets on the worksheets. Worksheets are organized into  a rectangular  
grid containing columns (vertical) lettered A to IV and rows (horizontal) numbered 1 to  65,536. A letter  
above each column identifies each column and a number on the left side of the grid identifies each row. Each 
worksheet in a workbook has 256 columns and 65,536 rows. Note that the alphabets in the columns can be 
changed to numbers by working in R1C1. 
Tools  Options  General Tab  Check R1C1  Ok. 

Navigating/Selecting in the Worksheet 

To move to a specific cell or range you can use the mouse, the menu, or the keyboard. 

 To select a single cell, place your cursor on the cell and click once (active cell). 

 To select multiple continuous cells first make one cell the active cell. Hold  the  left mouse button and  
drag until all the desired cells are highlighted or select the first cell + Shift/F8 + select the last cell. 

 To select an entire column/row or multiple columns/rows, select the column/row heading(s). 

 To select entire workarea/worksheet, click on the select all buttons located  at the  intersection between  
row and column heading in the upper-left corner of the worksheet 

 To select non-contiguous areas, use Ctrl with the methods of selection. 

 You can also use the keyboard navigation keys (4 arrows, Home, End, Page Up, Page Down, Tab). 

Note that the End mode move to the end of the data on a worksheet. e.g. Ctrl+Home key taken to cell A2. 

 You can move quickly across the worksheet by using F5, Ctrl + G or EditGo ToÖ 

 Use the name box to specify the cell(s) and press Enter e.g. single cell A5, or range (contiguous) or range 
(non-contiguous)A1:B12, H13:V67, AB1:AZ20. 

 Use the sheet Tabs to select the desired sheet(s) using other key combinations (Shift and/or Ctrl). 

 Use the Tab Scroll buttons (located left to the sheet Tabs) to navigate through the worksheets. 

 To activate any workbook of the recently opened books, Windowclick the desired workbook. 
In a range selection, the active cell appears white and receives any keystroke. You can change the position of 
the active cell within a selection using Enter or Shift + Enter (to move down/up), Tab key or Shift + Tab key 
(to move right/left). 

When you use the Scroll bar, as you drag the scroll box, scroll tips appear beside the scroll bar to indicate 
which row will be at the top of the screen when you release the mouse button. 

Cells 

The intersection of a column and a row is a cell. The cell is the basic unit of the worksheet and  data is  
entered in cells. A cell is referred to by its unique address, or ìcell referenceî or ìCell indicatorî, which is 
composed of the coordinates of the intersection of a column and a row. To identify a cell, specify the column 
letter first, followed by the row number. For example, cell reference D3 refers to the cell located at the 
intersection of column D and row 3. The active cell has a heavy border surrounding the cell. In addition, the 
active cell is listed in the ìreference areaî immediately above column A. range of cells is identified by using 
A1:B14 i.e. cell A1 through B14. To give a cell a unique name, select the cell and overtype the name in the 
cell reference. 



 

 

Inserting and Deleting Worksheet 

To insert a worksheet, Insert  Worksheet. 

To delete a worksheet, make it activate  Edit  Delete Sheet. 

You can also right-click the sheet tab to Insert, Delete, Rename, Copy, Move, Select all Sheets and/or give 
them colour. 

ENTERING DATA 

Data is entered in cells, and the most common types of data entered are texts (labels), numbers (values) and 
formulas. Labels are left justified and if the text is longer than the width of the column, they overflow 
characters in adjacent cells to the right as long as 

these adjacent columns contain no data. Values consist of the digits zero through nine and any one of the 
following special characters: + - ( ) , / . $ % E and e. If a cell entry contains any other character (including 
spaces), they are interpreted as text and treated accordingly. To enter a fraction, type the integer, then hit the 
space bar and type the fraction e.g. 1.5 = 1 8. To enter only the fractional part, type a zero, a space, and then 
the fraction e.g. 0.5 = 0 8. For details on Formulas, see under Calculation. 

To enter a value/label into many cells at a time, select all the cells, type the value/text and press Ctrl + Enter. 
Values longer than 11 characters within a cell by default will be displayed as scientific notation or number 
sign (####). To display all the digits, widen the cell. 

Note: Data may be raw or derived. Raw data are entered by the user, while derived data are calculated from 
the row data. 

Entering numbers and texts 

Any number that you enter is assumed to be values. When you enter numbers that you donít want any 
calculations to be performed on them, you enter the number as label by using the single quote before the 
number. For instance, both ë100 and 100 will be displayed as 100 in Excel but are of different formats. 

Smart Tags  

When you make an entry that Excel believes you may want to edit, a smart tag  appears. This gives you  
chance to make changes easily. Cells with smart tags appear with a green triangle in the upper left corner. 
When you place the mouse on it, it shows an error icon that can be clicked to see the options that you can 
choose from concerning that data. 

Editing data 

After you enter a data into a cell, you may want to edit it. This can be done by pressing F2, clicking in the 
formula bar, and double-clicking in the cell. You can change the data entry completely by just clicking  the 
cell and enter the new data. 

Anything you enter in a cell appears in both the cell and the formula bar until it is entered by accepting it.  
This is the Enter Mode. At the left side of the formula bar are three buttons: Cancel, Enter, and Edit 
formulas buttons. Use the Enter key, or click the Enter button, or move out of the cell to accept the data 
entered. To reject, press Escape key (Esc on the keyboard), use Cancel button, or press Backspace key to 
delete one character after the other. To edit, press Edit button or press F2 (this will enable you to use 
navigation buttons within the data). 

Deleting a cell entry 

Place the cursor in the cell or highlight the group of cell and press Delete. 



 

 

Deleting  Cells, Rows and Columns 
Select the rows/columnsEditDeleteÖ 
Freeze Titles and split panes 

When a worksheet is too large to fit on the screen, you can lock some pane to remain in  view while  you  
scroll through the rest of the worksheet. Freezing titles is done to keep it in views. The  titles/headings  will 
not leave the view when scrolling through the worksheet. Select the rows or columns to be frozen. 

To lock window; Window  Freeze panes. 

To unlock window; Window  unfreeze panes. 

Splitting the window into two or more panes. This is done when different parts of a large worksheet are to be 
viewed at ones, the worksheet may be arranged vertically or horizontally, windowsplit. To do  more, click in 
any of the window where you want the split and repeat the steps. 

Fill Handle Feature 

The fill handle feature of Excel makes copying a formula in one cell to adjacent cells easy. The fill handle is 
the small rectangular box located in the lower right corner of the heavy border around the active  cell. Make 
the active cell the cell with the formula to be copied, grab the fill handle with the mouse pointer and drag it 
across the cells where the formula is to be copied and applied. This can be used for filling series or copying. 
Using the right click is better when the value is not continuous. 

Inserting Rows and Columns 

To insert a single row/column, select a cell in the row/column immediately below where you want to  insert 
the new row/columnInsertRows or Columns. 

To insert multiple rows/columns, select the same number of rows/columns that you want to insert 
immediately below where you want them insertedInsertRows or columns 

Adjusting Row Height and Column Width 

To change the height or width of a single row/column, drag the boundary below the row/column heading  
until the row is the height or width you want. 

To change the height or width for multiple rows/columns, select the rows/columns to be changeddrag a 
boundary below one of the selected rows until the rows are the height or width you want. Adjusting the 
standard column width or row height, formatrows or columnsheight or width. 

Saving a file 

This is similar to that of Microsoft word. You should note that you cannot include any of the following 
characters in a file name: forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*), 
period (.), question mark (?), quotation mark (ì), pipe symbol (|), colon (:), or semicolon (;). 

Quitting Excel 

This can be done in two ways, to Exit or Close from the file menu. Close to close the worksheet but Exit to 
close the application window i.e. FileClose or Exit. 

Data Form 

When you are dealing with a worksheet with numerous columns that can't be viewed at once, either to view 
details of a particular record, modify it or enter new data, data form feature is used. This allows all the fields 
in the worksheet be viewed at once or scroll down to view all the fields for a particular record. 
Data  Data Form 



 

 

 
 

CUSTOMIZING EXCEL 

Customizing Settings 

One of the strengths of Excel is the ability for each individual user to customize the program so that it works 
the way you want it to work. 

To customize Excelís settings, ToolsOptions. Many of the options should not be changed from the default. 

View Tab 

If you have a slower computer, you should consider activating the Show Placeholders  option. This  will 
allow you to scroll quickly through a document since objects do not have to be displayed. If you  would  
always like to see your page breaks on your document, activate the Page Breaks option. 

Calculation Tab 

If you have a large spreadsheet with a lot of formulas in  it, and if you notice a delay each time you modify  
one of the formulas, you should consider selecting the Manual option in the Calculation section. With this 
option selected, Excel will only update your calculations when you ask it to do so, instead of recalculating all 
formulas each time an edit is made. When you are ready to recalculate, press the F9 key. 

Edit Tab 

One handy option allows you to dictate which cell becomes active when you press the Enter key (Windows). 
By default, when you press the Enter key, the cell below the current cell becomes the active cell. You can 
choose to make the active cell the cell above, below, to the right or to the left of the current cell. If you 
deselect the option, the current cell will remain the active cell when you press the Enter key. 

General Tab 

The Recently Used File List setting determines how many files appear at the bottom of the File Menu 
(maximum is nine while default is 4). The Sheets in New Workbook setting determines how many blank 
worksheets are available in a new workbook (by default is 3 but can be up to 255). The Standard  Font 
setting dictates the type and size of font that will default into each new workbook. You can change the 
standard font type and size to your preferred font. The Default file location setting tells Excel where to look 
for files when you open an existing document. If you set this to the folder that holds all your data files, you 
will speed the opening of your documents. 

Custom Lists Tab 

Here you can create lists that Excel uses when you copy a cell into adjacent cells using the AutoFill handle. 
For example, if you commonly create a long list of headings specific to your department, you can create a 
custom list to make this job easier. You can create custom lists two ways: 

1. Click NEW LIST in the Custom Lists window. Then click in the List Entries window and type each list 
member, pressing the Enter key after each entry. Click the Add button when you are done. 

2. Create a new list by selecting a range of cells in the Import List from Cells field. Once the range of cells 
that contains the list is entered, click the Import button to create the new list. 

AUDITING 

Excel offers an easy way to check your worksheets to ensure that your formulas are created correctly. With 
Excel, you can display tracer lines to find precedents (cells that are referred  to by a formula), dependents 
(cells that contain formulas that refer to other cells), and errors in any cell. The first step in the process is to 
activate the Auditing Toolbar. 



 

 

Tracing Precedents 

To determine which cells are used in the calculation of a value in another cell, select the cell with the 
calculated value. Click on the Trace Precedents button and Excel will graphically show you which cells are 
used in the calculation of the value in the selected cell. Click the button repeatedly, and Excel will take you 
deeper into the precedent relationship. 

Tracing Dependents 

To determine which cells depend on the value in a specific cell, select the specific cell. Click on the Trace 
Dependents button and Excel will graphically show you which cells rely on the value in the selected cell.  
Click the button repeatedly, and Excel will take you deeper into the dependent relationship. 

Removing Precedent/Dependent Arrows 

You can remove the arrows one level at a time by using the Remove Precedent Arrows button and the  
Remove Dependent Arrows button. You can also click the Remove All Arrows button to  remove  every  
arrow in the worksheet with one click. 

Tracing Errors 

When cells return an error result, such as #VALUE! select the cell with that result and click the Trace Error 
button. The normal trace arrows are drawn which enables you to track down the source of the error message. 

When you see the  symbol, this means that the trace extends to another worksheet or workbook. When 
you double click on the symbol you will be told which workbook or worksheet has cells involved in  the  
trace. 

VALIDATING USER INPUT 

If you create worksheets that others will use to enter data, you can define rules for the data that is to be 
entered. If invalid data is entered, you can have automatic pop-up reminders and messages display. 

Setting Validation Rules 

To set rules, you must first access the Data Validation dialog box. You do this by selecting the cells in the 
worksheet that are going to be subject to the rulesData Validation. The Data Validation dialog box will 
appear. The box has three tabs. 

The Settings Tab 

In the Settings tab, you set the actual rule for the selected cells. You first choose a type of data that can be 
entered in the Allow text box, and then you complete the remaining fields on the Settings tab to set the rules 
for that data type. 

The Input Message Tab 

With this tab, you can create input messages that remind the people using the worksheet of what data is 
required. When a cell is selected that has an input message defined, a comment appears with the information 
you type in the dialog box. 

The Error Alert Tab 

Use this tab to set an error alert for those times when data entered into the cell violates the established rules. 

Three types of error alerts can be defined: 

Information ñ When displayed, the user can simply acknowledge and continue, leaving the  invalid  data 
intact. 

Warning ñ When displayed, the user must acknowledge that they want to leave the invalid data intact. 



 

 

Stop ñ When displayed, the user must correct or reverse the entry. 

OUTLINING 

With larger worksheets, it is sometimes hard to get the big picture represented by the data. Sometimes you 
want to hide some of the data and only see totals. With Excel, you can create different outline levels in your 
worksheet. This way you can hide or reveal the data as needed. 

Creating an Outline Level 

To create an outline level, Select the rows or columns to be outlined (Outlined areas cannot be immediately 
adjacent to other outline areas)DataGroup and OutlineGroup. The outline is automatically created. 

Using Outlines 

Once an outline is created, you can click on the Show/Hide Detail buttons (the plus and minus buttons) to 
display or hide the contents of the outlined region. 

Removing an Outline Level 

To remove an outline level, select the rows or columns that make up the outline to be deletedDataGroup 
and OutlineUngroup. The outline is automatically deleted 

LINKING TO M-WORD 

You can take information from an Excel worksheet and place that information into a Word document. This 
information can be embedded in the Word document or linked to the Word document. 

Embedded vs. Linked Information 

If you embed Excel information into a Word document, a duplicate of the Excel information  is  actually  
added to the Word document, thus increasing the size of the Word file and the changes  in  the  Excel 
document will not be reflected in the Word document. 

If you link Excel information to a Word document, a pointer is stored in the Word document referencing the 
actual information in the Excel document, thus does not change the size of the Word document and changes  
in the Excel document will be displayed in the Word document to reflect the current Excel document. 

Embedding Information 

Select the desired cells in ExcelCopyOpen the Word document and place the cursor at  the  location 
where you want the Excel information insertedPaste. 

Linking Information 

Select the desired cells in ExcelCopyOpen the Word document and place the cursor at  the  location where 
you want the Excel information linkedPaste SpecialPaste LinkSelect the  Formatted  Text  (RTF) 
optionOK 

CONCATENATION 

You can join the values in two or more cells into a single cell. For instance, if you have a personís first name  
in one cell and their last name in a second cell, you can concatenate the cells  which will result in the full  
name being displayed in a single cell. 

Join Multiple Cell Values into a Single Cell, click in the cell where we need the data type = First cell & ì 
ì & second cellEnter. You can do this for more than two cells. 

TEXT TO COLUMNS 



 

 

You can take text in a single cell and break it out into multiple cells. For instance, if you have  a personís  
name in a single cell (Firstname, Lastname) and you want to sort by Lastname, you can breakup  the name  
into separate cells and then you can sort by Lastname. 

To split single values into multiple cells: You must have enough empty cells to  the  right of the original cell 
to hold the data once it has been split. Select the cell with the multiple valuesDataText  to  ColumnsThe 
data will either be delimited (characters such as commas or tabs separate each value) or fixed width (fields are 
aligned in columns with spaces between each field)-select  the  appropriate  optionNextIf delimited, check 
the box that contains the appropriate delimiter. If fixed width, insert,  delete or move the vertical line so that 
the window shows the breaks as you desire themNextFinish 

Single and Multiple Level of Sorting Data 

This is done to rearrange and reorder data in a list. This is done in order to rearrange the records  in  a  
specified order e.g. alphabetically, numerically, chronologically and either ascending or descending order. 
Particular field must be set as a reference, this field is called sort key. 

A list is an organized collection of related information. Lists are usually arranged in a column-and  -row 
format as a labeled series of rows that contain similar data e.g. telephone books, checkbooks, and personal 
phone directories. 

In Excel, a list must contain at least one column, which represents one category of information. Each column 
is identified by a title called a Column Label. Common labels should contain a font, data type, alignment, 
formatting, pattern, border, or capitalization style that differs from the data contained in the rows beneath 
them. This is how the column labels are recognized. 

A row in a list is called a set of data. Each set of data contain information from one or more related columns. 

Sorting is used to organize the sets of data in your list alphabetically, numerically, or chronologically. When 
you sort a list, the rows are arranged according to the contents of one or more columns. If you want to 
rearrange the sets of data in your list according to the information contained in only one column, you can 
perform a quick sort using the sort Ascending or sort Descending buttons, click any where in the column and 
click the Sort button. 

Excel automatically selects the entire list for sorting but companies the rows of the list for formatting 
differences. If it finds that the top row is formatted differently from the following rows, it identifies that row  
as a column label and excludes it from the sort. 

You can use the EditUndo Sort command to undo a sort  immediately after it has been performed. Once  you 
have issued another command, the undo command is no longer available. If your list is in no particular 
order and you want to assign order to it, then you can number the sets of order in your list. By this, you can 
easily return to the original order without relying on the undo command. 

In lists, many sets of data might contain some similar information e.g. two or more students might have the 
same surname. Sorting the list by the data contained  in  one column  might not provide enough order  because 
of the ties that occur with repeated information. To break these ties, DataSort command  enables  you  to sort 
by multiple columns of information. Consecutive sorts enable you to sort your list by more than three 
columns you can specify in the sort dialog box. In consecutive sorts you must perform the sorts for the least 
important order first, then work your way up to the most important sort order. The sort dialog box enables  
you to specify three columns by which to sort a list. The sort-By drop-down list specifies the secondary sort 
order, and the second then-By drop-down list specifies the list sort order. 

Custom sort rearrange your data in chronological order. To customize sort order, use  the sort options button  
in the sort order dialog box. 

Automatic subtotals help to summarize the data contained in a list. You create subtotals by using an Excel 



 

 

summary function, such as sum, count, or average. To use subtotals, your data must be organized  in  a 
properly designed list and sorted according to the column by which you want to summarize the data. Data  
subtotals. 

FILTERING 

If you are working with a list of items as you would if you had a database in Excel, you can  use  the 
AutoFilter tool to quickly search through your list for particular records. When you filter a list, you display 
only the sets of data that meet a set of search conditions (called criteria). The AutoFilter tool lets you  filter  
out all records that meet your criteria. The list itself is unchanged and you can change the criteria at any time 
to display a different set of records. 

AutoFiltering 
Select the column(s) or cell(s)  Data  Filter  AutoFilter 

Arrows are shown on the columns from which you want to filter. Navigate through the list by using the drop- 
down arrow buttons to indicate individual criterion per column meeting your criteria. After you  specify a  
filter criterion for one column, you can filter your list further by selecting  filter criteria for other columns. 
This procedure creates an AND condition i.e. the sets of data must meet all the set criteria. Although, sets of 
data that do not meet your criteria remain in the worksheet but the rows that contain them are hidden. To 
display a filtered list of records-click on desired button and select your desired criteria. 

You can also select one of the following special filtering options: 

ALL - Unfilters your list and shows all records. 

TOP 10 ñ (Used for numbers and dates only) Displays the top or bottom 10  (or another number you select)  
of records in the list, or the top or bottom 10% (or another number you select) of the records in the list. 

BLANKS ñ This selection allows you to display only the records with missing entries. 

NONBLANKS ñ This selection allows you to display only records that have some type of entry in the cell. 

CUSTOM ñ This option allows you to display criteria meeting your customized needs. State  your  
comparison criteria by selecting the desired operator then enter the comparison value in the window on the 
right. You can use multiple comparison criteria by selecting the AND or OR options and entering the desired 
criteria in the lower two windows. The OR condition allows you  to  use set of data which  must meet either 
the first filter criteria or the second filter criteria. Use the drop-down list to select custom. This can also be 
used to find values that fall within a specified a range by using comparism operator. 

You can use wildcards to search for sets of data in a list that have certain text in common within the unique 
entries, even through the entire entry might not match. Examples of wildcards include: 

Asterisk (*): finds any characters that are in the same position as the asterisk. 

Question mark (?): finds any single character that is in the same position as the question mark. 

Tilde (~): finds a question mark or asterisk. 

Note that if some columns are selected before the Auto filtering command, the drop-down arrows are only 
shown in the selected columns but the filtering is applied to the entire worksheet. 

To display all the hidden rows so that the entire list is visible, use Data  Filter  Show All. This removes 
the filtering from the worksheet. If you want to remove filtering for certain column(s), select All from the 
drop-down list options. 

ADVANCED FILTERING 

When using Excel as a database, you can query information by the use of filters. Filters allow you to extract 



 

 

data based on criteria you specify. 

Type the headings in new space to specify below it the criteria. Values on the same line means AND  
condition while on different line signifies OR condition. 

To filter in place you must first establish the criteria area and then input your criteria. 

Select the labels for all of the fields  copy these labelsselect an area of the worksheet and pasteenter 
the criteria you want to use to filter your database (Criteria entered on the same row will treated as an ìandî 
condition. Criteria entered on different rows will be treated as an ìorî condition.) 

Filter in Place 

To perform a filtering action that will place the search results in the location of the existing database: 

Select any cell in your databaseDataFilterAdvanced Filterclick the Collapse  Dialog  button  to  select 
the cells that contain the criteria (all field labels must be included)click the Collapse Dialog button   to 
restore the dialog box to the screenEnsure that Filter the list, in place option is selectedOK. 

Filter to Another Location 

Select any cell in your databaseDataFilterAdvanced Filterclick the Collapse  Dialog  button  to  select 
the cells that contain the criteria (all field labels must be included)click the Collapse Dialog buttonclick the 
Collapse Dialog button to the right of the Copy to boxselect in the worksheet area where you need the 
resultsclick the Collapse Dialog buttonEnsure that Copy to another location option is selectedOK. 

PROTECTION 

It is fairly easy to inadvertently replace a formula with a value. To avoid having this happen to your 
painstakingly-crafted formulas, you can choose to lock cells and/or protect  the  workbook. By default, all  
cells are locked. Until you enable protection however, the lock has no effect. What you must do before you 
protect a worksheet is to unlock all the cells for data entry or editing are to be enabled. 

There are several levels of protection that you can place on a workbook. You can: 

✓  Assign a password that is required before a file can be opened. 

✓  Assign a password that is required to modify a file. 

✓  Set up the file so that it is recommended as a ìread-onlyî file. 

✓  Hide worksheets in a workbook and require a password be used to re-display the worksheets. 

✓  Protect specific cells within a workbook so that changes cannot be made to the cells. 

Setting a Password to Open a File 
This is similar to barred security in M-Word. FileSave AsTools buttonGeneral Options 

Enter the desired password in the Password to open box (and/or password to modify and/or Check Read 
Only)Ok (You will be prompted to re-enter password)Save. 

Note: 

1. If you select to require a password to modify a file, the user must know the password to make  any  
changes to the workbook. The user will have the option to open it and view it, but cannot save any  
changes to the file unless the file is given a different name. 

2. If you select to recommend read only, keep in mind that this is a recommendation only. The users are not 
prevented from editing and then saving changes to the workbook under a different name. 

3. Write the passwords down and keep in a secure place. If you lose the password, you cannot open the file. 



 

 

Hiding Rows, Columns and/or Worksheets 

You can hide worksheets and then protect them from being displayed without a password. Select the 
worksheet to be hiddenFormatSheet or Row or ColumnHide 

Protecting the workbook 

ToolsProtectionprotect WorkbookCheck Structure box  to  activate protection  for the basic structure  of 
the workbookEnter the passwordOkRe-enter passwordOk 

Protecting Cells in a Worksheet 

When you protect a worksheet, Excel assumes that every cell in  the  worksheet is to be protected. You need  
to tell Excel which cells can be modified. 

Select the cells that are permitted to  be modifiedFormatCellsProtection tabUncheck  the Locked  box 
to unlocks the selected cellsOKToolsProtectionProtect SheetEnter PasswordOKRe-  enter 
PasswordOK. 

FORMATTING DATA 

This is used to format the data in cell(s) to specify the categories e.g. Number, Currency, percentage, etc. 

Formatting Fonts 

You can format (alignment, font size, colour or type, Bold, Italic, Underline) characters, words and 
paragraphs easily by using the methods you know from Microsoft Word. Note that underlining  may be 
single, double, single accounting or double accounting. FormatCellschoose tabsmake changesOk 

Formatting Numbers 

You can format numbers in Excel by adding commas to separate thousands, specify number of decimal  
places, place dollar sign to convert number to currency, display number as percent and so on. Almost  all  
these are on the formatting toolbar or FormatCellsNumber Tabsselect from the category boxmake 
other selectionsOk. 
Others that can be formatted are Alignment, Border, patterns and protection. 

Creating Borders 

The worksheets you see with the lines like that of a table are not really there. You have to create the borders  
as we have in Microsoft Word. 

Moving and Coping Data 

This is similar to that of Microsoft Word. You can drag a selection  items to new location. Drag only when  
the pointer changes to a pointer. The second method is cutting and pasting. You can copy by drag and drop 
while holding the Control button. You can also use copy and paste method. Another way is to use fill handle  
to copy formula. Excel adjusts the formula of copied cells. Clipboard can also be used to copy more than one 
item to contain up to 24 items. 

Relative, Absolute and Mixed Referencing 

By default, all cell references in Excel are relative references. A relative reference is a cell reference in a 
formula that is adjusted when the formula is copied. For instance, if cell A1  contains  the  formula ì=B3î,  
then Excel knows that it must look one column to the right of column A and two rows down from row 1 to 
find cell B3ís value. If cell A1 is copied to cell A3, Excel will look one column to the right of column A and 
two rows down from row 2 to find the new value, which is now B5. 

An absolute reference is a cell reference in a formula that does not change when copied to  a new location. 
To change a relative reference to an absolute reference, insert a ì$î before the column letter and/or the row 



 

 

number. A8 changes to A$8 (fixed row), $A8 (fixed column) or $A$8 (both fixed). You can simply press F4 
when you are in point mode. To toggle between the relative reference and the absolute, select the cell and 
press F4 in succession. 

Mixed reference contains both the absolute and/or the relative references. 

Thereís another type called circular referencing. This occurs when a formula refers to the cell in which it 
resides. When a cell contains a circular reference, an error message box is displayed when you open the 
worksheet. Dismiss the message box by pressing Ok. The circular reference toolbar is displayed and the 
message in the status bar identifies the cell that contains the circular reference. The formula will not work  
until you set the number of iteration. Tools  Options  Calculate Tab  check the Iteration check box. 

Page Setup 
This is similar to that of M-Word, FilePage Setup. Other things to be noted here are: 
Page Tab: Scaling is done with respect to width and height or by both. The other feature here is the Page 
Number, change the format from auto if you need other than 1, 2, 3, Ö 

Margins Tab: center on page either horizontally and/or vertically. 

Header & Footer Tab: this feature is done here and has the same options as in M-Word. This can also be 
done in the same way as the M-Word. ViewHeader and Footer. 

Sheet Tab: Print area to select the area you want to print of the document. Print Title to include for the 
heading either Top or Left. Print the gridlines, Headings, Black and White, or Comments. The  last  is the  
page order which is very important. 

Page Break 

This is done to differentiate between the pages. InsertPage Break. You can also click on any row/column 
above/after which you want the break to be to either insert or remove the break. You can add the page break 
in preview window which will colour the lines to enable you move and set the page as you want. Page break 
preview button or viewpage break preview. 

Adding and Formatting Graphics Object 

The buttons on the drawing toolbar enable you to create lines, arrows, shapes, and text boxes that are 
displayed and print as part of a worksheet or a chart sheet. You can display the Drawing toolbar by using the 
toolbar shortcut menu or by clicking on the Drawing button the items on the toolbar can be used similar to 
their uses in Microsoft Word. You can also format them as the same way you format any other chart item. 

PRINTING 

Print Preview 

Before you print your document, you may want to look at the document on the screen  to ensure that your  
page breaks are where you want them. Excel allows you to see each page of the document as it will appear 
when printed. To preview your document, FilePrint Preview or Print Preview button. This view enables 
you  to  see  what the  final document  will look  like, and  it may save  you  from  printing pages  that are   not 
formatted properly. To exit, click on the Close button. This screen enables you to do  many changes like  set 
up the pages, view and move the margins, and even go to normal view (to exit the coloured break lines. 

Printing the Document 
When you are ready to print your document, or a part of your document, click on FilePrint. 
Print Range-All (default) to print the entire spreadsheet, Page(s) to specify which pages to print. Use the 
up/down arrows to indicate the desired pages to print. 



 

 

Print What-Selection to print the selected area, Active sheets (default) to print the worksheet, and entire 
workbook. 

CALCULATIONS 

Formula is one of the reasons Excel is such a valuable tool because you can assign a formula to a cell to 
calculate and display the result in  the cell. Formula is not case sensitive, and  spaces can be added between  
the arithmetic operators to make the formula easier to read. A formula is a sequence of values and cell 
references (entered directly or use point mode) in a cell that produces a new value from existing values. 

The equal sign (=) or plus (+) must precede all formulas in a cell. It alerts Excel that a formula is being 
entered. Valid arithmetic operators are +, -, *, /, %, and ^. When more than one arithmetic operation is 
involved in a formula, algebraic order of operation is followed-Excel will evaluate the operators from left to 
right, and perform the operations in the order shown in the following table. To change the order  of  
evaluation, enclose the part of the formula to be calculated first in parentheses to use BODMAS. 

 
 

Operator Description 

: (colon) 

, (comma) 

(Single space) 

 
 
Reference operators 

Parenthesis ( ) Bracket 

% Percent 

^ Exponentiation 

* And / Multiplication and division 

+ and - Addition and subtraction 

& Connects two strings of text (concatenation) 

  =, <, >, <=, >=, <> Comparison 
 
 

There are three types of formulae viz: 

1. Numeric formula: uses operators like +,-, /,#,^,@functions e.g. = (A1+B1)/C1. 

2. Text formula: uses & or @ for text enclosed in " " and labels e.g.  @LOWER(C3) or   0+"NET"&D4 to 
give NETPAY for cell D4 contains PAY before 

3. Logical formula: statements that returns either 0(false) or 1(true), they use  <,>,=,<>,<=,>=,#NOT#, 
#OR#, #AND# and @ functions. 

You can also enter formula by using column-headings (this is called natural language)  to  activate  this 
feature: Tools  options  calculation Tab  check "Accept Labels in the formula. 

Entering Functions 

Functions are predefined formulas. Excel provides more than 200 built-in functions that enable you to create 
formulas easily for a wide range of needs. Each function consists of the equal sign, the function name  and  
one or more arguments enclosed in parenthesis. To enter a function manually in the active cell, type =  
function name (specify the cell or range of cells you want to use the function for) e.g. =SUM(A1:H34). Then 
you press Enter. The Function Wizard can guide you through the process of entering a function. 



 

 

Insertfunctionsselect categoriesselect functionOkselect range of cellsOk. This can also be 
accessed using the function key (on the formula bar), Autosum button (on the Standard toolbar) 

To enter a formula into selected cells, type the formula and then press Ctrl + ENTER to place this function 
into all the selected cells. This can also be done for values. 

Note that when you select a cell that has formula, the cell displays the  value  after accepting the formula  
while the formula bar displays the formula. To display formulas rather than their results in the cell, 
ToolsOptionsView Tabin the window option section, check formulas 

ARRAYS 

You can perform multiple calculations and return either a single result or multiple results by using an array 
formula. Array formulas use two or more sets of values called array arguments. 

The first set of arguments generally refers to a range of cells that contains data used in the calculation and the 
second set of arguments generally refers to a range of cells where the results will be displayed. 

Each array argument must have the same number of rows and columns. 

You create array formulas in the same way that you create other formulas, except you press 
CTRL+SHIFT+ENTER to enter the formula. 

Single Result 

To use an array formula to obtain a result in a single cell, choose the destination cell, create the formula and 
press CTRL+SHIFT+ENTER to enter the formula e.g. When you enter the formula 
={SUM(B2:D2*B3:D3)} as an array formula, it multiples the Shares and Price for each stock, and then adds 
the results of those calculations together. 

Multiple Results 

To use an array formula to obtain results in a range of cells, select the range of cells where the results are to  
be displayed. The selected range of cells must have the same number of rows and columns  as  the  
argument(s) used in the array formula. Create the formula and press CTRL+SHIFT+ENTER to enter the 
formula. For example, given a series of three sales figures (in column B) for a series of three months (in 
column A), the TREND function determines the straight-line values for the sales  figures. To display all of  
the results of the formula, it is entered into three cells in column C (C1:C3). When you enter the formula 
=TREND(B1:B3,A1:A3) as an array formula, it produces three separate results (22196, 17079, and 11962), 
based on the three sales figures and the three months. 

Edit an Array Formula 

To change an array formula: Select any cell in the array rangepress F2 or click in the Formula Bar to edit. 
(Note that the braces ({}) do not appear when working in the Formula Bar)Make your changes to the 
formulaPress CTRL+SHIFT+ENTER to enter the formula. 

Delete an Array Formula 
To delete an array formula: Select the cell(s) that contains the array formulaPress the DELETE key. 

Conditional Statements 

"If - Then" 

The IF Function is one of the most useful functions available in Excel. When you design an IF Function, you 
ask Excel to perform a test, and then you tell Excel what to do if the result of the test is positive or negative. 

The syntax you use is as follows: 



 

 

=IF(logical_test, value_if_true,value_if_false) 

While this may look intimidating, it really is quite simple. Set up a worksheet as follows: Assume you enter 
the following formula in cell D16; =IF(A16=1,Faculty,Staff). The syntax is broken down as follows: 

 =IF ñ All formulas in Excel start with the equal (=) sign and the IF indicates you want Excel to  perform  
the IF Function. The remaining information in inserted within parenthesis. 

✓  logical_test ñ This is any value or expression resulting in True (1) or False (0). You use the logical test to 
ask Excel to test something. Excel would look at cell A16 and determine if the value of that cell equals 1. 

✓  value_if_true ñ The value that will be returned if logical-test is true. For instance, if A16 has a value of 1 
then Excel would insert the text ìFacultyî in cell D16. 

✓  value_if_false ñ The value that will be returned if logical-test is false. For instance, if A16 has any value 
other than 1, Excel would insert the text ìStaffî in cell D16. 

The value_if_true and value_if_false parts of the function can contain text or formulas. 

You may need to create an "If -Then" formula to generate a nest IF  statement/function. For instance, using  
the grade below for the scores of student in an examination. This formula will specify the grades of each 
student that falls within a certain percentage, then they will receive the letter grade designated for that 
percentage. Letís use the following grade scale for this formula. 

70-100 = A, 60-69 = B, 50-59 = C, 45-49 = D, 40-44 = E and <40 = F. This is an illustration 
=IF(A1>=70,"A",IF(A1>=60,"B",IF(A1>=50,"C",IF(A1>=45,"D", IF(A1>=40,"E","F"))))) 

RAND FUNCTION 

This function creates a list of randomly generated numbers between 0 and 1 to a precision of 15 digits. You 
can use this function to sort a list of items into random order. 

Every time the worksheet is recalculated (by entering text or numbers into a cell and pressing <ENTER>, the 
formulas will recalculate and new random numbers will appear in the spreadsheet cells. To create a list of 
random numbers select all the cells and type =RAND(). Then press Ctrl + ENTER to place this function into 
all the selected cells. 

If you do not want the numbers to be recalculated, select the cells with the random numbers  in  them  and 
copy the cells, then Paste Special as Values. This will turn the formulas into numbers. 

If you need numbers greater than those generated (between 0 and 1), simply create a formula to multiply the 
randomly generated numbers by 10, 100, 1000, etc. This will give you numbers greater than 1. 

To generate a random real number between a and b, use: =RAND()*(b-a)+a 

If you want to use RAND to generate a random number but don't want the numbers to change every time the 
cell is calculated, you can enter =RAND() in the formula bar, and then press F9 to change the formula to a 
random number. 

To switch between viewing the results and viewing the formulas that return the results, press CTRL+` (grave 
accent), or ToolsFormula AuditingFormula Auditing Mode. 

What Formula Error Values Mean 

Microsoft Excel displays an error value in a cell when it cannot calculate the formula properly. Error values 
always begin with a number sign (#). Error value Meanings are 

✓  #DIV/0! Is trying to divide by zero. 

✓  #N/A Refers to a value that is not available. 



 

 

✓  #NAME? Uses a name that Excel does not recognize. 

✓  #NULL! Specifies an invalid intersection of two areas. 

✓  #NUM! Uses a number incorrectly. 

✓  #REF! Refers to a cell that is not valid. 

✓  #VALUE! Uses an incorrect argument or operand. 
✓  ##### Produces a result that is too long to fit in the cell. This is not actually an error value, but an 

indicator that the column needs to be wider. 

LINKING WORKSHEETS AND WORKBOOKS 

Linking Data in Multiple Worksheets 

Each worksheet in a workbook has unique name. You can link the data on multiple worksheets in a particular 
workbook and even do calculations on them from wherever they are. To create a link between some of the 
data on different sheets, use the syntax: sheetname!cell name Opertor sheetname!cell name operatorÖ. For 
instance, sheet1!a2 + sheet2!a2 add the data and display the result in the active. You can also use the paste- 
link method. CopyEditPaste Link 

Linking Workbooks 

You may want to use multiple Workbooks in addition to  multiple  Worksheets, and  Excel provides a means 
of linking Worksheets in multiple Workbooks in order to calculate formulas. The workbook that contains the 
linking formula with external reference is called dependent workbook while the workbook to which  the 
linking formula refers are called the source workbook. The syntax is =[workbook name.xls]worksheet 
name!cell name + [workbook name.xls]worksheet name!cell name. If the worksheets are opened, you can 
navigate to select them from the window menu just as you do in point mode. 

In general see this to imagine: =SUM('C:\Reports\[Budget.xls]Annual'!C10:C25). When the source  is  
opened, the link includes the workbook name in square brackets, followed by the worksheet name, an 
exclamation point (!), and the cells that the formula depends on and add the directory if the  file  is not  
opened, all in single quote as seen above. To ensure that the source workbook formulas have been calculated 
and that document names are current, save the source workbooks before saving their dependent workbooks. 

When you open a file that contains one or more linked formulas, you can use the EditLinks to open source 
workbooks, update the formula, calculations, or change the source workbooks. Because you do not have all  
the source documents open, excel asks if you want to update the linked formula with the latest data from the 
source workbooks. Accept to update. 

CHARTS 

Creating a Chart Using the ChartWizard 

A chart is a graphic representation of your worksheet data. Values from cells (data points) are displayed as 
bars, lines, column, pie slices, or other shapes in the chart. Data points are grouped into data series, which are 
distinguished by different colors or patterns on the chart. The ChartWizard is a series of dialog boxes that 
simplifies creating a chart. The ChartWizard guides you through the process step by step: you verify your  
data selection (either contiguous or noncontiguous), select a chart type, and decide whether to add items such 
as titles and a legend. A sample of the chart you are creating is displayed so  you can make changes  before 
you finish working with the ChartWizard. When you create a chart, the worksheet data used to create  the  
chart is linked to the chart - this is called a "relational chart.î In a relational chart when your spreadsheet data  
is changed, your chart is updated to reflect those changes. The chart may be embedded Charts (on the same 
sheet with the data) or Chart Sheet (on a different worksheet). To create a chart with the ChartWizard, follow 

these  steps: Select the data  you  want  to  chartChartWizard button  or  F11  or InsertChart select chart 



 

 

typeselect chart sub-typeNextData Range Tab-Series In, checkmark ColumnsNext Titles tab, change 
to Chart Title, X Axis label, Y Axis label Legend Tab-check or uncheck Show Legendchange other Tabs 
conditions as requiredNextSelect place for the chart- As New Sheet or as Object inFinish. 

When you use F11, Excel applies the default chart format to the new chart. When you create a chart, values 
form worksheet cells called data points, create data markers that can be displayed as bars, columns, lines, pie 
slides, or other shapes. A data marker is a chart symbol that represents a single data points. All of the data 
points on the selected worksheets combined on the chart to create data series. These are displayed on  the  
chart as a group of data markers distinguished by the same colour or pattern. 

A sample of each seriesí marker colour and pattern is displayed in the legend along with the series name. the 
legend identifies the series on the chart so that you can compare the chart easily with the worksheet data. The 
value axis is the vertical axis or y-axis while the category axis is the  horizontal axis  or x-axis.  Category 
labels are plotted along the x-axis, and data markers for all series are grouped into these categories. Gridlines 
are lines drawn in the plot area typically for value axis to facilitate comparism of the data marker with the   
axis values. 

Linking chart titles to worksheet cells 

This enables the chart title to automatically update to reflect any changes made to those cells on the  
worksheet. Select the chart titletype = navigate to select the cellEnter. 

Changing the Chart Type 

Sometimes you want to change the chart type to better illustrate you data. 

Activate the chart by clicking on the chart imageChartChart TypeSelect the type of chart you  want  and 
the sub-type. You can also use the chart-type drop-down arrow to select new chart. 

Moving, Sizing and Formatting Chart items 

This provides extra emphasis or clarity and increases its overall effectiveness and appeal. You  can  move 
chart items by selecting them and dragging them with the mouse to the desired location. To select a sub-item 
e.g. a sector of a pre-chart, you first select the entire chart before selecting the item. You can enlarge the data 
marker area if the chart sheet by selecting the plot area and  dragging its borders to  the edges of the chart  
area. This is necessary when you want to add extra chart items or to increase the size of the items. 

To make your chart more attractive, you can format chart items e.g. add borders around the titles, legend, and 
the text boxes. You can change the colour thickness, and style of the border, and choose  the colour of the  
area within the border. In the format dialog box, you can change many chart features through the tabs. You 
can make these changes either by double-clicking the chart area or individual chart items or right-clicking on 
them to select format chart item or FormatSelectedÖ 

Adding items to a chart 

A simple chart cannot always convey information as clearly or completely as you would like. You can add 
information, increase visual interest, and enhance readability by adding elements such as data labels, titles, a 
legend, and gridlines. To add items, right click on the chartChart Options box will  appearmake  necessary 
changes. 

You can also format any chart in Excel by selecting the chart and double-clicking. Some of the formatting 
options available to you are the following: Changing the color, patterns, scale,  font,  alignment, options,  
series order, and data labels. 

Adding Data Series and Data Points 

Once you have created a chart, you sometimes need to update it by adding or deleting a data series. In some 
cases, you might want to change the range of worksheet data the chart is based on. For an embedded chart, 



 

 

select the data on the worksheet to be added and drag it onto the chart. For a chart sheet, right click on the 
chartsource dataseries TabAdd new seriesOk 

Deleting Data Series and other chart items 

You can delete a data series by selecting it on the chart and pressing the DEL key. You can also select it and 
then EditClearSeries or right click the chartsource dataseries Tab select the  seriesRemoveOk. 

Changing the Range of Data Plotted 

If you want a chart to display different data than was originally plotted, you can change the worksheet range 
for the chart. Select the chart on your worksheetright clicksource datadata Range Tabclick on the 
collapse buttonselect new rangeuncollapseOk. 

 

Types of Charts and their Uses 
 
 

Chart Use to 
 
Area 

Display the importance of values over time; emphasizes the amount of charge, rather than time 
or rate of exchange. 

 
Bar 

Display individual values for comparison. Categories are drawn from the vertical axis, and 
values are drawn from the horizontal axis. 

 
Column 

Display individual values for comparison. Categories are drawn from the horizontal axis, and 
values are drawn from the vertical axis. 

 
Line 

Show trends over time; emphasizes time flow and rate of charge, rather than the amount of 
charge. 

Pie Display one data series as a whole. Each of its parts represents a percentage of that whole. 

Radar Show changes or frequencies of data relative to a center point and to each other. 

XY(Scatter) Plot coordinate values; shows the relationship between numeric values in several data series. 
 
Bubble 

Plot coordinate values. The size of the data marker indicates the value of a third variable, 
similar to XY (Scatter) charts. 

 
3-D Area 

Show a three-dimensional view of an area chart. The data series are displayed separately, one  
in front of the other. 

3-D Line Show a three-dimensional view of a line chart. Lines are displayed as bands. 

 
3-D Surface 

Show what appears to be a sheet stretched over the category axis. This chart type is useful for 
finding the optimum combinations between two sets of data. It is similar to a topographic map; 
colour indicates areas that are at the same height (colour does not mark the data series). 

Doughnut Display more than one data series, similar to a pie chart. 

3-D Bar Show a three-dimensional view of a bar chart. 

3-D 
Column 

 
Show a three-dimensional view of a column chart. 

3-D Pie Show a three-dimensional view of a pie chart. 



 

 

 

3-D Cone, 
3-D 
Cylinder, 
and 3-D 
Pyramid 

 

 
Add a dramatic effect to 3-D column and bar charts. 

 
 

GOAL SEEK 

You can use Goal Seek if you want to produce a specific value in a specific cell by adjusting only one input 
cell. For example, the following calculator was created and formatted in Excel. Text was added to cells C5 
through C8. Values were added in cells D6 (48) and D7 (10% or 0.1). Finally the Payment Function  was 
added to cell D8. 

 
 

4 Column C Column D 

5 Loan Amount 0 

6 Terms (Months) 48 

7 Interest Rate 10% 

8 Payment =PMT(D7/12,D6,D5) 
 
 

This calculator can be used to determine the size of a loan that would be supported by a certain payment 
amount. For instance, if an individual was only able to afford a payment of $700 per month, Goal  Seek  
would calculate the loan amount that equates to the payment. 

To use Goal Seek: ToolsGoal SeekSet cell - cell containing the formula you want to force to a specific 
value e.g. (D8 in the above example), To value - enter the target amount (700), By changing cell - the cell 
address of the cell you want to change e.g. D5OK and Goal Seek will display a dialog box indicating that    a 
solution was foundOK. 

PIVOT TABLES AND CHARTS 

Create a PivotTable/ PivotChart 

You can use a PivotTable report to quickly summarize large amounts of data. A Pivot Chart allows 
you to view data graphically. It is an attractive worksheet table. 

The reports are interactive which means that you can rotate the data (rows and columns) to see different 
summaries of your data. You can filter the data by displaying different pages, or display the details for areas 
of interest. If you change anything in the PivotTable the PivotChart will reflect those changes. If you change 
anything in the PivotChart, the PivotTable will reflect those changes. 

In  order to create a PivotTable or PivotChart itís imperative that the source of the data be set up properly.   
The data that you use to create a pivot table is called the source data. This may come from Excelís data or 
from an external database file. 

The data needs to be arranged in rows and columns. The first row must contain Field Names. Each column 
must contain like data. All automatic totals must be removed prior to creating the PivotTable. 

You can create a PivotTable by itself or you can create a Pivot Chart with a PivotTable together. 

To create a PivotTable: DataPivotTable and Pivot Chart ReportChoose the data source and select the 



 

 

type of report you want to createNextIndicate the range of cells that contains the data you want to  analyze 
- Select the range of cellsNextIndicate where you want the PivotTable located (existing work sheet or new 
work sheet), and you are able to lay out the table. A basic grid for the pivot table is shown as 
well as the pivot table toolbar. On the toolbar, the field names from the list appear at the bottom of the  
toolbar. You drag the fields onto the various areas of the pivot table grid to create the pivot table. 

To specify what portions of the source data to use in the table, you choose fields and items. Fields are 
categories of data, and items are subcategories in a field. There are two types of fields viz: row/column/page 
fields and data fields. Row/column/page fields usually contain a limited set of text values while data fields 
contain numeric data used for summarizing. 

To lay out the table click on the Layout buttonIn the layout window, you will find your field names 
represented as buttons in the lower right corner of the window. In the center of the window you have 
PivotTable fields as follows: 

ï Page Field - This field allows you to select the data that is to appear in the PivotTable. 

ï Row Field - This field summarizes information across rows. 

ï Column Field - This field summarizes information across columns. 

ï Data Field - This is the central area in the PivotTable where the actual data will displayYou set up your 
PivotTable by moving (dragging and dropping) your Field Names into one of the PivotTable Field 
areasOnce the layout is complete-OKFinish. 

PivotTable Toolbar 

Once the PivotTable and PivotChart are built, the PivotTable toolbar is displayed. The buttons on the toolbar 
function as follows (from left to right): 
PivotTablePivot Chart: Use this button to access a menu of PivotTable and PivotChart commands 

Format Report: Clicking on this button will cause a display of preformatted reports to be displayed. Choose 
one of the options and the formatting of that option will be applied to your PivotTable. (Does not display  
when the PivotChart is selected.) 

Chart Wizard: Use this button to automatically create a PivotChart that is based on the current PivotTable. 
Row Fields in the PivotTable become Category Fields in the PivotChart and Column Fields in the PivotTable 
become Series Fields in the PivotChart. The PivotChart will be placed in a new worksheet. 

PivotTable Wizard: You can use the wizard not only to create new PivotTables, but it can be used to edit 
existing PivotTables. (Does not display when the PivotChart is selected.) 

Hide Detail: Use this to hide a selected PivotTable fieldís data. (Does not display when the PivotChart is 
selected.) 

Show Detail: Use this to show hidden PivotTable data. (Does not display when the PivotChart is selected.) 

Refresh Data: If data has been added, deleted or modified in your data source, click on this button to have the 
PivotTable display the current data. 

Field Settings: Clicking the Field Settings button causes the PivotTable Field dialog box to display. You can 
choose different ways to summarize the data in the PivotTable. (Does not display when the PivotChart is 
selected.) 

Hide Fields/Display Fields: Hides or displays the data fields on the bottom of the PivotTable toolbar. (Does 
not display when the PivotChart is selected.) 



 

 

Using the PivotTable 

Picking Options 

You can analyze data a variety of ways. You can pick and choose among all the options that are available to 
you and you can reorganize the table. 

The following examples are from the PivotTable, but the PivotChart works the same way. 

You can click on the small arrow to the right of ì(All)î (below) and you can pick a specific year or years to 
analyze. 

You can click on the small arrow to the right of Salesperson (below) and you can pick a specific salesperson 
or salespersons to analyze. 

You can click on the small arrow to the right of Make (below) and you can pick a specific Make or several 
Makes to analyze. 

Reorganizing Tables and Charts 

You can change the way the data is analyzed by adding and deleting fields, and you can physically move 
fields from rows to columns or from columns to rows. 

Add a Field 

To add a field, ensure that the PivotTable Toolbar is showing. If it isnít showing, click on View on the Menu 
Bar, choose Toolbars and then click on PivotTable. 

Click anywhere in the PivotTable and the toolbar will display all the fields of data in the data file. Click and 
drag the desired field from the toolbar to the desired location in the PivotTable. 

Delete a Field 

To delete a field from the PivotTable, simply drag the field button off of the PivotTable. 

Moving Fields 

Fields can be move into and out of Row Fields, Column Fields and the Page Field area. To move a field, 
simply drag the field button to the desired location in the PivotTable. 

Refreshing a Table 

If you add or delete data from the data source, you will need to refresh the PivotTable  in order to  view 
current data. To refresh the PivotTable click on the red exclamation point button on the PivotTable toolbar. 

SOME ADVANCE FEATURES 

Creating and using style 
A combination of formats for a cell is called a style. To format a cell, select the cells, choose FormatStyle. 
The style dialog box is displayed and shows the six formatting attributes. By default, all cells in all  
worksheets use the Normal style. 

To modify a style: Select the style nameclick the modify buttonuse the tabs to define the styles you 
wantOKOK. 
To create new style: Type new nameclick Add buttonsclick modify button to define the style you 
wantOKOK. 

Cell Names 

A name is a description that you assign to a group of cells as an alternative to its cell reference. You can use 
the names to make your formula more powerful and flexible. Even, using a named range simplifies a 



 

 

formula. The guidelines for naming are: 

1) The first character must be text or an underscore character, the remaining character can be text, numbers, 
periods and the underscore character. Names can be of up to 225 characters. 

2) A name cannot contain spaces. 

3) The name can be of any case; Excel is not case sensitive. 

To name cell(s), you select the cell(s) and then either type the new name in the name box and press Enter or 
InsertNameDefine (this displays the Define Name dialog box). The Define  Name dialog box enables  you 
to define new names and to see names that are already assigned. 

You can also use InsertNameCreate (displays the Create Name dialog box) select the section of the range 
where Excel will assume as the label for the data from the corresponding row/columnOK. This uses the 
names in the specified row/column as the column/row name. 

Use InsertNameApply (displays the Apply Name dialog box) to formula that has already been created. 

The If and VLOOKUP Functions 

The If function is used to create a formula that returns different results under different conditions, the 
VLOOKUP function is used to  create a formula that picks a return  value from a range of values depending  
on an input value. 

The VLOOKUP function finds and returns a value located in a certain row and column of a looking table, as 
long as the table contains an orderly arrangement of information, the syntax is: VLOOKUP (looking_value, 
table_array, col_index_num, range_lookup) 

lookup_ value is the value that will be looked for in the first column of the looking table. It can be a value, 
reference, or text string. 

Table_array is a reference to (or name of a reference to) the looking table. 

Col_index_num is the column number in the looking table from which a value should be returned. 

Range_lookup is an optional argument that specifies whether you require an exact match or an approximate 
match. 

The advantage of using the VLOOKUP function comes when you delete, add, or change the information 
within the looking table. You won't need to change the formula because they will be managed automatically. 

Comments 

A comment is a textbox that contains information about a worksheet cell. Comment indicators are displayed 
automatically for cells that have comments attached; this indicator is a small triangle in the  upper-right  
corner of the cell they do not print when you print a worksheet (the smart tag). 

To add comment: select the cell(s) right-clickInsert comment or Insertcomments. The comment features 
can be changed from the view tabs of the options dialog box. 

You can delete a comment either by right-click in the cell to remove it or use the comment toolbar. 

Custom views 

This enables you to create a preserved set of worksheet display and print options. To  add  custom view or 
view them, ViewCustom viewAddType the view nameOK. 

The custom views dialog box has four buttons: show, close, Add, Delete. 

You can also use Excel outlining feature to create useful views, DataGroup and outlineAuto outline. 



 

 

Running and Recording Macros 

A macro is a group of user-created instructions that automates one or more operations, this may be used to 
open an existing file, customize your worksheet so that repeated actions can be done by excel. 

Viewing and Editing VBA Code 

The term VBA refers to Visual Basic for Applications. When you create macros, they are stored as program 
modules in VBA. To view  the  UBA program  behind a macro, ToolsMacroMacrosÖselect the name of 
the macroEdit. 

In the Visual Basic Editor's Main Module window, the sub-procedure for the macro will open. In VBA, all 
executables code must be contained in a procedure, and procedures are contained in modules that can contain 
many procedures. A procedure begins with the keyword sub and ends with the keywords End sub. You can 
alter the assignment in one procedure, and run the macro to determine the effect. 

Saving Excel worksheets as web Documents 

You can save ranges within a worksheet, or even an entire workbook, as a web document. You can then view 
the web document in a browser. To view how the page will be displayed on the web: Fileweb page  preview. 
You can't change the documents on the web. By default, Excel does not save worksheets with 
interactivity. Adding interactivity to an Excel web document enables those viewing it to manipulate the data   
it contains. To save an interactivity web document, you must first select the range of cells you want to save. 

Filesave as web pagethe save as web page dialog box has many save options; Select either entire workbook 
or selection using the radio buttonsChange title of the web page using the change title button. 

To add interactivity: check Add interactivity button, this enables you to save the data on the page. 

To publish: click on the publish button. 

Spreadsheet web components 

An interactive web document created with spreadsheet web components contains many of the same analysis 
tools found in Excel. When you save a worksheet with interactivity, spreadsheet toolbar will be displayed 
above the interactive worksheet. The toolbar contains all the spreadsheet web components, the components 
can be used as if you are in Excel spreadsheet. All the changes made to the web  document are not saved  
when you quit the web page, i.e. the original web component is intact. To make permanent  change, you  
would have to modify the Excel workbook file and re-publish the web document. 
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"We are all now connected by
the Internet, like neurons in a

giant brain."
Stephen Hawking



WHAT IS THE
INTERNET?
The Internet is  a global  network of  bi l l ions of

computers and other electronic devices.  With

the Internet,  i t 's  possible to access almost

any information,  communicate with anyone

else in the world,  and do much more.

You can do al l  of  this by connecting a

computer to the Internet,  which is also cal led

going onl ine .  When someone says a computer

is onl ine,  i t 's  just  another way of saying it 's

connected to the Internet.



HOW DOES THE INTERNET
WORK?

At this point you may be wondering, how does the Internet work? The exact answer is pretty complicated and
would take a while to explain. Instead, let's look at some of the most important things you should know.

It's important to realize that the Internet is a global network of physical cables, which can include copper
telephone wires, TV cables, and fiber optic cables. Even wireless connections like Wi-Fi and 3G/4G rely on

these physical cables to access the Internet.

When you visit a website, your computer sends a request over these wires to a server. A server is where
websites are stored. Once the request arrives, the server retrieves the website and sends the correct data

back to your computer. What's amazing is that this all happens in just a few seconds!

Click the computer above to watch a short movie
by Tata Communications

https://www.youtube.com
/watch?v=jKA5hz3dV-g

https://www.youtube.com/watch?v=jKA5hz3dV-g


HOW DO YOU CONNECT TO THE
INTERNET?

Once you've set up your computer, you may want to purchase home Internet access so you can send and
receive email, browse the Web, stream videos, and more. You may even want to set up a home wireless

network, commonly known as Wi-Fi, so you can connect multiple devices to the Internet at the same time.

Types of Internet Service
DIAL UP: This is generally the slowest type of Internet
connection, and you should probably avoid it unless it is
the only service available in your area. Dial-up Internet
uses your phone line, so unless you have multiple phone
lines you won't be able to use your landline and the
Internet at the same time.

DSL: DSL service uses a broadband connection, which
makes it much faster than dial-up. DSL connects to the
Internet via a phone line but does not require you to have
a landline at home. And unlike dial-up, you'll be able to
use the Internet and your phone line at the same time.

Cable: Cable service connects to the Internet via cable
TV, although you do not necessarily need to have cable
TV in order to get it. It uses a broadband connection and
can be faster than both dial-up and DSL service;
however, it is only available where cable TV is available.

Satellite: A satellite connection uses broadband but
does not require cable or phone lines; it connects to the
Internet through satellites orbiting the Earth. As a
result, it can be used almost anywhere in the world, but
the connection may be affected by weather patterns.
Satellite connections are also usually slower than DSL
or cable.

3G and 4G: 3G and 4G service is most commonly used with mobile phones, and it
connects wirelessly through your ISP's network. However, these types of connections
aren't always as fast as DSL or cable. They will also limit the amount of data you can use
each month, which isn't the case with most broadband plans.



WHAT CAN YOU DO
ON THE INTERNET?

One of the best features of the Internet is the ability to

communicate almost instantly with anyone in the world. Email

is one of the oldest and most universal ways to communicate

and share information on the Internet, and billions of people

use it.

Short for electronic mail, email is a way to send and receive

messages across the Internet. Almost everyone who uses the

Internet has their own email account, usually called an email

address. This is because you'll need an email address to do

just about anything online, from online banking to creating a

Facebook account.



SOCIAL MEDIA & NETWORKING
Social  networking websites are another way to connect and share with your family and
fr iends onl ine.  Rather than sharing with just  a few people over email ,  social  networks
make it  easier  to connect and share with many people at  the same t ime.  Facebook is
the world 's largest social  networking site ,  with more than 1 bi l l ion users worldwide.

Social  media can be used for  many things:  staying in touch with fr iends and family ,
promoting your cause,  and keeping up with trending topics and news.

skype

pinterest

twitter

linked in

snapchat

instagram

facebook



There are many sites that allow you to watch videos and listen

to music. For example, you can watch millions of videos on

YouTube or listen to Internet radio on Pandora. Other services,

like Netflix and Hulu, allow you to watch movies and TV shows.

ONLINE MEDIA

EVERY DAY TASKS
You can also use the Internet to complete many everyday

tasks and errands. For example, you can manage your bank

account, pay your bills, and shop for just about anything. The

main advantage here is convenience. Rather than going from

place to place, you can do all of these tasks at home!

FINDING INFORMATION
With billions of websites online today, there is a lot of

information on the Internet. Search engines make this

information easier to find. All you have to do is type one or more

keywords, and the search engine will look for relevant websites.

There are many different search engines you can use, but some

of the most popular include Google, Yahoo!, and Bing.

http://www.bing.com/
http://www.hulu.com/
http://www.hulu.com/


WHAT IS THE WEB?
The World Wide Web—usual ly cal led the Web for  short—is a col lect ion of  different

websites you can access through the Internet.  A website is  made up of  text ,  images,
and other resources.  Websites can look l ike other forms of media—like newspaper

art icles or  television programs—or they can be interactive in a way that 's  unique to
computers.

The purpose of a website can be almost anything :  a  news platform, an advert isement ,
an onl ine l ibrary ,  a forum for  sharing recipes,  or  an educational  site.

Once you are connected to the Internet ,  you can access and view websites using a type
of appl ication cal led a web browser .  Just keep in mind that the web browser i tself  is

not the Internet;  i t  only displays websites that are stored on the Internet.



USING A WEB BROWSER
A web browser is a type of software that allows you to find and view websites on the

Internet. There are many different web browsers, but some of the most common ones

include Google Chrome, Internet Explorer, Safari, and Mozilla Firefox.

No matter which web browser you use, you'll want to learn the basics of browsing the

Web. In this lesson, we'll talk about navigating to different websites, using tabbed

browsing, creating bookmarks, and more.

URL   AND THE ADDRESS BARs
Each website has a unique address, called a URL (short for Uniform Resource Locator). It's like a street

address that tells your browser where to go on the Internet. When you type a URL into the browser's

address bar and press Enter on your keyboard, the browser will load the page associated with that URL.

In the example below, we've typed www.bbc.com/travel into the address bar.

http://www.bing.com/
http://www.bing.com/


LINKS
Whenever you see a word or phrase on a website that's blue or underlined in blue, it's

probably a hyperlink, or link for short. You might already know how links work, even if

you've never thought about them much before.

Links are used to navigate the Web. When you click a link, it will usually take you to a

different webpage. You may also notice that your cursor changes into a hand icon

whenever you hover over a link.

This turns into that!

If you see this icon, it means you've found a link. You'll find other types of links this way

too. For example, many websites actually use images as links, so you can just click the

image to navigate to another page.

By clicking here...

...you will come here!

http://www.bing.com/
http://www.bing.com/
http://www.bing.com/
http://www.bing.com/


NAVIGATION BUTTONS
The Back and Forward buttons allow you to move through websites you've recently

viewed. You can also click and hold either button to see your recent history.

The Refresh button will reload the current page. If a website stops working, try using the

Refresh button.

http://www.bing.com/
http://www.bing.com/


TABBED BROWSING
Many browsers allow you to open links in a new tab. You can open as many links as you want, and they'll stay in the

same browser window instead of cluttering your screen with multiple windows.

To open a link in a new tab, right-click the link and select Open link in new tab (the exact wording may vary from

browser to browser).

To close a tab, click the "x". To create a new blank tab, click the button to the right.

http://www.bing.com/


BOOKMARKS
If you find a website you want to view later, it can be hard to memorize the exact web address. Bookmarks, also

known as favorites, are a great way to save and organize specific websites so you can revisit them again and again.

Simply locate and select the Star icon to bookmark the current website.

Bookmarks saved to the "Bookmarks Bar" will

show up here, under the Address Bar.

http://www.bing.com/
http://www.bing.com/


USING SEARCH ENGINES
With billions of websites online today, there is a lot of information on the Internet. Search engines make this

information easier to find. Let's look at the basics of using a search engine, as well as some techniques you can use

to get better search results.

Click on the TV above to watch a short movie

about search engines by GCF Learnfree.

http://www.bing.com/
https://youtu.be/7RlB1CJovTs?t=20s
http://www.bing.com/


HOW TO SEARCH THE INTERNET
There are many different search engines you can use, but some of the most popular include Google,

Yahoo!, and Bing. To perform a search, you'll need to navigate to a search engine in your web browser,
type one or more keywords—also known as search terms—then press Enter on your keyboard. In this

example, we'll search for recipes.

Keywords go here!

This is called a "search bar."

First, go to the website.
In this example, we'll

use Google.

http://www.bing.com/


After you run a search, you'll see a list of relevant websites that match your search terms. These are
commonly known as search results. If you see a site that looks interesting, you can click a link to open it.
If the site doesn't have what you need, you can simply return to the results page to look for more options.

http://www.bing.com/


If you don't find what you're looking for on the first try, don't worry! Search engines are good at finding
things online, but they're not perfect. You'll often need to try different search terms to find what you're

looking for.

If you're having trouble thinking of new search terms, you can use search suggestions instead. These will
usually appear as you're typing, and they're a great way to find new keywords you might not have tried

otherwise. To use a search suggestion, you can click it with your mouse, or select it with the arrow keys
on your keyboard.

SEARCH RESULTS

http://www.bing.com/


There may be times when you're looking for something more specific, like a news article, picture, or video.
Most search engines have links at the top of the page that allow you to perform these unique searches.

CONTENT-SPECIFIC SEARCHING

In the example below, we've used the same search terms to look for images instead of websites. If you
see an image you like, you can click to visit the website it originally came from.

http://www.bing.com/
http://www.bing.com/


You can use the extra search tools to narrow down your results even more. These tools will
change based on the type of content you're looking for, but in this example we can filter our

images by size, color, image type, and more. So if you wanted to find cookies with pink
frosting, you could search for images that are mostly pink.

http://www.bing.com/


One final thing to note: Most search engines include advertisements with search results. For example,
you can see advertisements at the top of the search results below.

ADVERTISEMENTS

These ads are based on your search terms, and they often look similar to other search results. While they
may be useful in some cases, it's usually more helpful to focus on the actual search results.

http://www.bing.com/
http://www.bing.com/


One final thing to note: Most search engines include advertisements with search results. For example,
you can see advertisements at the top of the search results below.

ADVERTISEMENTS

These ads are based on your search terms, and they often look similar to other search results. While they
may be useful in some cases, it's usually more helpful to focus on the actual search results.

http://www.bing.com/
http://www.bing.com/


Let's say you've found a webpage that might have what you're looking for. Should you just start reading
the entire page until you find it? Well, no. Most of the time, you don't need to read the page from top to

bottom. Instead, you should look for the most relevant parts of the webpage and ignore everything else.
In this lesson, we'll show you some of the common parts of a webpage, as well as some tips for reading

webpages more effectively.

HOW TO READ A WEBPAGE

Every webpage is different, but there are some common elements you'll find on most pages. For example,
the page might have the main content in the middle of the page, with ads on the left or right side. Almost

every webpage will have some sort of navigation bar that lets you go to other parts of the website. By
learning about some of these basic parts, you'll be able to find the information you're looking for more

quickly.

THE ANATOMY OF A WEBPAGE

http://www.bing.com/
http://www.bing.com/


Click the image below to be taken to in interactive website created by GCFlearnfree.org

HOW TO READ A WEBPAGE

http://www.gcflearnfree.org/
http://www.gcflearnfree.org/searchbetter/how-to-read-a-webpage/1/


Technology 1-on-1

Wordpress

Microsoft Basics

Email Basics

Are you intimidated by the prospect of
using electronic mail (email)? Come

learn what this tool has to offer and how
to utilize it to suit your needs. We will

help you to: create a free email account,
navigate your inbox easily, and
safeguard your account against

malicious hacking. Registration is
required and begins February 1st, 2017.
Call the Reference Department at (978)

744-0860 to reserve your session.

Learn Microsoft 2016 basics for
composing letters, academic papers,
and résumés. This open workshop is
designed for people who are novice-

to-intermediate computer users,
though all are welcome. Workshop

will include a mirror screen
demonstration and Q&A time; all
attendees may take home a free

instructional docket. No registration
is required.

Want to build a website? Interested
in blogging? Try Wordpress! Using
Wordpress, you can build websites

and blogs for personal and/or
professional use. This program

includes four cumulative sessions
that walk you through the entire

process of creating and customizing
a website. No experience is needed

and no registration is required.

Having trouble keeping up with new
technology? Half-hour one-on-one

Technology Help Sessions are being
offered at the Salem Public Library!
Need help with the new line spacing
in Microsoft Word? Want assistance
posting an online ad? Want to learn

how to download eBooks and audio-
books? We are here to help!

 Registration is required and begins
on February 1st, 2017. Call the
Reference Department at (978)

744-0860 to reserve your session.



THANK YOU FOR
COMING!

PLEASE FEEL FREE TO FILL OUT AN OPTIONAL SURVEY
AND PLEASE LEAVE YOUR EMAIL ADDRESS IF YOU'D LIKE A COPY OF
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E-commerce   Note  

By DILLIP RANJAN NAYAK 

Basics of E-commerce: 
 

Business:-A business is an organization engaged in the trade of goods, services, or both to consumers. 
Commerce: - The buying and selling of products and services between firms, usually in different status or 
countries. 

 

E-commerce: - E-commerce means buying and selling of products or services over electronic systems such as 
the internet and other computer networks. Electronic commerce draws on technologies such as mobile 
commerce, electronic funds transfer, supply chain management, Internet marketing, online transaction 
processing, Electronic Data Interchange (EDI), inventory management systems, and automated data 
collection systems. 

E-commerce businesses employ the following: 

 Online shopping web sites for retail sales direct to consumers 
 Providing or participating in online marketplaces, which process third-party business-to-consumer or 

consumer-to-consumer sales 

 Business-to-business buying and selling 

 Gathering and using demographic data through web contacts and social media 

 Business-to-Business (B2B) electronic data interchange 

 Marketing to prospective and established customers by e-mail or fax (for example, with newsletters) 
 Online financial exchanges for currency exchanges or trading purposes 

Basic Elements of e-commerce: 
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E-commerce framework 

 

 

 

 



 
 

Conceptual  framework 
 

Here are seven important infrastructure decisions that E -commerce businesses face. 

1. Marketing 

2. Facilities 

3. Customer Service 

4. Information Technology 

5. Fulfillment 

6. Finance and Administration 

7. Human Resource 

 
Difference between E-business and E-commerce:- 
 

In both the cases, E stands for “Electronic networks “ and describes the applications of Electronic network 
technology – including internet and electronic data interchange (EDI) – to improve and change business process . 
E-commerce covers outward - facing processes that touch customers, suppliers and external partners, including 
sales, marketing, order taking, delivery, customer service, purchasing of raw materials.  
E-business includes E-commerce but also covers internal process such as production, inventory management, 
products development, finance, human resources, E-business strategy is more complex, productivity and cost 
savings. 

Ex:-E-bay, Amazon.  
 



          
 

Activities of E-commerce 
a)          Increasing the speed of service delivery. 
b)          Use of computer networks to search and retrieve information fo r  human  
c)          Buying and selling of information, products and services via computer network.  
d)          Faster customer response and improve services quality . 
e)          Advertising on the internet. 
f)           Online electronic commerce payments just like electronic funds transfer. 

 

Benefits of E-commerce 
a.           The global nature of the technology. 
b.          Low cost. 
c.          Opportunity to reach hundreds of millions of people. 
d.          Interactive nature. 
e.           Variety of possibilities. 
f.          Rapid growth of the supporting infrastructures. 

 

 E-commerce benefits are classified into 3 types. 
          1. Benefits to organization. 
          2 .  Benefits to consumers. 
       3 .  Benefits to society. 

Technical Infrastructure  
  
Internet connectivity 
 The Internet's growth has become explosive and it seems impossible to escape the bombardment of www.com's seen 
constantly on television, heard on radio, and seen in magazines. Because the Internet has become such a large part of 
our lives, a good understanding is needed to use this new tool most effectively.  Internet is network of network means 
a global network of computers. Each computer connected to the Internet must have a unique address. Internet 
addresses are in the form of nnn.nnn.nnn.nnn (where nnn must be a number from 0 – 255). This address is known 
as an IP address. (IP stands for Internet Protocol; more on this later.) 

The picture below illustrates two computers connected to the Internet; your computer with IP address 1.2.3.4 and 
another computer with IP address 5.6.7.8. The Internet is represented as an abstract object in-between. (As this paper 
progresses, the Internet portion of Diagram 1 will be explained and redrawn several times as the details of the 
Internet are exposed.) 

 

Diagram 1 

 
If you connect to the Internet through an Internet Service Provider (ISP), you are usually assigned a temporary IP 
address for the duration of your dial-in session. If you connect to the Internet from a local area network (LAN) your 
computer might have a permanent IP address or it might obtain a temporary one from a DHCP (Dynamic Host 



Configuration Protocol) server. In any case, if you are connected to the Internet, your computer has a unique IP 
address.                                                  Diagram-2  

Protocol Stacks and Packets 

 Every computer needs one to communicate on the Internet and it is usually built into the computer's operating 
system (i.e. Windows, Unix, etc.). The protocol stack used on the Internet is referred to as the TCP/IP protocol stack 
because two major communication protocols are used. The TCP/IP stack looks like this:  
 

Protocol Layer Comments 

Application Protocol Layer Protocols specific to applications such as WWW, e-mail, FTP, etc. 

Transfer Control Protocol 
Layer 

TCP directs packets to a specific application on a computer using a port 
number. 

Internet Protocol Layer IP directs packets to a specific computer using  IP address. 

Hardware Layer/Physical 
Layer 

Converts binary packet data to network signals and back. 
(E.g. Ethernet network card, modem for phone lines, etc.) 

 
 
 

 

 

 



Diagram 3 

Networking Infrastructure 

 
 
Here we see Diagram 1 is redrawn with more details. The physical connection through the phone network to the 
Internet Service Provider might have been easy to guess, but beyond that might bear some explanation. 

The ISP maintains a pool of modems for their dial-in customers. This is managed by some form of computer (usually 
a dedicated one) which controls data flow from the modem pool to a backbone or dedicated line router. This setup 
may be referred to as a port server, as it 'serves' access to the network. Billing and usage information is usually 
collected here as well. 

After your packets traverse the phone network and your ISP's local equipment, they are routed onto the ISP's 
backbone or a backbone the ISP buys bandwidth from. From here the packets will usually journey through several 
routers and over several backbones, dedicated lines, and other networks until they find their destination, the computer 
with address 5.6.7.8.  

 
Internet Infrastructure 

The Internet backbone is made up of many large networks which interconnect with each other. These large networks 
are known as Network Service Providers or NSPs. Some of the large NSPs are UUNet, IBM, BBN Planet, 
SprintNet, PSINet, as well as others. These networks peer with each other to exchange packet traffic. Each NSP is 
required to connect to three Network Access Points or NAPs. At the NAPs, packet traffic may jump from one NSP's 
backbone to another NSP's backbone. NSPs also interconnect at Metropolitan Area Exchanges or MAEs. MAEs 
serve the same purpose as the NAPs but are privately owned. NAPs were the original Internet interconnect points. 
Both NAPs and MAEs are referred to as Internet Exchange Points or IXs. NSPs also sell bandwidth to smaller 
networks, such as ISPs and smaller bandwidth providers. Below is a picture showing this hierarchical infrastructure.  

 

 
 

Diagram 4 



 

 

Diagram 5 

 

Application Protocols: HTTP and the World Wide Web 

One of the most commonly used services on the Internet is the World Wide Web (WWW). The application protocol 
that makes the web work is Hypertext Transfer Protocol or HTTP. HTTP is the protocol that web browsers and 
web servers use to communicate with each other over the Internet. It is an application level protocol because it lies on 
top of the TCP layer in the protocol stack and is used by specific applications to talk to one another. In this case the 
applications are web browsers and web servers. 

HTTP is a connectionless text based protocol. Clients (web browsers) send requests to web servers for web elements 
such as web pages and images. After the request is serviced by a server, the connection between client and server 
across the Internet is disconnected. A new connection must be made for each request. Most protocols are connection 
oriented. This means that the two computers communicating with each other keep the connection open over the 
Internet. HTTP does not however apply this. Before an HTTP request can be made by a client, a new connection 
must be made to the server. 

When you type a URL into a web browser, this is what happens: 

1. If the URL contains a domain name, the browser first connects to a domain name server and retrieves the 
corresponding IP address for the web server. 

2. The web browser connects to the web server and sends an HTTP request (via the protocol stack) for the 
desired web page. 

3. The web server receives the request and checks for the desired page. If the page exists, the web server sends 
it. If the server cannot find the requested page, it will send an HTTP 404 error message. (404 means 'Page Not 
Found' as anyone who has surfed the web probably knows.) 

4. The web browser receives the page back and the connection is closed. 
5. The browser then parses through the page and looks for other page elements it needs to complete the web 

page. These usually include images, applets, etc. 
6. For each element needed, the browser makes additional connections and HTTP requests to the server for each 

element. 



E-commerce software 
E-commerce software is the engine behind the scenes of an online store, making it possible to easily manage 
inventory, add or remove products, calculate taxes, and everything else required to manage a website and fulfill 
orders. 
E-commerce software simplifies intricate processes in a friendly user interface that enables people of non-
technical backgrounds to oversee an entire ecommerce operation. Despite the ease of use that e-commerce 

7. When the browser has finished loading all images, applets, etc. the page will be completely loaded in the 
browser window. 

 
  Application Protocols: SMTP and Electronic Mail 
Another commonly used Internet service is electronic mail. E-mail uses an application level protocol called Simple 
Mail Transfer Protocol or SMTP. SMTP is also a text based protocol, but unlike HTTP, SMTP is connection 
oriented. SMTP is also more complicated than HTTP. There are many more commands and considerations in SMTP 
than there are in HTTP. 
 
      Transfer Control Protocol 
Under the application layer in the protocol stack is the TCP layer. When applications open a connection to another 
computer on the Internet, the messages they send (using a specific application layer protocol) get passed down the 
stack to the TCP layer. TCP is responsible for routing application protocols to the correct application on the 
destination computer. To accomplish this, port numbers are used. Ports can be thought of as separate channels on 
each computer. For example, you can surf the web while reading e-mail. This is because these two applications (the 
web browser and the mail client) used different port numbers. When a packet arrives at a computer and makes its 
way up the protocol stack, the TCP layer decides which application receives the packet based on a port number. 

TCP works like this: 

 When the TCP layer receives the application layer protocol data from above, it segments it into manageable 
'chunks' and then adds a TCP header with specific TCP information to each 'chunk'. The information 
contained in the TCP header includes the port number of the application the data needs to be sent to. 

 When the TCP layer receives a packet from the IP layer below it, the TCP layer strips the TCP header data 
from the packet, does some data reconstruction if necessary, and then sends the data to the correct application 
using the port number taken from the TCP header. 

This is how TCP routes the data moving through the protocol stack to the correct application. 

TCP is not a textual protocol. TCP is a connection-oriented, reliable, byte stream service. Connection-oriented 
means that two applications using TCP must first establish a connection before exchanging data. TCP is reliable 
because for each packet received, an acknowledgement is sent to the sender to confirm the delivery. TCP also 
includes a checksum in it's header for error-checking the received data. The TCP header looks like this:  

Internet Protocol 

Unlike TCP, IP is an unreliable, connectionless protocol. IP doesn't care whether a packet gets to it's destination or not. Nor 
does IP know about connections and port numbers. IP's job is to send and route packets to other computers. IP packets are 
independent entities and may arrive out of order or not at all. It is TCP's job to make sure packets arrive and are in the correct 
order. About the only thing IP has in common with TCP is the way it receives data and adds it's own IP header information to 
the TCP data.  
 
 

 
 



software brings to an online business, it is a multifaceted and complex machine. The purpose of e-commerce 
software is to put everything you need to run your store in one place 
 E-COMMERCE SECURITY 
E-commerce security is the protection of e-commerce assets from unauthorized access, use, alteration, or 
destruction.  
  
Six dimensions of e-commerce security 
  
1.     Integrity: prevention against unauthorized data modification 
2.     No repudiation: prevention against any one party from reneging on an agreement after the fact 
3.     Authenticity: authentication of data source 
4.     Confidentiality: protection against unauthorized data disclosure 
5.     Privacy: provision of data control and disclosure 
6.     Availability: prevention against data delays or removal 
 

THREATS 
1.   Intellectual property threats -- use existing materials found on the Internet without the owner's permission, 

e.g., music downloading, domain name (cyber squatting), software pirating  
2.  Client computer threats 

–      Trojan horse 
–      Active contents 
–      Viruses  

3.  Communication channel threats 
–      Sniffer program 
–      Backdoor 
–      Spoofing 
–      Denial-of-service  

4.  Server threats 
–      Privilege setting 
–      Server Side Include (SSI), Common Gateway Interface (CGI) 
–      File transfer 
–      Spamming  

  
A procedure that recognizes, reduces, or eliminates a threat 
 
1.  Intellectual property protection 

–      Legislature 
–      Authentication 

2.  Client computer protection 
–      Privacy -- Cookie blockers;   
–      Digital certificate (Figure 5.9) 
–      Browser protection 
–      Antivirus software 
–      Computer forensics expert 

3.  Communication channel protection 
–      Encryption 

       Public-key encryption (asymmetric) vs Private-key encryption (symmetric) (Figure 5-6) 
       Encryption standard: Data Encryption Standard (DES), Advanced Encryption Standard (AES) 

–            Digital signature  
Bind the message originator with the exact contents of the message 
–A hash function is used to transform messages into a 128-bit digest (message digest). 
–The sender’s private key is used to encrypt the message digest (digital signature) 

http://www.cybercrime.gov/ip.html
http://www.digimarc.com/products
http://www.junkbuster.com/
http://www.surveil.com/rates.htm


–The message + signature are sent to the receiver 
–The recipient uses the hash function to recalculate the message digest 
–The sender’s public key is used to decrypt the message digest 
–Check to see if the recalculated message digest = decrypted message digest 

4.  Server protection 
      Access control and authentication 

       Digital signature from user 
       Username and password 

       Access control list  
 

The benefits of Ecommerce: 
Benefits to organizations 
1. E-commerce expands the market place to national and international level. 
2.  E-commerce  decreases  the  cost  of  creating,  processing,  distributing,  storing,  and   retrieving  paper based 
information. 
3.  Ability for creation highly specialized business. 
4.  E-commerce reduces the time between the outlay of capital and the receipt of products and services. 
5.  E-commerce initiates business processes reengineering projects. 
 
 
 
Benefits to consumers: 
 
The following are the benefits of E-commerce to consumer 
1. E-commerce enables customer to shop  transactions 24hrs a day, all year round from any location. 
2.  E-commerce provides customers with more choices they can select from many vendors and from many 
products. 
3. Products E-commerce allows quick delivery. 
4. Customer can retrieve relevant and detailed information in seconds, rather than days or weeks . 
5.  E-Commerce facilitates competition, which results in substantial discounts 
 
 
 
Benefits to society: 
 
The following are the benefits of E-Commerce to society: 
 
1.E-Commerce enables more individuals to work at home and to do less travelling for shopping resulting in less 
traffic on the roads and lower air pollution. 

2. E-Commerce enables people in rural areas to enjoy products and services that are not available to them.  This 
includes opportunities to learn professions and earn college degrees. 
3.  E-Commerce  facilitates  delivery  of  public  services  such  as  health  care  education  and distribution of 
Government social services at a reduced cost and or improved quality. 
 
 
Limitations of E-Commerce 
 
The limitations of E-Commerce can be categorized into 
 1)  Technical 
 2)  Non-Technical 
 
Technical limitations of E-Commerce are: 



1.   There  is  a  lack  of  system  security,  reliability,  standards  and  some  communication protocols. 
2.  There is insufficient telecommunication band width. 
3.  Soft ware development tools are changing rapidly. 
4.  It is difficult to integrate the internet and soft ware with some existing application data basis. 
 
Non-Technical limitations are: 
1.   COST AND JUSTIFICATION: - The cost of developing E-Commerce in house is very costly and made 
mistakes due to lack of experience may result in delays. 
2.  SECURITY AND PRIVACY: - these issues are especially important in the B2C area, especially security issues 
which are privacy measures are constantly improved.EC Industry has a very long and difficult task of convincing 
customers that online transactions are secure and they will keep. 
3.  LACK OF TRUST AND USER RESISTANCE: - Customers do not trust on unknown faceless sellers, 
paperless transactions and electronic money. 
 
 
E-COMMERCE APPLICATIONS: 
 
1)E-MARKETING : E-Marketing also known as Internet marketing,  Online marketing, Web marketing.  It is the 
marketing of products or services over the internet. It is consider to be broad in scope because not refers to 
marketing on the internet but also done in Email and wireless media. E-Marketing ties together the creative and 
technical aspects of the internet, including design development, advertising and sales. Internet marketing is 
associated with several business models ie., B2C, B2B, C2C. Internet marketing is inexpensive when examine 
the ratio of cost to the reach of the target. 
 
 
2)E-ADVERTISING:  It is also known as online advertising it is a form of promotion that uses internet and world 
wide web to deliver marketing messages to attracts customers. Example: Banner ads, Social network advertising, 
online classified advertising etc.The growth of these particular media attracts the attention of advertisers as a 
more productive source to bring in consumers. An online advertisement also offers various forms of animation. 
The  term  online  advertisement  comprises  all  sorts  of  banner  advertisement,  email advertising, in game 
advertising and key soon. 
 
3) E-BANKING OR INTERNET BANKING: Means any user with a personal computer and browser can get 
connected to his banks, website to perform any of the banking functions.  In internet banking system the bank has 
a centralized data base i.e., web-enabled. example for E-Banking is ATM. 
 
SERVICES THROUGH E-BANKING: 
 
•   Bill payment service. 
•   Fund Transfer 
•   Investing through internet Banking 
•   Shopping 
 
4) MOBILE-COMMERCE: Mobile Commerce also known as M-Commerce, is the ability to conduct, commerce 
as a mobile device, such as mobile phone. 
 
SERVICES ARE: 
1. Mobile ticketing 
2. Mobile Vouchers, Coupons and 
3. Mobile contract purchase and delivery mainly consumes of the sale of ring tones, wallpapers and games of 
mobile phones. 
 



5) E-LEARNING: E-Learning comprises all forms of electronically supported learning and teaching’s-Learning 
specially the computer and network skills and knowledge’s-Learning applications include web-based learning, 
computer-based learning. Content is delivered via. The internet, intranet, audio, or video tape, satellite TV, and 
ED-ROM.Computer-Based Learning, refers to the use of computers as a key component of the education 
environment. 
 
6) ONLINE SHOPPING:-  Online shopping is the process whereby consumer directly buy goods or services 
from a sell in real time, without an intermediary services over the internet .  Online shoppers commonly use 
credit card to make payments, however some systems enable users to create accounts and pay by alternative 
means ,such as 
1.   Billing to mobile phones and landline. 
2.   Cheque. 
3.   Postal money order. 
 
   7) SEARCH ENGINE:- A web search engine is designed to search for information on the WWW and FTP 
servers. The search results are generally presented in list of result and are often called hits.    The information 
may consist of web pages, images, information, and other types of files.   
. 
 
8) ONLINE TRADING:- An online trading community provides participants with a structured method for 
trading bantering (exchanging goods with goods) or selling goods and services.  These communities often have 
forums and chat rooms, designed to facilitate communication between the members. 
   
9) ENTERTAINMENT:- 
 
The conventional media that have been used for entertainment are 
1.  Books/magazines. 
2. Radio. 
3. Television/films. 
4. Video games. 
 
 
ELECTRONIC PAYMENT SYSTEMS 
 
Electronic Payment Systems 

 
Definition: Electronic payment is a financial exchange that takes place online between buyers and sellers. The 
content of this exchange is usually as encrypted credit card numbers, electronic cheques or cash. The various 
factors that have the financial intuitions to make use of electronic payments are: 

1.   Decreased technology cost. Interest is becoming free almost everywhere in the world. 
2.  Reduced operational and proceeding cost. 
3.  Increasing online commerce. 

 
Advantages:- 
1.   Privacy. 
2.  Integrity. 
3.  Compatibility. 
4.  Good transaction efficiency. 
5.   Acceptability. 
6.  Convenience. 
7.   Mobility. 
8.  Low financial risk. 



9.  Anonymity. 
 

1) The greatest advantage of e-payments is the convenience. i.e. customer can pay from any locations  
24 hours day, 7 days a week. 

2) E-payments have reduced the amount of time spent on bill management or payment by about 
60%. 
3) Compared to the cost of postage, online payment can save the money. 
4) E-payments are secure. 
 
Risks in Electronic payment systems:- 

 
There are three major risks in the operation of the payment system 

1)  Fraud or mistake. 
2)  Privacy issues. 
3)  Credit Risk. 

 
1)  Fraud or Mistake: 

All electronic payment systems need some ability to keep automatic records. Once information has 
been captured electronically, it is easy and inexpensive to maintain. The need for record keeping for 
purpose of risk management like fraud or any sort of mistakes. 

 
2)  Privacy Issues: 

The electronic payment system must ensure and maintain privacy. The privacy of customers should 
be protected as much as possible. privacy must be maintained against unauthorized access. For any 
type of transaction trusted third-parties will be needed for all tenacity and good faith. 

 
3)  Managing Credit Risk: 

 
Credit or systematic risk is a major concern in net settlement systems because a bank’s failure to 
settle its net position could lead to a chain reaction of bank failures. 

 
 
 
TYPES OF ELECTRONIC PAYMENTS  SYSTEM 

 
Electronic payment systems are mainly used in banking, retail, health –care, online markets, etc., Electronic 
payment system also called as Electronic Funds Transfer (EFT) It is defined as “ any transfer of funds initiate 
through an electronic terminal telephonic instrument or computer or authorize a financial institution to debit 
or credit an account” 
 
 
EFT (Electronic Funds Transfer) can be categorized in to three types. 

 
   1) Banking and financial payments  
                                Large-scale or wholesale payments (e.g., Bank-to-bank transfer)  

                                Small-scale or retail payments (e.g., automated teller machines  

                               Personal banking (e.g., bill payment)  
 

   2 )Retailing payments  
                             Credit Cards (e.g., VISA or MasterCard)  

                              Private label credit/debit cards (e.g., J.C. Penney Card)  



                              Charge Cards (e.g., American Express)  
 

    3)  Online electronic payments. 
 
  i)Token-based payment systems Electronic cash (e.g., DigiCash) Electronic cheques (e.g.,                                                                        
NetCheque) Smart cards or debit cards (e.g., Mondex Electronic Currency Card) 
 ii)Credit card-based payments systems Encrypted Credit Cards (e.g., World Wide Web form-based 
encryption) Third-party authorization numbers (e.g., First Virtual) 
 
 
 
Electronic Cash ( E-cash) 

 
E-cash is a new concept in online payment system because it combines computerized convenience with 
security and privacy. E-cash presents some interesting characteristics that should make it an attractive 
alternative for payment over the internet. 

 
Properties of E-cash: 

 
There are four properties of E-cash 
: - Monetary Value 
: - Interpretability 
: - Irretrievability and security 

 
E-cash must have a monetary value; it must be backed by cash, bank-authorized credit or a bank certified 
cashier cheque. When e-cash created by one bank is accepted by others. 

 
 
E-cash must be Interpretable i.e. this can be cleared in multiple banks, because multiple banks are required with 
an international clearing house that handles the exchangeability issues because all customers are not going to be 
using the same bank or even be in the same country. 

 
E-cash  must  be  storable  and  retrievable  from  any  place  telephone  or  personal  communication device 
and withdraw from and deposit into banking A/C. E-cash should not be easy to copy, this includes preventing 
or detecting duplication. 

 
 
Working of E-cash: 

 
E-cash is based on cryptographic systems called “Digital Signatures”. This method involves a pair of numeric 
keys (Very large no’s) 
- One for locking (encoding) 
- Another for unlocking (decoding) 
- Encoding key is kept private and the decoding key is made public. 

These digital signatures are very secured way for e-cash. 

Electronic cash fulfills two main functions: 
1) As a medium of exchange. 
2) As a store of value. 

 
Digital money is a perfect medium of exchange e-cash would be allowed to realize its potential for 
bypassing the transaction costs of the foreign exchange market. 
 



Electronic Cash Storage: 
• Two methods 
 
– On-line 
                    • Individual does not have possession personally of electronic cash 
                    • Trusted third party, e.g. e-banking, bank holds customers‘ cash accounts 
– Off-line 
                  • Customer holds cash on smart card or electronic wallet 
                  • Fraud and double spending require tamper-proof encryption 
The purchase of e-cash from an on-line currency server (or bank) involves two steps: 

 
 Establishment of an account 
 Maintaining enough money in the account to bank the purchase. 

 
 Once the tokens are purchased, the e-cash software on the customer‘s PC stores digital                 money 

undersigned by a bank. 
 The users can spend the digital money at any shop accepting e-cash, without having to open an account 

there or having to transmit credit card numbers.  
 As soon as the customer wants to make a payment, the software collects the necessary amount from 

the stored tokens. 
 
Smart Cards & Electronic Payment Systems: 
 

 Smart cards have been in existence since the early 1980s and hold promise for secure transactions using 
existing infrastructure. 

 
 Smart cards are credit and debit cards and other card products enhanced with microprocessors capable 

of holding more information than the traditional magnetic stripe. 
 

 The smart card technology is widely used in countries such as France, Germany, Japan, and Singapore to 
pay for public phone calls, transportation, and shopper loyalty programs. 

 
Types of Smart Cards:  
 

 Relationship-Based Smart Credit Cards  
 Electronic Purses also known as debit cards  

 
 Relationship-Based Smart Credit Cards:  

 It is an enhancement of existing cards services &/ or the addition of new services that a financial 
institution delivers to its customers via a chip-based card or other device.  
 

 These services  include access  to multiple  financial accounts, value-added marketing   programs, or 
other information card holders may want to store on their card. 

 
 It includes access to multiple accounts, such as debit, credit, cash access, bill payment & multiple access 

options at multiple locations.  
 

 Electronic Purses:  
 

         To replace cash and place a financial instrument are racing to introduce electronic purses wallet-sized  
smart  cards  embedded with  programmable microchips  that  store  sums  of   money for people to use instead of 
cash for everything. 
     
The electronic purse works in the following manner: 



 
 After purse  is  loaded with money  at  an ATM,  it can be used  to pay  for  candy  in  a  vending machine 

with a card reader.  
 It  verifies  card  is  authentic  &  it  has  enough  money,  the  value  is  deducted  from  balance on  the 

card &  added  to  an e-cash &  remaining balance  is displayed by  the  vending machine. 
 
Credit Card-Based Electronic Payment Systems: 
 
Payment cards are all types of plastic cards that consumers use to make purchases:  
– Credit cards 

 Such as a Visa or a MasterCard, has a preset spending limit based on the user‘s credit limit. 
 
– Debit cards  
       • Removes the amount of the charge from the cardholder‘s account and transfers it to the seller‘s bank. 
 
 
--Charge cards  
• Such as one from American Express, carries no preset spending limit. 
 
Advantages:  
– Payment cards provide fraud protection.  
– They have worldwide acceptance.  
– They are good for online transactions. 
 
Disadvantages:  
Payment card service companies charge merchants per-transaction fees and monthly processing  
fees. 
 
 
 
Electronic payments Issues: 

 Secure transfer across internet  
 High reliability: no single failure point  
 Atomic transactions  
 Anonymity of buyer  
 Economic and computational efficiency: allow micropayments  
 Flexibility: across different methods  
 Scalability in number of servers and users 

 
 
Security Requirements In Electronic Payment Systems: 

 
 Integrity and authorization  

A payment system with integrity allows no money to be taken from a user without explicit authorization  by  that  
user.  It may  also  disallow  the  receipt  of  payment without  explicit consent, to prevent occurrences of things 
like unsolicited bribery. Authorization constitutes the most  important  relationship  in a payment system. 
Payment can be authorized  in  three ways: via out-band authorization, passwords, and signature. 
 

 Out-band authorization   
 
In  this approach,  the verifying party  (typically  a bank) notifies  the authorizing party  (the payer) of a  
transaction. The authorizing party  is  required  to approve or deny  the payment using a secure, out-band channel 
(such as via surface mail or the phone). This is the current approach for credit cards involving mail orders and 



telephone orders: Anyone who knows a user‘s  credit  card  data  can  initiate  transactions,  and  the  legitimate  
user must  check  the statement  and  actively  complain  about  unauthorized  transactions.  If  the  user  does  not  
complain within a certain time (usually 90 days), the transaction is considered ―approved by default.   
 

 Password authorization 
A  transaction  protected  by  a  password  requires  that  every message  from  the  authorizing party  include  a  
cryptographic  check  value.  The  check  value  is  computed  using  a  secret known  only  to  the  authorizing  
and  verifying  parties.  This secret can be a personal identification number, a password, or any form of shared 
secret. In addition, shared secrets that are short - like a six-digit PIN - are inherently susceptible to various kinds 
of attacks. They cannot by themselves provide a high degree of security. They should only be used to control 
access  to a physical  token  like a  smart  card  (or a wallet)  that performs  the actual authorization using secure 
cryptographic mechanisms, such as digital signatures. 
 

 Signature authorization   
In this type of transaction, the verifying party requires a digital signature of the authorizing party. Digital 
signatures provide non repudiation of origin. 
 

 Confidentiality   
Some parties involved may wish confidentiality of transactions. Confidentiality  in  this context means the 
restriction of the knowledge about various pieces of information related to  a  transaction:  the  identity  of  
payer/payee,  purchase  content,  amount,  and  so  on. Typically, the confidentiality requirement dictates that this 
information be restricted only to the participants involved. Where anonymity or un-traceability are desired, the 
requirement may be to limit this knowledge to certain subsets of the participants only, as described later. 
 

 Availability and reliability   
All parties require the ability to make or receive payments whenever necessary. Payment transactions must be 
atomic: They occur entirely or not at all, but they never hang in an unknown or inconsistent state. No payer 
would accept a loss of money (not a significant amount, in any case) due to a network or system crash. 
Availability and reliability presume that  the  underlying  networking  services  and  all  software  and  hardware  
components  are sufficiently dependable. Recovery from crash failures requires some sort of stable storage at all 
parties and specific resynchronization protocols. These fault  tolerance  issues are not discussed here, because 
most payment systems do not address them explicitly. 
 
Operational Risks: 

 
Risks Involve in E-Cash are: 
 
1) The time over which given electronic money is valid 
2) How much can be stored on and transferred by electronic money. 
3) No. of transactions made during given period of time. 
 
To make purchasing using E-cash: 
1)  Establishment of an account 
2)  Maintaining enough money in the a/c to make the purchase. 

 
 
Legal Issues: 

 
Electronic cash will force bankers and regulators to make tough choices that will shape the form of lawful 
commercial activity related to electronic commerce. 

 
 
1. The consumers acquire an OTPP account numbers by filling our registration form. This will give the OTPP a 
customer information profile. 



 
2. To purchase in on-line the consumer requests the form the merchant by quoting OTPP account number. 

 
3. The merchant contacts with OTPP payment server with the customer’s account number 

 
4. The OTPP payment server verifies the customer’s account number for the vendor and check for stuffiest 
funds. 

 
5. The OTPP payment server sends an electronic message to the buyer. The buyer responds to this message in 
one of two ways. Yes I agree to pay; No; I will not pay; 

 
6. If the OTPP payment servers get a yes from the customer, the merchant is informed and the customer is 
allowed to download the material immediately. 

 
7. The OTPP will not debit the buyer’s account until it receives conformation of purchase completion. 

 
 
 
 

PAYMENT SERVER 
 
 
 
 
 
 
 
 

BANK                              THIRD PARTY 
SERVER 

 
 
 
 
 

 
CREDIT CARD, 

DEBIT CARD, 

DIGITAL CASH 
 
 

 
 
 

A medium of payment between remote buyers and sellers in cyberspace: electronic cash, software 
wallets, smart cards, credit/debit cards 

 
 
 
 
 
 
 
 
 



EDI-ELECTRONIC DATA INTERCHANGE 
 

INTRODUCTION 
 
EDI refers to the exchange of electronic business documents i.e. purchasing orders, invoices, etc. between 
applications. The exchange involves no paper, no human intervention and takes place in a matter of seconds. 
EDI documents are formatted using published standards. EDI requires a network connection between the two 
companies exchanging business documents. 
EDI has provided great value to trading partners especially those in certain “EDI – ENABLED” industries such 
as retail, automotive, and petroleum. The advent of the internet has created a common information and 
communications platform upon which business can be conducted. Internet provides the communications. 
Capabilities of EDI over a Value-Added network at a much lower 
price. 

 
BUSINESS SYSTEMS ARE OF 3 TYPES:- 
1. NON-EDI SYSTEMS 
2. PARTIALLY EDI SYSTEMS 
3. FULLY INTEGRATED SYSTEMS 

 
NON-EDI SYSTEMS:- 

 
EDI today is most widely used in large business and by smaller companies trading with larger 

businesses. 
The entire non- EDI process requires the use of multiple clerks by both the customer and vendor 

to complete the transaction. The typical clerks involved in the buying cycle are Inventory 
control, purchasing, receiving, accounts payable, etc.. The typical clerks involved in the selling cycle 
are sales order processing, credit, warehouse, shipping, accounts receivable and cash receipts. 

 
EXAMPLE FOR NON-EDI SYSTEMS 

SELLING BUYING 

PREPARE SALES OEDER PURCHASE REQUISITION 

SALES ORDER COPY SENT TO 
WAREHOUSE OR PLACED ON BACK 
ORDER. 

SEARCH VENDOR FILES 
OR 

SELECT A VENDOR 

AFTER GOODS ARE SHIPPED, INVOICE IS 
PREPARED. 

PREPARE PURCHASE ORDER 

MAIL INVOICE TO CUSTOMER MAIL PURCHASE ORDER TO VENDOR 

 RECEIVE INVOICE & VERIFY ACCURACY 

 PREPARE CHECK AND MAIL CHECK. 

From the above example, as many as eleven clerks are involved in the process from start to finish. 
 
 
EDI layered architecture: 
 
• Semantic (or application) layer  
• Standards translation layer  
• Packing (or transport) layer  
• Physical network infrastructure layer 
 



EDI Semantic 
layer 

Application level services 

EDI standard 
layer 

EDIFACT  business form standards  

ANSI X12  business form standards 
EDI 
Transport 
layer 

Electronic mail X.435,MIME 

Point to point FTP,TELNET 

WWW HTTP 

Physical layer Dial up lines, Internet, i -way 

 
EDI semantic layer: 
 
• Describes the business application  
• Procurement example  
– Requests for quotes  
– Price quotes  
– Purchase orders  
– Acknowledgments  
– Invoices  
• Specific to company & software used 
 

: standard layer Standards translation 
 

• Specifies business form structure so that information can be exchanged  

• Two competing standards  

– American National Standards Institute (ANSI)X12  

– EDIFACT developed by UN/ECE, Working Party for the Facilitation of International Trade Procedures 

 

EDI transport layer  

• How the business form is sent, e.g. post, UPS, fax  

• Increasingly, e-mail is the carrier  

• Differentiating EDI from e-mail  

– Emphasis on automation  

– EDI has certain legal status 

Physical network infrastructure layer  

• Dial-up lines, Internet, value-added network, etc. 

 

VALUE – ADDED NETWORKS(VANS) 
 

The EDI features are implemented in the organization through third party network services, generally 
called Value-Added-Networks.(VAN).The services provided by most VANS include 

 
1. EDI translation s/w 
2. Security assurances of data 
3. Reliability of services due to multiple 
4. Telecommunication links 
5. EDI systems development assistance 
6. Employee training sessions. 

 
 



ROLE OF VAN 
 

1.         To execute only authorized transactions with valid trading partners. 
2.         To enable the VAN to distinguish authorized transactions and valid trading partners. 

Companies view EDI messaging as a function to be outsourced to a specialist. VANS provide this outsourcing 
function and serve as a messaging station for trading partners. Messaging can be transmitted from one party's 
VAN to the other party's VAN. When author trading partner send a request for information to VAN .VAN 
transmit the data immediate back to the requesting partner without needing to contact to the vendor. 

If VAN does not have the requested data, it request the vendor for the data.  
After getting the data from the vendor, it sends back to the trading partners. 

 
 
 

 
 
 
 

Company A 
(Vendor) 

VAN 
COMPANY'S A 

AND B 
TRADING 

AGREEMENT 

 
 
 
Company B 
(Customer or 
partner)

 
 
 
 
 
 
FULLY INTEGRATED EDI SYSTEMS 

 
Fully integrated EDI systems encompass electronic data sharing throughout all aspects of the 

purchasing and payment cycles. 
1.  The processing of the actual payment and remittance advice is called Financial EDI. 
2.   Fully integrated EDI, including financial EDI, provides firms with the greatest benefits in terms of 

speed and accuracy. 
3. Payment systems also did in electronic fund transfer.



 

 

 

 
 
 

PRE-REQUISITES OF EDI 
 
Planning for EDI implementation is an important factor 
for success. The step required for EDI is:- 
1. Identify organizational needs for EDI 
2. Weigh the cost and benefits of EDI 
3. Identify EDI business partners 
4. Obtain top management approval 
5. Form an EDI project team 
6. Education & training 
7. Decide on EDI standards 
8. Decide on the connection options 
9. Implementation planning. 

 
 

EDI: LEGAL, SECURITY AND PRIVACY ISSUES 
 
In EDI, Trading is done between countries and corporations. 
 
•   In EDI, legal issues and computer security are important. 
•   Companies that deal with EDI should take the services of a lawyer during the design of EDI 
applications, so that evidentiary/admissibility safeguards are implemented. 
 

1.Scans inventory files to 
determine purchase 
requirements 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
VAN (steps:3,4,5,6,7,9,10,12,13 
are done through van) 

6.electronically retrives purchse 
order and sales order is 
automaticcally generated. 

2. Scans vendor files to 
determine appropriate 
vendor. 

7.Notifies ware house to pull 
goods 

3. contact vendor systems to 
check inventory availability 
and prices. 

8.records shipping date and 
quantities. 

4. select vendor 9.sends electronic invoice to 
customer 

5. place order(purchase 
order) 

13.receives electronic 
notification of funds 
transferred and remittance 
advice. 

10.receives electronic invoice  

11. verifies amount charged 
and goods received. 

 

12.Electronically transfers 
funds and remittance advice 

 



 

 

 

There are 3 types of communications when considered for EDI issues: 
 
1) Instantaneous: - If the parties are face to face or use an instantaneous communication 
medium such as telephone. 
2) Delayed with postal service: - The mailbox rule provides that an acceptance communicated 
via Postal service mail is effectively communicated when dispatched or physically deposited. 
3) Delayed with non postal service: - EX: - Couriers, telegram 

 
•   Messaging systems combine features of delayed and instantaneous 
• Messaging delay is a function of the specific applications, message routing, 

networks traversed, system configuration and other technical factors. 
 
One way of legal & security issue is Digital signatures. The technical uses of digital signatures 

are:- 

1.Messages are time- stamped or digitally notarized to establish dates and times at which a 
recipient hard access or even read a particular message. 
2.These signatures are to replace handwritten signatures, as it is same legal status as 
handwritten signatures. 
3 Digital signatures should have greater legal authority than handwritten signatures. 

 
 

 
Business Models for E-commerce 
 
REVENUE MODEL 
In business, revenue typically consists of the total amount of money received by the company for goods 

sold or services provided during a certain time period. Therefore, revenue models are a part of the 

business model. Many online companies generate revenues from multiple income streams such as 

advertising, subscription, affiliate marketing etc. Online models not only sell goods or services but also 

contacts (e.g. banner) and information (e.g. user-data). 

Five primary revenue models are described below- 

1. Advertising Revenue Model 

Typically, fees are generated from advertisers in exchange for advertisements, which is ultimately the 

classic principal among the revenue models besides sales. Even if representatives of major media 

companies complain about earning less money with online advertising than with advertising in print or 

TV, the figures indicate steadily rising revenues. 

The advertising revenue model is based on contacts making it one of the indirect sources of revenue. 

The conventional version is display-marketing - for example wallpaper, super banner, rectangle, 

skyscraper- which is paid according to traffic (invoice per CPC/cost-per-click or CPX/cost-per-action). 



 

 

 

Examples 

Google (e.g. AdWords and AdSense) 

Facebook 

New York Times (Marketing) 

2. Subscription Revenue Model 

 

Users are charged a periodic (daily, monthly or annual) fee to subscribe to a service. Many sites combine 

free content with premium membership, i.e. subscriber- or member-only content. Subscription fees do 

not depend on transactions. Subscribers use the content as long and often as they want 

 

Examples 

Publishers and content services, e.g. newspapers, magazines, tv channels - they provide text, audio or video 

content to users who subscribe for a fee to get access to the service or to download the new issue: New York 

Times, Spiegel Online, Zattoo, Netflix 

Networks offer premium memberships to find business partners or former classmates, subscribers can use all 

services, i.e. they get any information about their account via short notifications or newsletter, receive and send 

e-mails, get job offers: Xing, Linkedin, Stayfriends 

Internet service providers offer the connectivity (e.g. via broadband) and services around (security software for 

download, e-mail-services): T-Online, AOL 

 

3. Transaction Fee Revenue Model 

A company receives commissions based on volume for enabling or executing transactions.7) The revenue is 

generated through transaction fees by the customer paying a fee for a transaction to the operator of a platform. 

The company is a market place operator providing the customer with a platform to place his transactions. 

During this process the customer may be presented as a buyer as well as a seller. To actively participate in this e-

market, customers must register, so both parties of a transaction taking place are identified. From a business 

perspective, the offer is determined by others as customers offer their goods online and are acting as sellers. 

The amount of the transaction fee can be both – fixed and percentage calculated. 

Examples 

 eBay 

 Amazon 

 

4.Sales Revenue Model 

Wholesalers and retailers of goods and services sell their products online. The main benefits for the customer 

are the convenience, time savings, fast information etc. The prices are often more competitive. In terms of 

online sales there are different models such as market places as common entry points for various products from 

multiple vendors. 

Examples 

 the shops of single companies, sometimes based on web-catalogs (combines mail, online and telephone-

ordering): Otto 

 e-tailers operating solely over the web: Amazon 

http://en.ecommercewiki.info/fundamentals/revenue_models
http://www.ebay.com/
http://www.amazon.com/
http://www.otto.de/
http://en.ecommercewiki.info/glossary/e/e-tailers
http://www.amazon.com/


 

 

 

 marketplaces: Buy.com, Etsy 

 live shopping: iBood, guut.de, woot! 

 shopping clubs: brands4friends, vente-privee.com 

 

5.Affiliate Revenue Model 

 

The affiliate program is an online distribution solution which is based on the principle of commission. Merchants 

advertise and sell their products and services through links to partner-websites. It is a pay-for-performance 

model: Commissions are only paid for actual revenue or measurable success.8) An affiliate-link includes a code, 

which identifies the affiliate. That’s how clicks, leads or sales are tracked. The affiliate therefore acts as the 

interface between merchants and customers. This model leads to a win-win situation: the merchants sell their 

products or services and the affiliates get their commissions. Variations include banner exchange, pay-per-click 

and revenue sharing programs. The affiliate model is well-suited for the web and therefore very popular. 

Examples 

 Amazon 

 affilinet 

 

E-Commerce Business models based on strategies 

 

There are mainly 4 types of business models based on transaction party.  

Business-to-Consumer (B2C)  

In  a  Business-to-Consumer  E-commerce  environment,  companies  sell  their  online  goods  to consumers 

who are the end users of  their products or services. Usually, B2C E-commerce web shops have an open 

access for any visitor, meaning that there is no need for a person to login in order to make any product 

related inquiry. 

 
Business-to-Business (B2B)  

In a Business-to-Business E-commerce environment, companies sell  their online goods  to other companies  

without  being  engaged  in  sales  to  consumers.  In  most  B2B  E-commerce environments  entering  the  

web  shop  will  require  a  log  in.  B2B  web  shop  usually  contains customer-specific pricing, customer-

http://www.buy.com/
http://www.etsy.com/
http://www.ibood.com/
http://www.guut.de/
http://www.woot.com/
http://www.brands4friends.com/
http://www.vente-privee.com/
http://en.ecommercewiki.info/fundamentals/revenue_models
http://www.amazon.com/
http://www.affili.net/


 

 

 

specific assortments and customer-specific discounts. It includes the IOS transactions and electronic market 

transactions between organizations. 

•IOS Transactions means Inter Organizational Information Systems refers to flow of standard transactions 

information between business partners, such as placing orders, building or paying. 

 

 

 

 

 

 

 
 

 

Consumer-to-Business (C2B)  

In a Consumer-to-Business E-commerce environment, consumers usually post  their products or services 

online on which companies can post their bids. A consumer reviews the bids and selects the company that 

meets his price expectations. 

 

 



 

 

 

Consumer-to-Consumer (C2C)  

In a Consumer-to-Consumer E-commerce environment consumers sell their online goods to other 

consumers. A well-known example is eBay. 

 

 

 

 
 

 

Marketing on the web  

Internet Marketing Techniques: 

Internet marketing techniques are of 2 types: 

1) Passive Techniques. 

2) Aggressive Techniques. 

1) Passive Techniques: Passive techniques are considered to be those methods that require the user to 

‘pull’ the information from the website. 

2) Aggressive Techniques: Aggressive techniques are considered to be those techniques in which the 

website “pushes” the information on to the customer regardless of whether the consumers is interested 

or not. 

Some of the marketing techniques: 

•   Solicited, targeted e-mail. 

•   Interactive sites. 



 

 

 

•   Banner advertising. 

•   Off-line advertising. 

•   Unsolicited targeted e-mail. 

•   Spam Mail. 

•   E-mail, chain letters. 

Solicited, Targeted E-mail: 

E-mail marketing has become a popular medium because of its relatively low-cost and the ability to send 

HTML messages containing full color pictures of products, as well as links to order from pages. The 

transmit of an e-mail message to a solicited, targeted list is a method used to  visitors to a website that 

requires acts by both the website and the visitor. This mechanism allows a business to maintain regular 

contract with customers and drive traffic to websites or other products. 

Because the user requests the information this type of internet marketing technique is considered to be 

“pulled” by the consumer with the help of the website. 

This Technique comes under passive Techniques. 

Interactive Sites: 

Some sites may exhibit initiative to attract initial and subsequent visitors to their site by providing 

general information in an interactive fashion. 

Banner Advertising: 

Online Banner advertising, off-line advertising one comes under aggressive advertising techniques. 

Online banner advertising a service sold. Internet marketing firms. Can be very effective. A major 

advantage is that the banner’s effectiveness, in terms of  a    visitors to site is easily monitored. 

Off- Line Advertising: 

The method used to promote website is off-line advertising, such as television, radio and print. These 

advertising mechanisms are also relatively more costly than previously mentioned methods. 

Unsolicited, Targeted E-mail: 

The method of on-line advertising that unsolicited, targeted email advertising to past visitor or 

customers. This type of advertising is aggressive in that the visitor or customer does not specifically 

request additional sales or promotion items. When conducted properly, these methods can be effective. 

 

 



 

 

 

Spam mail: 

Even more aggressive factices to attract customers is the sending of  unsolicited e-mail advertisements 

to individuals or business that have never visited the site. The e-mail address may be purchased or 

traded with another business. The on –line eqvalent of junk-mail- that is sent out repeatedly is referred 

to as spam mail. 

Spam is referred to as “Postage due marketing “because the thousands of messages sent reside on the 

recipients host computers until they are deleted, and the storage of such messages cost business 

money. 

E-mail chain letters: 

Another low-cost, aggressive advertisement technique used on the internet is e-mail chair letters. E- 

mail chair letters typically require that a user visit site and register. 

 

Marketing ( Web – Based marketing): 

The www provides an exciting and powerful new distribution channel for marketers. Web –based 

electronic commerce is providing marketers with an exciting new marketing channel. 

Marketing is the process of planning and executing the conception, pricing, promotion, and distribution 

of ideas, goods and services to create exchanges that satisfy individual and organizational goals. 

The www presents a new venue for marketers to use and with it comes new guidelines. Web based 

marketing consider two issues. 

1)     Determine whether web-based marketing is  

(i) Evolutionary- altering an existing firm’s business model. 

(ii) Revolutionary- forming a new organization to realize the opportunity of marketing on the 

web. 

2)     Consider how the various web-based marketing techniques can supplement current marketing 

initiatives. 

The Five “P”s Applied To Internet Marketing: 

A customer oriented value chair that places the customer as the center of attention, with information 

follows passing from a business to its customer for all facts of its operations except for own 

procurement where the firm inter faces with its suppliers. 

 



 

 

 

The five “P” s of marketing are: 

1)     Product 

2)     pricing 

3)     Place & Distribution 

4)     Promotion 

5)     Personalization 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure: The relationship of the five Ps and the consumer- oriented value chain 

 

Product: 

Product is a good or service that a business offers to its customers without a perfect product to offer, a 

business cannot survive. The produce component in the marketing is related to the production section 

of the consumers –oriented value chain. 

Pricing  

Procurement 

Customer 
personalization 

Product 

Promotion 

Place & 

Distribution 



 

 

 

Pricing: 

The pricing of a “good” refers to the processes involved in determining the amount to change for a 

specific physical good or service pricing models are typically used to determine a firms price. 

Because of the development of search engines customers are easily able to compare prices of many 

goods offered for sale on the internet. On-line quotation are a popular method for selling items on the 

internet an interesting method of pricing goods on the internet is through offers made by consumers. 

Place (Distribution): 

Place is frequently referred to as out bound logistics or Distribution. 

The Distribution task entails moving the product from the producer to the customer. 

The product may travel directly from the products to the customer or it may be channeled 

intermediaries such as whole sales or retailers. 

E-commerce involving the sale of physical goods can be very useful in exchanging information between 

business and delivery companies. 

The physical internet itself us also a delivery channel for digital products like software data or 

multimedia fill. 

Promotion: 

The sales and marketing function under the traditional marketing category called promotion. 

The successful promotion of a product requires that at a minimum a positive message be received by 

potential customers. This message can be communicated many ways. 

1) Paid advertising channels. 

2) New stories and press releases. 

3) Word of mouth. 

4) Consumers personal experiences. 

5) Packaging. 

Another aspect of promotion is the sharing of information with customers. 

Personalization: 

The internet is leading marketers to a fundamental paradigm shift from mass marketing to personalized 

marketing. Data bases and telecommunications technology make it very easy and cost – efficient to 

mass marketing personalized services. 

Personalization on the internet refers to the ability of customers to receive personalized information 

(ex: sales advertisements or coupons) or visit a website. 



 

 

 

ONLINE ADVERTISING MECHANISMS 

Attracting visitors to websites is a key component to a successful web-based commerce site. The must 

common sources of revenue come from allowing advertisers to pay for banners on their sites is to be 

listed as site sponsors. 

Different Techniques in online Advertising are: 

1) Banners. 

2) Sponsorships. 

3) Portals. 

4) Online Coupons. 

Banners: 

According to interest advertising bureau (IAB), the most popular form of on-line advertising is banner 

advertising. 

Banner advertising is used to attract visitors to a site. 

Banner advertising containing text and graphic that are placed on the screens of search engines, web 

browser software and websites to attract the attention of www users. Banner advertising is of two types 

•   Click through advertisement. 

•   Not click- thorough advertisement. 

Click through advertisement contain hypertext links to the site about which the banner is advertising. 

Non Click through advertisements which does not contain hypertext links to the site. 

Banner advertising is typically measured and priced according to two features. 

  CPM- Cost per thousand impressions. 

  CTR- Click through rate. 

CPM- an impression refers to each time a page is viewed that is displaying the banner. 

CTR- the click through rate is considered to be more important by many advertisers since it measures 

the no. of users ”delivered” to a site. 

 

Firms are also interested in tracking whether visitors they make a purchase from the site. So software 

tracking devices are available for tracking such items. 

 



 

 

 

Sponsorships: 

Sponsorship is another popular on-line advertising method. Sponsorships are similar to banner in that a 

business gets to display a message typically just a logo, on a site a click- thorough may be allowed. 

Sponsorships typically allow the firms banner to stay on a site for a longer period of time or for a certain 

no. of days. 

Sponsorships are a good mechanism for generating brand recognition’s. 

Portals: 

A portal is referred to a site that serves the “post of entry” on to the web. Portals are designed to give 

web users the information they need as they first enter the www. 

Customized pages are an option, as well a customized news items and stock quotes. Portals types sell 

advertising space on their sites. 

Online coupons: 

Online coupons are printed for use in stores or requested and sent via portal mail for use in stores when 

the visitor expenses the produce in which they are interested the store mails the coupons to them. 

On-line coupons are also distributed from sites that specialize in distributing such coupons for 

businesses that subscribe to their services. 

 

Electronic market places 

Electronic markets (or electronic marketplaces) are information systems (IS) which are used by 

multiple separate organizational entities within one or among multiple tiers in economic value 

chains. In analogy to the market concept which can be viewed from a macroeconomic 

(describing relationships among actors in an economic systems, e.g. a monopoly) as well as 

from a microeconomic (describing different allocation mechanisms, e.g. public auctions of 

telephone frequencies) perspective, electronic markets denote networked forms of business 

with many possible configurations: 

First, the topology of electronic markets may be centralized or decentralized in nature. 

Centralized electronic markets are hubs which often provide services to their participants. 

Decentralized settings involve sequential relationships within value chains which often are 

found when electronic messages are exchanged directly between businesses (electronic data 

interchange, EDI). 

https://en.wikipedia.org/wiki/Information_systems
https://en.wikipedia.org/wiki/Value_chain
https://en.wikipedia.org/wiki/Value_chain
https://en.wikipedia.org/wiki/Value_chain
https://en.wikipedia.org/wiki/Electronic_data_interchange
https://en.wikipedia.org/wiki/Electronic_data_interchange


 

 

 

Second, the services provided by electronic markets may serve infrastructural or allocation 

purposes. Among the infrastructure services are routing, messaging, identification and partner 

directories whereas allocation services enable pricing process which in turn may be static or 

dynamic in nature. Typical implementations are catalogs, exchanges and auctions. 

Third, the relationships of actors involved in electronic markets may be stable or atomistic in 

nature. The former usually refers to classical supply chains where business collaborate during a 

longer period of time. In the latter case, the transaction partners are only stable for a single 

transaction. This is usually to be found in auction and other exchange settings. 

This leads to two definitions: In a narrow sense Electronic Markets are mainly conceived as 

allocation platforms with dynamic price discovery mechanisms involving atomistic 

relationships. Popular examples originate from the financial and energy industries. In a broader 

sense, price discovery is not critical for electronic markets. This covers all forms of electronic 

collaboration between organizations and consumer as well as vice versa. 

Electronic Auctions 

The electronic auction (e-Auction) is an e-business between auctioneers and bidders, which 

takes place on an electronic marketplace. It is an electronic commerce which occurs business to 

business (B2B), business to consumer (B2C), or consumer-to-consumer (C2C). 

The auctioneer offers his goods, commodities or services on an auction side on the internet. 

Interested parties can submit their bid for the product to be auctioned in certain specified 

periods. The auction is transparent, all interested parties are allowed to participate the auction 

in a timely manner.[ 

The two major types of the electronic auction are: 

1. forward auction in which several buyers bid for one seller's goods  

2.  reverse auction in which several sellers bid for one buyer's order. 

Advantages of online auction- 

 No physical location 

The products for auction do not need any physical location in case of online auction. The 

inventory can be managed online and upon sale the product can be shipped physically. This 

makes it flexible to hold an auction online site. 

 

 

 

https://en.wikipedia.org/wiki/Price_discovery
https://en.wikipedia.org/wiki/Auction
https://en.wikipedia.org/wiki/Auctioneers
https://en.wikipedia.org/wiki/Business-to-business
https://en.wikipedia.org/wiki/B2C
https://en.wikipedia.org/wiki/Consumer-to-consumer
https://en.wikipedia.org/wiki/Bid_price
https://en.wikipedia.org/wiki/Forward_auction
https://en.wikipedia.org/wiki/Reverse_auction


 

 

 

 Convenience 

The bidder can participate in auction from anywhere at anytime through online auction. 

There is no limitation regarding the time, place, or person to conduct online auction. 

Bidders can participate in auction from home or office using the computer terminal. 

 Rich information 

The related information about each auction product is neatly presented on the website. Bidders 

can peruse all the documents related to the products before participating in the auction. There 

is no confusion to get information at fingertips. 

 Time& money saving 

Online auction saves time and money. There is no dedicated time required to travel and reach 

an auction place. Just logging into the site makes it possible for the user to participate in 

auction which also saves money spent for reaching the auction spot. 

 

Disadvantages of online auction- 

 Prolonged time 

In normal auction the time for auction is fixed which will not be changed. But in the case of 

online auction, the timer is reset with 20 or 30 seconds when a bidder places a bid which makes 

the auction time to be prolonged causing time delay in closing the auction. 

 Anonymous bidder 

The online auction does not take place face to face which creates anonymous bidders. The 

auctioneers cannot have a hold on who is participating in the bidding. This can lead to 

anonymity in identifying the bidders. 

 Product genuineness 

One can view only the product photo on the auction website. One cannot inspect the product 

about its condition and usability physically which may lead to lack of product genuineness. 

Some of the online auction does not support refund 

 Fake sites 

The auction website may be sometimes fraudulent which sells fake products which will never 

be delivered. The product description and actual product may differ. Sometimes the product 

delivered may not be the product that was placed for auction leading to chaos. 

 

 

 

 



 

 

 

M-Commerce 

M-Commerce or mobile commerce is process of buying and selling products and services through 

wireless handheld devices such as cell phones or PDAs. Though M-commerce is a new term, it has 

become an instant hit and is also being called as the next generation e-commerce. M-commerce lets 

users carry out financial transaction using mobile phones and does not always require internet. It is has 

made the process of buying and selling products even easier due to a technology known as WAP 

(Wireless Application Protocol), which allows users to connect to the internet without dealing with the 

hassle of wires and electricity. 

It also allows businesses to reach consumers even faster compared to e-commerce, as a person may not 

always have a computer with them, while a person will always have their cell phones on them. 

Promotional text messages are an example of mobile commerce. Another popular example is 

downloading movie tickets and airline tickets on the phone. With the constant upgrade in cellular 

technology, more and more possibilities are available to the consumers. Mobile applications, online 

banking, online shopping via phone, are also different forms of m-commerce. 

Compared to M-commerce, E-commerce is more limited as it requires the use of a computer and 

internet connection, while mobiles work on satellites. Video conferencing is now available on mobile 

phones with 3G and 4G networks, without the hassle of internet. M-commerce however is costly 

compared to E-commerce. 

Virtual community 

A virtual community is a social network of individuals who interact through specific social media, 

potentially crossing geographical and political boundaries in order to pursue mutual interests or goals. 

Some of the most pervasive virtual communities are online communities operating under social 

networking services. 

Virtual communities all encourage interaction, sometimes focusing around a particular interest or just to 

communicate. Some virtual communities do both. Community members are allowed to interact over a 

shared passion through various means: message boards, chat rooms, social networking sites, or virtual 

worlds 

 Purpose of virtual communities: 

Virtual communities are used for a variety of social and professional groups; interaction between 

community members varies from personal to purely formal. For example, an email distribution list 

operates on an informational level. 

 Internet-based virtual communities- 

The explosive diffusion of the Internet since the mid-1990s fostered the proliferation of virtual 

communities in the form of social networking services and online communities. Virtual communities 



 

 

 

may synthesize Web 2.0 technologies with the community, and therefore have been described as 

Community 2.0, although strong community bonds have been forged online since the early 1970s on 

timeshare systems like PLATO and later on Usenet. Online communities depend upon social interaction 

and exchange between users online. This interaction emphasizes the reciprocity element of the 

unwritten social contract between community members. 

 Impacts of virtual communities 

-On health 

Concerns with a virtual community's tendency to promote less socializing include: verbal aggression and 

inhibitions, promotion of suicide and issues with privacy. However, studies regarding the health effects 

of these communities did not show any negative effects. There was a high drop-out rate of participants 

in the study. The health-related effects are not clear because of the lack of thoroughness and the 

variation in studies done on the subject. 

-On civic participation 

New forms of civic engagement and citizenship have emerged from the rise of social networking sites. 

Networking sites acts as a medium for expression and discourse about issues in specific user 

communities. Online content sharing sites have made it easy for youth to not only express themselves 

and their ideas through digital media, but also connect with large networked communities. Within these 

spaces, young people are pushing the boundaries of traditional forms of engagement such as voting and 

joining political organizations and creating their own ways to discuss, connect, and act in their 

communities. 

Civic engagement through online volunteering has shown to have positive effects on personal 

satisfaction and development. Some 84 per cent of online volunteers found that their online 

volunteering experience had contributed to their personal development and learning. 

 

 Types of virtual communities- 

1.Internet message boards: 

An online message board is a forum where people can discuss thoughts or ideas on various 

topics. Online message centers allow users to choose which thread, or board of discussion, 

users would like to read or contribute to. A user will start a discussion by making a post on a 

thread. Other users who choose to respond can follow the discussion by adding their own post 

to that thread. Message boards are not conversation based because user responses do not 

have to take place right away. Whenever the user revisits the message board, he/she can make 

a response. Unlike a conversation, message boards do not have an instantaneous response and 

require that users actively go to the site to check for responses. Anyone can register to 



 

 

 

participate in an online message board. A message board is unique because people can choose 

to participate and be a part of the virtual community, even if they choose not to contribute 

their thoughts and ideas. Registered users can simply view the various threads or contribute if 

they choose to. Message boards can also accommodate an almost infinite number of users, 

while the number of users who can be accommodated by a single chat room is limited at least 

in practice. 

 

2.Online chat rooms: 

Shortly after the rise of interest in message boards and forums, people started to want a way of 

communicating with their "communities" in real time. The downside to message boards was 

that people would have to wait until another user replied to their posting, which, with people 

all around the world in different time frames, could take a while. The development of online 

chat rooms allowed people to talk to whoever was online at the same time they were. This 

way,messages were sent and online users could immediately respond back. The original 

development by CompuServe CB hosted forty channels in which users could talk to one another 

in real time. The idea of forty different channels led to the idea of chat rooms that were specific 

to different topics. Users could choose to join an already existent chat room they found 

interesting, or start a new "room" if they found nothing to their liking. Real time chatting was 

also brought into virtual games, where people could play against one another and also talk to 

one another through text. Now, chat rooms can be found on all sorts of topics, so that people 

can talk with others who share similar interests. Chat rooms are now provided by Internet Relay 

Chat (IRC) and other individual websites such as Yahoo, MSN, and AOL. 

3.Virtual worlds:  

Virtual worlds are the most interactive of all virtual community forms. In this type of virtual 

community, people are connected by living as an avatar in a computer-based world. Users 

create their own avatar character (from choosing the avatar's outfits to designing the avatar's 

house) and control their character's life and interactions with other characters in the 3-D virtual 

world. It is similar to a computer game, however there is no objective for the players. A virtual 

world simply gives users the opportunity to build and operate a fantasy life in the virtual realm. 

Characters within the world can talk to one another and have almost the same interactions 

people would have in reality. For example, characters can socialize with one another and hold 

intimate relationships online. 

 This type of virtual community allows for people to not only hold conversations with others in 

real time, but also to engage and interact with others. The avatars that users create are like 

humans. Users can choose to make avatars like themselves, or take on an entirely different 



 

 

 

personality than them. When characters interact with other characters, they can get to know 

one another not only through text based talking, but also by virtual experience(such as having 

avatars go on a date in the virtual world). A chat room form of a virtual community may give 

real time conversations, but people can only talk to one another. In a virtual world, characters 

can do activities together, just like friends could do in reality. Communities in virtual worlds are 

most similar to real life communities because the characters are physically in the same place, 

even if the users who are operating the characters are not. It is close to reality, except that the 

characters are digital. Second Life is one of the most popular virtual worlds on the Internet. 

Whyville offers a good alternative for younger audiences where safety and privacy are a 

concern. In Whyville you use the simulation aspect of the virtual world to experiment and learn 

about various phenomenons. 

4.Social network services:  

Social networking services are the most prominent type of virtual community. They are either a 

website or software platform that focuses on creating and maintaining relationships. Face 

book, Twitter, and MySpace are all virtual communities. With these sites, one often creates a 

profile or account, and adds friends or follow friends. This allows people to connect and look for 

support using the social networking service as a gathering place. These websites often allow for 

people to keep up to date with their friends and acquaintances‟ activities without making much 

of an effort. On Facebook, for example, one can upload photos and videos, chat, make friends, 

reconnect with old ones, and join groups or causes. All of these functions encourage people to 

form a community, large or small, on the Internet. 
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Abstract 

Over the past 10 years mobile phones have changed the way that we live and work. 

It’s a change in personal freedom. The mobile phone seems to give us more power 

as individuals to do what we want and be who we want to be. Many people 

consider mobile phones as extensions of themselves. 

Mobile commerce has become the latest topic for today. Business organizations 

have been restlessly evaluating the revenue potential of the m-commerce market 

and developing business models to exploit the huge profit potential of this new 

market.  
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1-Introduction 

In this report we try to                 

1- Provide an overview of the fundamentals about m-commerce.         

2- Understanding the key elements and basic concepts of m-commerce          

3- Assessing the impact of m-commerce on current and future businesses         

4-Identify new business opportunities and challenges. 

 

2- Objectives             
Upon completion of this report, you will be able to :            

1- Understand different business needs relevant to mobile commerce. 

2-Define what benefits is driven from mobile commerce. 

3-Demonstrate m-commerce how can support businesses and consumers in the    

   adoption of mobile commerce. 

4-Show where there are gaps and issues in technology that would create a barrier      

   to adopting standards. 

5-Drive interoperable mobile commerce implementations based on a basic set of   

    standards.  
 

3-History and future of mobile commerce  

There are currently over 3 billion mobile phones worldwide (Informa, Nov 2007).  

It means that approximately 40% of the world’s population currently carries a 

mobile phone. The chart below puts this figure in the context of other major 

technologies. Mobile phone adoption continues to grow. By 2013, it is expected 

that there will be 4 billion mobile phones worldwide. In many developed countries 

mobile phone penetration is well above 90%, so saying “everyone has a mobile 

phone’” is very close to reality. While electronic commerce continues to see 

phenomenal growth, mobile commerce is still in its infancy.    

 

 

 

 

      

 

 

Figure 1 
Figure 2 
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4- M-commerce and its importance 

 M-Commerce is known as mobile electronic commerce or wireless electronic 

commerce. It will enable millions of people to access web information services 

wherever they go (Yeo and Huang, 2003) .           
M- Commerce is so important for the following reasons:          
1-The number of mobile terminals available is larger than the PC user base and is    

growing much faster.                

2- User’s intimacy with the terminals is higher. The terminal and service represents 

a more convenient and personal combination.             

3- It is truly accessible anytime and anywhere.            

4- It will enable employees to access information wherever they are and make 

decisions instantly without being confined to a desk or computer.             

5- M-commerce eliminates many time- consuming tasks. 

5-Usages of M-Commerce 

1. Financial Services.             

2. Travel and Tourism.             

3. Retail.        

4. Ticketing.               

5. Entertainment and gambling.                      

6. Personal Information Management (PIM).          

7. Location Based service. 

6- M-Commerce value chain 

There are many players in the m- commerce market and the m-commerce value 

chain can be grouped into three major categories:       

(Technology developers-Technology applications developers-Service Providers.) 

 

 

 

 

Figure 3 

Figure 4 
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6.1- Major players in the Industry: 

1. Device Manufacturers: Device Manufacturers are the hardware handheld makers 

and system providers. Some of the giants may also get involved in the industry 

standards design and definition, which are used to work closely with the software 

specification and application environment. Famous leaders are Nokia, Apple and 

Samsung.                   

2. Application Providers: These solution providers integrate the output of content 

provider and mobile devices for end- user applications.             

3. Content Providers: Content providers are the cores of the application usage. 

Generally speaking, organizations (government or industry institution), service 

centers, research centers, agencies, financial bodies, entertainment companies, 

portals, commercial entities, banks all can be content providers.           

4. Service providers (Operators): Service Providers are the platforms for the 

delivery of applications and services to end- users.             

5. Users: End –users, the customers, of course will be the passengers and drivers as 

well, for the wireless application industry to move on. From service providers’ and 

makers’ point of view, mobile users can be categorized to several groups, so that 

the specific needs and consumption behavior can be mined to improve the 

hardware, application and service quality. 
Table 1 
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6.2- M-Commerce target Categories  

Primary target markets for m- commerce consumer services are            

• Teenagers (18years and under)                  

• Students (19- 25 years)                  

• Young business people (25-36years)             

The business markets can be divided into three main categories of organization that 

possess distinct m- commerce needs: 

• Sales driven organizations, such as manufacturing companies and banks 

• Service – driven organizations, such as consultancies and system houses. 

• Logistics- driven organizations, such as taxi companies or courier services. 

7-M-commerce enabling technologies 

Technology suppliers are key market drivers for M-Commerce.          

Network technologies - Service technologies - Mobile Commerce Terminal -    

Mobile Location Technologies                 

Security Technology         

 • Digital signatures for authentication of customer and merchant. 

 • Non- repudiation of the involvement in the transaction.   

 • Strong Encryption.   

 • Integrity of the message  Confidentiality.

               

Other Technologies for Wireless Applications: 

(Radio Frequencies, IEEE 802.11, Infrared (IR), 

Bluetooth)       

Java: The most compelling advantages of Java 

are:       

 • Open, distributed platform based 

 • Supports dynamic download  

 • Provides offline processing mechanism    

 • Easy to develop and maintain.         

These features are the key reasons of Java’s success. Java code can be downloaded 

Figure 5 
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dynamically from remote servers and interpreted on – the fly within a local 

application. 

8-Industrial aspects and considerations 

Although the mobile industry is booming on the way, there are several issues that 

require professionals, users and service providers to explore and look into (Frolick 

and Lei-da-Chen, 2004, Urbaczewskj, et al, 2003, Tarasewich, 2003). • 

Application is about integration and cooperation     

 • Good product design is important      

 • How and when to charge the user      

 • Understanding the User        

 • Security and Privacy        

 • Crowded Band: The 2.4 GHz band is theoretically available worldwide.

 • Separation of Enterprise Data from Personal Data. 

Mobile devices are often used in a dynamic environment where the user is engaged 

in multiple activities. Therefore these devices must present the best possible user 

interface for quick and simple usage. Input methodology (by keys, hand- writing or 

voice) is one of the crucial subjects. It is not possible for users to input data and 

requests using long and complicated procedures and key sequences. Mobile 

devices must be simple so that users are not required to focus on their devices. 

These devices should have no installation scripts and complicated menu structure. 

Screen design, weight and size of the device are also important factors. 

Figure 6 
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9- M-commerce Opportunities and challenges  

M-Commerce could be developed to become strategic weapons for businesses to 

improve their selves . 

9.1- some important opportunities are:            

1- Open Platforms and Solutions, high productivity, flexibility of solution 

implementation, integration and maintenance requirement. Wireless application 

design is also targeting for “one application, run on any mobile handheld.        

2- All –in- one device, with rich application package (multimedia): Mobile usage is 

popular because it brings much convenience and flexibility to users.         

3- Personalization: Obviously, personalization is a powerful feature because 

applications and service providers can identify users’ specific needs while users on 

the other hand can have a better and greater control on their personal mobile 

devices. 

9.2- Some important challenges are: 

1- Apps and Mobile Sites : Companies will need to provide their customers with a 

satisfying experience and a means to make purchases from their smartphones. This 

requires having an app developed or investing in a mobile website.   

2- Keyboards and screens on cell phone are tiny and awkward to use. 

3- Data transmission speeds on existing wireless networks are very slow 

4- Most Internet enabled phones have minimal memory and limited power supply. 

5- Web content on wireless phones are mostly in the form of text with very few 

graphics. 

6- All web sites have still to configure their services to display text in such a way 

that it can be accommodated on cell phone screens. 

7- Unlike Europe and Japan, Wireless networks in the US are based on several 

incompatible technologies (CDMA & TDMA standards). 

8- For M- Commerce to take off, more Web- sites need to be designed specifically 

for wireless devices. 

http://www.custommobileapps.com.au/
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10- CONCLUSION 

Mobile commerce application that offers Mobility, quick accessibility and higher 

convenience, increase in popularity and business, higher customer satisfaction, cost 

effective execution 

Companies are scrambling to repackage their Internet services so they can deliver 

them wirelessly to cellular phones, their target: the ultimate impulse buyer, the 

kind of people who shop and do business wherever they happen to be –in cars, 

restaurants, airplanes, the back seats of taxicabs and just about any other place 

where personal computers are not readily available. Without a doubt, the wireless 

market is growing quickly, and with it the demand for wireless commerce. 

Therefore, the future of M- Commerce is very optimistic. Global wireless 

subscribers are expected to reach between 3 billion by the year 2013. There will be 

more wireless Internet users than fixed line users, and there will be more mobile 

phones than fixed line phones.  

Mobile commerce continues to evolve, and new challenges and opportunities will 

rise up. Regardless, it’s essential for businesses to get in now. 
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